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1
Setting up and Preparing for a 
Meeting

About setting up Meeting Manager 
To participate in a meeting, you must set up Meeting Manager software on your 
computer. Once you schedule, start, or join a meeting for the first time, your 
meeting service Web site starts the setup process. However, to save time, you can set 
up Meeting Manager at any time before scheduling, starting, or joining a meeting.

Setting up Meeting Manager

If you want to... See...

get an overview of setting up Meeting 
Manager

About setting up Meeting Manager on page 1

set up Meeting Manager for Windows Setting up Meeting Manager for Windows on 
page 3

remove Meeting Manager from your computer Uninstalling Meeting Manager on page 4

make sure your system can handle Universal 
Communications Format (UCF) media files 

Checking your system for UCF Compatibility 
on page 5

get an overview of setting up WebEx AIM Pro About WebEx AIM Pro on page 5

If you want to... See...

get an overview of system requirements System requirements for Meeting Manager for 
Windows on page 2

set up Meeting Manager for Windows Setting up Meeting Manager for Windows on 
page 3
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Chapter 1: Setting up and Preparing for a Meeting
System requirements for Meeting Manager for Windows 

You can find the system requirements and other information about compatible 
browsers and operating systems on the User Guides page for your service:

1 Log in to your Meeting Center site.

2 On the Meeting Center navigation bar, click Support>User Guides.

3 On the right side of the page, under Release Notes and FAQs, click the link for 
release notes.

If you need to change your browser settings

In most cases, your Web browser is set up properly for Meeting Manager. However, 
if you are unsure whether your Web browser's settings are correctly configured, or 
you encounter problems when setting up Meeting Manager, you can set up your 
Web browser according to the following instructions.

To set up Internet Explorer 6.x:

1 On the Tools menu, choose Internet Options. 

The Internet Options dialog box appears.

2 Click the Security tab.

3 Ensure that the Internet zone is selected.

4 Click Custom Level. 

The Security Settings dialog box appears.

5 In the Reset to drop-down list, ensure that Medium is selected.

If Medium is not already selected, select it, and then click Reset.

6 Click OK to return to the Security tab.

7 Click OK to close the Internet Options dialog box.

To set up Netscape Navigator 7.x:

1 On the Edit menu, choose Preferences.

2 Click Advanced. 

The Advanced dialog box appears

3 Ensure that the following options are selected:

■ Enable Java

check your system for UCF compatibility Checking your system for UCF Compatibility 
on page 5

If you want to... See...
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■ Enable JavaScript

■ Accept all cookies

4 Click OK.

Setting up Meeting Manager for Windows

Before installing Meeting Manager, ensure that your computer meets the minimum 
system requirements. For details, see System requirements for Meeting Manager for 
Windows on page 2.

If you are not using the Windows operating system, please refer to our FAQ, which 
includes information about setting up Meeting Manager on other operating 
systems. 

To go to the list of FAQs:

1 On your Meeting Center Web site, on the left navigation bar, click 
Support>User Guides.

2 On the User Guides page, under Release Notes and FAQs, click the link for FAQs 
(Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information about 
your operating system under Minimum System Requirements.

To set up Meeting Manager for Windows:

1 On the navigation bar, expand Set Up, and then click Meeting Manager.

The Set Up page appears.

2 Click Set Up.

3 If a security dialog box appears, do one of the following:

■ If you are installing Meeting Manager on Microsoft Internet Explorer, click 
Yes.

■ If you are installing Meeting Manager on Netscape Navigator, click Grant.

Setup continues. A progress message box appears, indicating the progress of 
setup.

4 On the Setup Complete page, click OK.

You can now start, schedule, or join a meeting.

Note

■ Alternatively, you can download the Meeting Manager for Windows Installer 
from the Support page on your Meeting Center Web site, and then install 
Meeting Manager on your Web browser. This option is useful if your system 
3
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does not allow you to install Meeting Manager directly from the Set Up page.

■ If you or another attendee plans to share Universal Communications Format 
(UCF) media files during a meeting, you can verify that the required 
components are installed on your system to play the media files. For details, see 
Checking your system for UCF Compatibility on page 5.

Uninstalling Meeting Manager

Uninstalling Meeting Manager for Windows

You can easily uninstall or remove Meeting Manager for Windows on your 
computer.

1 Do one of the following:

■ For Windows 98, 2000, ME, or NT: On your computer's desktop, 
double-click My Computer, and then open the Control Panel folder.

■ For Windows XP: Click Start, and then click Control Panel.

2 Double-click Add/Remove Programs or Add or Remove Programs, depending 
on your computer's operating system.

A dialog box appears, showing a list of programs installed on your computer.

3 In the list, select WebEx.

4 Click Add/Remove or Change/Remove, depending on your computer's 
operating system.

A message appears, asking you to confirm that you want to remove the software.

5 Click Yes.

The Uninstall WebEx Software dialog box appears.

6 Select Meeting Manager.

7 Click Uninstall.

8 Once the software is removed, click Finish.

Select an option to restart your computer now or later.

If you want to... See...

get an overview of removing Meeting 
Manager from your computer

Uninstalling Meeting Manager on page 4

remove Meeting Manager for Windows Uninstalling Meeting Manager for Windows on 
page 4
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Preparing for meetings
To take advantage of the many features available in meetings, check your system 
and then install some tools to extend meeting capabilities.

■ Check your system for UCF compatibility (if you have presentations with 
animations, save them as .ucf so meeting attendees can view these effects) 
More...

■ Set up and install WebEx AIM Pro Business Edition (to integrate a special 
business version of IM with your meeting) More...

■ Share a remote computer More...

Checking your system for UCF Compatibility

If you intend to play or view Universal Communications Format (UCF) media files 
during the meeting, either as a presenter or an attendee, you can verify that the 
following components are installed on your computer:

■ Flash Player, for playing a Flash movie or interactive Flash files

■ Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a UCF 
multimedia presentation or standalone UCF media files.

To check your system for UCF compatibility:

1 On the navigation bar, do one of the following:

■ If you are a new meeting service user, click New User?.

■ If you are already a meeting service user, expand Set Up, the click Meeting 
Manager. 

2 Click Verify your rich media players.

3 Click the links to verify that the required players are installed on your computer.

Note The option to check your system for required rich media players is available 
only if your Meeting Center Web site includes the UCF option.

About WebEx AIM Pro

Use WebEx AIM Pro, the instant messenger for business users to send secure instant 
messages, invite or remind participants, and manage meetings. AIM Pro integrates 
with Microsoft Outlook corporate directories and calendars, encrypts messages and 
scans them for viruses, and offers quick access to business conferencing services 
from WebEx.
5
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To download WebEx AIM Pro:

1 Log in to your WebEx Meeting Center Web site.

2 On the Meeting Center navigation bar, click Support>Downloads.

3 Scroll down to the section of the page describing WebEx AIM Pro Business 
Edition.

Click the link to learn more about this product and download it.

About sharing a remote computer

Use remote computer sharing to show all meeting attendees a remote computer. 
Depending on how you set up the remote computer, you can show the entire 
desktop or just specific applications. Use remote computer sharing to show 
attendees an application or file that is available only on a remote computer.

Attendees can view your remote computer, including all your mouse movements, 
in a sharing window on their screens.

You can share a remote computer during a meeting for which you are the presenter, 
if:

■ You have installed the Access Anywhere Agent on the remote computer

■ You logged in to your Meeting Center Web site before joining the meeting, if 
you are not the original meeting host

For information about setting up a computer so you can access it remotely, refer to 
the Access Anywhere User’s Guide.
6



2
Joining a Meeting

About joining a meeting
You can join a meeting in a number of ways. The simplest and quickest is by clicking 
the meeting URL, which the host can send you in an instant message or paste into 
an email message.

If the host has given you just the meeting number, you have a couple of ways to join 
the meeting. For details, see Joining a meeting using the meeting number on page 10.

Joining a meeting from an instant message

1 From the instant message window, click the link to join the meeting.

If you want to... See...

get an overview of joining a meeting About joining a meeting on page 7

join a meeting from an instant message Joining a meeting from an instant message on 
page 7

join a meeting from an email invitation Joining a meeting from an email invitation on 
page 8

join a meeting from the meeting calendar Joining a meeting from the meeting calendar on 
page 9

join a meeting from the host’s personal meeting 
page

Joining a meeting from the host’s personal page on 
page 10

join a meeting if the meeting is not listed on the 
calendar or on the host’s personal meeting page

Joining a meeting using the meeting number on 
page 10

register for a meeting Registering for a meeting on page 12

obtain information about a meeting, such as its 
agenda and meeting number

Obtaining information about a scheduled meeting 
on page 14

add a scheduled to your calendar program, such as 
Microsoft Outlook

Adding a meeting to your calendar program on 
page 16
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2 On the Meeting Information page, enter the requested information.

For instance, you may be asked to enter the meeting password.

If the meeting requires registration, a Register button appears on the page. If you 
have not yet registered for the meeting, you must do so before you can join it. 
For more information, see Registering for a meeting on page 12.

3 Click Join Now.

The Meeting window appears.

Joining a meeting from an email invitation

If you received an email invitation to a meeting, you can join the meeting by 
clicking a link in the invitation.

Note As you fill in the information requested, you may also be asked to type your 
user name and password. This page appears only if the meeting host requires that 
you have a user account to attend the meeting.

To join a listed meeting from an invitation email message:

1 Open your email invitation, and then click the link.

2 On the Meeting Information page, enter any requested information.

If the meeting requires registration, a Register button appears on the page. If you 
have not yet registered for the meeting, you must do so before you can join it. 
For more information, see Registering for a meeting on page 12.

3 Click Join Now.

The Meeting window appears.

Click this link to join the meeting.
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Note If you did not receive an email invitation to a meeting, you can also join a 
meeting directly from your Meeting Center Web site or from the host’s Personal 
Meeting Room page. For details, see Joining a meeting from the meeting calendar on 
page 9 or Joining a meeting from the host’s personal page on page 10

Joining a meeting from the meeting calendar

If you do not have an email invitation for a meeting, you can join it from the 
meeting calendar, if the meeting host has listed it there.

To join a meeting listed on the meeting calendar:

1 On the navigation bar, expand Attend a Meeting, and then click Browse 
Meetings.

The Browse Meetings page appears.

2 On the meeting calendar, locate the meeting that you want to attend.

Tips for quickly finding a meeting:

■ Select a view of the meeting calendar by clicking one of the following tabs: 
Today, Daily, Weekly, or Monthly. For more information about calendar 
views, see Viewing the meeting calendar on page 20.

■ Sort a meeting list by clicking the column headings. For details, see Sorting the 
meeting calendar on page 22.

■ View a list of meetings for another date. For details, see Selecting a date on the 
meeting calendar on page 20.

■ Search for a meeting. For details, see Searching for a meeting on the meeting 
calendar on page 22.

3 Under Status, click Join.

4 On the Meeting Information page, enter any requested information.

If the meeting requires registration, a Register button appears on the page. If you 
have not yet registered for the meeting, you must do so before you can join it. 
For more information, see Registering for a meeting on page 12.

5 Click Join Now.

The Meeting window appears.

Tip

■ You can obtain detailed information about a selected meeting or its agenda 
before joining it. For details, see Obtaining information about a scheduled meeting 
9
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on page 14.

■ You can display all meeting times in another time zone. 

■ You can refresh the meeting calendar to ensure that you are viewing the most 
recent information.

Joining a meeting from the host’s personal page

You can join a meeting from the host’s Personal Meeting Room page if the host has 
listed it there.

To join a listed meeting from the host's Personal Meeting Room page:

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 
host must provide you with this URL.

2 On the Meetings tab and under Meetings in Progress, locate the meeting that 
you want to join.

Tip If the meeting is not in progress, you cannot join the meeting. To check 
whether the host has started the meeting, you can periodically click the Refresh 
button on the page.

3 Under Status, click Join.

4 On the Meeting Information page, enter any requested information.

If the meeting requires registration, a Register button appears on the page. If you 
have not yet registered for the meeting, you must do so before you can join it. 
For more information, see Registering for a meeting on page 12.

5 Click OK.

The Meeting window appears.

Joining a meeting using the meeting number

If the meeting host has not included a link to the meeting on the meeting calendar 
or on his or her Personal Meeting page, you can still join that meeting. You need to 
obtain the meeting number from the meeting host.

You can join a meeting by providing the meeting number on either:

■ Your Meeting Center Web site, see Joining a meeting from your Meeting Center 
Web site using the meeting number on page 11

■ The host's Personal Meeting page on your Meeting Center Web site, if the host 
gave you the URL (Web address) for the page Joining meeting from the host’s 
personal page using the meeting number on page 11
10
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Joining a meeting from your Meeting Center Web site using the 
meeting number

f the meeting you want to attend is not listed on the meeting calendar, you can still 
join the meeting. You just need to know the meeting number, which the meeting 
host can give you.

To join an unlisted meeting from your Meeting Center Web site:

1 On the navigation bar, expand Attend a Meeting, and then click Unlisted 
Meeting.

The Join an Unlisted Meeting page appears.

2 In the Meeting number box, type the meeting number that the host gave to you. 

3 Click Join Now.

4 On the Meeting Information page enter any requested information.

If the meeting requires registration, a Register button appears on the page. If you 
have not yet registered for the meeting, you must do so before you can join it. 
For more information, see Registering for a meeting on page 12.

5 Click Join Now.

The Meeting window appears.

Joining meeting from the host’s personal page using the 
meeting number

If you want to attend a meeting that is not on the host’s Personal Meeting Room 
page, you can still join that meeting. Simply ask the host for the meeting number

To join a meeting from the host's Personal Meeting Room page:

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 
host must provide you with this URL.

2 On the Meetings tab and under Join an Unlisted Meeting, type the meeting 
number that the host gave to you in the Meeting number box.

3 Click Join Now.

4 On the Meeting Information page, enter the requested information.

If the meeting requires registration, a Register button appears on the page. If you 
have not yet registered for the meeting, you must do so before you can join it. 
For more information, see Registering for a meeting on page 12.

5 Click Join Now.

The Meeting window appears.
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Registering for a meeting

About registering for a meeting

If a meeting host invites you to a meeting that requires registration, you receive an 
invitation email message. The email message contains a link that you can click to 
register for the meeting.

If you did not receive an email invitation to a meeting that requires registration, you 
can register for the meeting on either:

■ The meeting calendar on your Meeting Center Web site

■ The host's Personal Meeting Room page on your Meeting Center Web site, if the 
host gave you the URL, or Web address, for the page

Registering from an email message

If you received an invitation email message for a meeting that requires registration, 
you can register for the meeting from the message.

To register for a meeting from an invitation email message:

1 Open your invitation email, and then click the link to register for the meeting.

2 On the Meeting Information: [Topic] page that appears, click Register.

The Register for [Topic] page appears.

3 Provide the required information.

4 Click Register Now.

Once the host approves your registration, you receive a registration 
confirmation email message. You can then join the meeting once it starts. 

If the meeting is already in progress, and the host has chosen to approve all 
registration requests automatically, you join the meeting immediately.

If you want to... See...

get an overview of registering for a meeting About registering for a meeting on page 12

register for a meeting from an invitation email 
message

Registering from an email message on page 12

register for a meeting from the meeting calendar on 
your Meeting Center Web site

Registering from the meeting calendar on page 13

register for a meeting from the host’s Personal 
Meeting Room page

Registering from the host’s personal page on 
page 14
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Registering from the meeting calendar

If you did not receive an invitation email message for a meeting that requires 
registration, you can register for it from the meeting calendar on your Meeting 
Center Web site.

To register for a meeting from the meeting calendar:

1 On the navigation bar, expand Attend a Meeting, and then click Register.

The Register for a Meeting page appears, showing the meeting calendar. This 
calendar displays a list of meetings that require registration for the current date. 
Only meetings that require registration appear on this calendar.

2 On the meeting calendar, locate the meeting for which you want to register.

To locate a meeting quickly, you can:

■ Sort the list of meetings by clicking the column headings. For details, see 
Sorting the meeting calendar on page 22.

■ Display the list of meetings for another date. For details, see Selecting a date 
on the meeting calendar on page 20.

■ Search for a meeting. For details, see Searching for a meeting on the meeting 
calendar on page 22.

3 Under Topic, select the option button for the meeting for which you want to 
register.

4 Click Register.

5 On the Register for [Topic] page that appears, provide the required information.

6 Click Register Now.

Once the host approves your registration, you receive a registration 
confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all 
registration requests automatically, you join the meeting immediately.

Tip

■ You can obtain detailed information about a selected meeting or its agenda 
before registering for it. For details, see Obtaining information about a scheduled 
meeting on page 14.

■ You can display all meeting times in another time zone.

■ You can refresh the meeting calendar to ensure that you are viewing the most 
recent information.
13
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Registering from the host’s personal page

You can register for a meeting from the host’s Personal Meeting Room page on your 
Meeting Center Web site.

To register for a meeting from the host's Personal Meeting Room page:

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 
host must provide you with this URL.

2 On the Meetings tab, do one of the following: 

■ If the meeting is not currently in progress, under Scheduled Meetings, click 
Register.

■ If the meeting is currently in progress, under Meetings in Progress, click Join 
Now. On the Join Meeting: [Topic] page that appears, click Register.

3 If the Log In page appears, provide your user name and password, and then click 
Log In.

The Log In page appears only if the meeting host requires that you have a user 
account to join the meeting. In this case, you must provide your user name and 
password before you can register for the meeting.

4 On the Register for [Topic] page that appears, provide the required information.

5 Click Register Now.

Once the host approves your registration, you receive a registration 
confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all 
registration requests automatically, you join the meeting immediately.

Obtaining information about a scheduled meeting

If you want to... See...

get an overview of obtaining information about a 
scheduled meeting

About obtaining meeting information on page 15

obtain meeting information from an invitation 
email message

Obtaining information from an email message on 
page 15

obtain meeting information from the host’s 
Personal Meeting Room page

Obtaining information from the host’s personal 
page on page 16
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About obtaining meeting information

Before joining or registering for a meeting, you can obtain information about it 
from the Meeting Information page. The information you can view includes the 
host’s name and email address, meeting number, and agenda.If you received an 
email invitation to a meeting, you can click a link in the message to view the meeting 
information.

If you did not receive an email invitation from the host, you can view the meeting 
information from either:

■ The meeting calendar on your Meeting Center Web site

■ The host's Personal Meeting Room page on your Meeting Center Web site, if the 
host gave you the URL, or Web address, for the page

Obtaining information from an email message

If you receive an email invitation for a meeting, you can view the meeting 
information from the email message.

To obtain information about a meeting from an invitation email message:

1 Open your invitation email message, and then click the link.

The Meeting Information appears.

2 Optional. To view the meeting agenda, click View Agenda.

Obtaining information from the meeting calendar

If you did not receive an email invitation, you can obtain meeting information from 
the meeting calendar on your Meeting Center Web site.

To obtain information about a meeting from the meeting calendar:

1 From the navigation bar on your Meeting Center Web site, expand Attend a 
Meeting.

2 Click Browse Meetings.

3 On the meeting calendar, locate the meeting about which you want to obtain 
information.

4 Under Topic, click the link for the meeting.

If the meeting requires a password, the Get Info page appears.

If the meeting does not require a password, the Meeting Information page 
appears. You can skip to step 6.

5 If the Get Info page appears, type the password that the meeting host gave to you 
in the Meeting password box, and then click OK.

6 Optional. To view the meeting's agenda, click View Agenda.
15



Chapter 2: Joining a Meeting
The Agenda page appears.

Obtaining information from the host’s personal page

You can obtain meeting information from the hosts’s Personal Meeting Room page 
on your Meeting Center Web site.

To obtain meeting information from the host’s Personal Meeting Room page:

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 
host must provide you with this URL.

2 On the Meetings tab, locate the meeting about which you want to obtain 
information.

3 Under Topic, click the link for the meeting.

If the meeting requires a password, the Get Info page appears.

If the meeting does not require a password, the Meeting Information page 
appears

4 If the Get Info page appears, type the password that the meeting host gave to you 
in the Meeting password box, and then click OK.

5 Optional. To view the meeting’s agenda, click View Agenda.

Adding a meeting to your calendar program

About adding a meeting to your calendar program

You can add a scheduled meeting to your calendar program, such as Microsoft 
Outlook. This option is applicable only if your calendar program supports the 
iCalendar standard, a common format for exchanging calendaring and scheduling 
information across the Internet.

You can add a meeting to your calendar from either:

■ The invitation email message that you receive from the host

■ The Meeting Information page for the meeting, which you can access by clicking 
the link for the meeting on the meeting calendar or on the host’s Personal 
Meeting Room page

If you want to... See...

get an overview of adding a scheduled meeting to 
your calendar program

About adding a meeting to your calendar program 
on page 16

add a scheduled meeting to your calendar program Adding a meeting to your calendar program on 
page 17
16
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Adding a meeting to your calendar program

You can add a scheduled meeting to your calendar program if your calendar 
program supports the iCalendar standard.

To add a scheduled meeting to your calendar:

1 Do one of the following, as appropriate:

■ In the invitation email message that you receive, click the link to add the 
meeting to your calendar.

■ On the Meeting Information page for the meeting, click Add to My Calendar.

A meeting item opens in your calendar program.

2 Accept the meeting request. For example, in Outlook, click Accept to add the 
meeting item to your calendar.

Note If the host cancels the meeting, the cancellation email message that you 
receive contains an option that lets you remove the meeting from your calendar 
program.
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3
Using the Calendar

About the meeting calendar
The public meeting calendar on your Meeting Center Web site provides 
information about all listed meetings that are either scheduled or in progress. 
However, the meeting calendar does not provide information about unlisted 
meetings.

You can navigate the meeting calendar to quickly find a listed meeting—either on 
the current date or any date—using one of several calendar views. For example, you 
can view a list of meetings for today’s date only or for an entire month. You can also 
view a list of only those meetings that require registration.

When viewing a list of meetings, you can sort the list and refresh it at any time.

If you want to... See...

get an overview of using the calendar About the meeting calendar on page 19

view the meeting calendar Viewing the meeting calendar on page 20

select a date on the meeting calendar Selecting a date on the meeting calendar on 
page 20

search for a meeting on the meeting calendar Searching for a meeting on the meeting 
calendar on page 22

sort the meeting calendar Sorting the meeting calendar on page 22

refresh the meeting calendar Refreshing the meeting calendar on page 23

select a language and time zone on the 
meeting calendar

Selecting a language and time zone on the 
meeting calendar on page 23

register for a meeting from the meeting 
calendar

Registering for a meeting from the meeting 
calendar on page 24
19
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Viewing the meeting calendar

You can open one of the following calendar views of all listed meetings:

To open a calendar view of all scheduled meetings:

1 On the navigation bar, expand Attend a Meeting to view a list of links.

2 Click Browse Meetings.

The Browse Meetings page appears, displaying the meeting calendar.

3 Click one of the tabs to navigate to different views of the meeting calendar:

You can choose Today, Daily, Weekly, or Monthly.

You can also view a list that includes past meetings, and can view a list of meetings 
that require registration.

To include past meetings in your list of meetings:

1 Select the Today or Daily tab.

2 Select the Show past meetings check box.

The list of meetings displays accordingly for the tab.

To display a list of only meetings that require registration:

1 Select the Today, Daily, or Weekly tab.

2 Select the Show only meetings that require registration check box.

The list of meetings that require registration displays accordingly for the tab.

Selecting a date on the meeting calendar

You can view a list of scheduled meetings for any date on the meeting calendar.

To display a list of scheduled meetings for the previous or next day:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 On the Daily view on the Browse Meetings page, or on the Register for a Meeting 
page, do one of the following:

Today Contains a list of meetings occurring on the current date, including 
all meetings currently in progress and all scheduled meetings that 
are not yet in progress.

Daily Contains a single list of all meetings occurring on the current date, 
or on another date to which you have navigated.

Weekly Contains a list of scheduled meetings for each day of the selected 
week.

Monthly Indicates on which dates meetings are scheduled for the selected 
month.
20
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■ To display a list of meetings for the previous day, click the Previous Day 
button. 

■ To display a list of meetings for the next day, click the Next Day button.

For details about the options on the Daily view, see About the Daily view on 
page 26.

To display a list of meetings for a specific date, using the Today, Daily, or Weekly 
view:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 On the Today, Daily, or Weekly tab on the Browse Meetings page, or on the 
Register for a Meeting page, click the Calendar icon. 

The Calendar window appears, showing the calendar for the current month.

3 Optional. Do any of the following:

■ To view the calendar for the previous month, click the Decrement Month 
button.

■ To view the calendar for the next month, click the Increment Month button.

■ To view the calendar for a specific month, in the drop-down list, select a 
month.

■ To view the calendar for a specific year, in the drop-down list, select a year.

4 Click the date for which you want to view a list of meetings.

The Daily view for the date that you selected appears.

For details about the options on the view tabs, see About the Today view on 
page 25, About the Daily view on page 26, or About the Weekly view on page 28.

Next DayPrevious Day

Decrement Month

Year drop-down list

Increment Month

Month drop-down list
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To display a list of meetings for a specific date, using the Monthly view:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 Click the Monthly tab.

3 Optional. Do either of the following:

■ To view the Monthly view for the previous month, click the Previous Month 
button. 

■ To view the Monthly view for the next month, click the Next Month button.

4 Click a date for which you want to view a list of scheduled meetings.

The Daily view appears for the date that you selected.

Note Only dates on which an iconappears have at least one scheduled meeting.

For details about the options on the Monthly view, see About the Monthly view 
on page 29.

Searching for a meeting on the meeting calendar
On the meeting calendar, you can locate a meeting by searching for text in the host’s 
name, meeting topic, or meeting agenda. You cannot search for a meeting number.

To search for a meeting: 

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 Type the text for which you want to search in the Search for box.

3 Click Search.

The Search Results page appears, listing all meetings that contain the search text.

Sorting the meeting calendar
By default, meeting lists on the meeting calendar are sorted by hours, in ascending 
order. However, you can sort the meeting lists by any column:

Next MonthPrevious Month
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To sort the public meeting calendar:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 In a list of meetings on the Today, Daily, or Weekly tab on the Browse Meetings 
page, or on the Register for a Meeting page, click the column heading by which 
you want to sort the meetings.

The Ascending Sort indicator appears, and the meetings are sorted by the 
column, in ascending order.

The Descending Sort indicator appears, and the meetings are sorted by the 
column, in descending order.

Refreshing the meeting calendar
Information about meetings on the public meeting calendar can change at any time. 
Thus, to ensure that you are viewing the most current meeting information, you 
can refresh the meeting calendar at any time.

To refresh the public meeting calendar:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 Click the Refresh button.

Selecting a language and time zone on the meeting 
calendar

On the meeting calendar, you can access your Preferences page to select the 
language and time zone in which you want to view meeting times. Your site 
administrator specifies the default language and time zone that appears on the 
meeting calendar. You may need to change the time zone, for example, if you are 
travelling and temporarily in another time zone.

Time Sorts the meeting list by hours, in ascending or descending order.

Topic Sorts the meeting list alphabetically by topic, in ascending or 
descending order.

Host Sorts the meeting list alphabetically by host name, in ascending or 
descending order.

Duration Sorts the meeting list by duration, in ascending or descending order.
23



Chapter 3: Using the Calendar
To select a language on the public meeting calendar:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 Click the language link on the right side of the page.

The Preferences page appears.

3 In the Language drop-down list, select another language.

4 Click OK.

To select a time zone on the public meeting calendar:

1 If you have not already done so, open the meeting calendar. For details, see 
Viewing the meeting calendar on page 20.

2 Click the time zone link on the right side of the page.

The Preferences page appears.

3 In the Time zone drop-down list, select another time zone.

4 Click OK.

Note

■ Your time zone selection affects only your view of your Meeting Center Web site, 
not other users’ views.

■ If you have a user account, all meeting invitations that you send automatically 
specify the meeting’s starting time in the time zone that you selected.

■ If you select a time zone for which daylight saving time (DST) is in effect, your 
Meeting Center Web site automatically adjusts its clock for daylight saving time.

Registering for a meeting from the meeting 
calendar

If you did not receive an invitation email message for a meeting that requires 
registration, you can register for it from the meeting calendar on your Meeting 
Center Web site.

About the Register for a Meeting page

The Register for a Meeting page lists only meetings that require registration. Each 
page of the meeting calendar lists all of the meetings occurring on a given day that 
require registration, except unlisted meetings. 
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To select a scheduled meeting, click the option button to the left of its topic. Once 
you have selected a meeting, you can click one of the following buttons on the 
button bar:

Registering for a meeting

If you find the meeting you want to register for, you can easily complete the 
registration form and send it to the meeting host.

1 Select a meeting for which the status is Registration.

2 Click Register.

3 Enter your information and click Register Now.

Once the host approves your registration, you receive a registration 
confirmation email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all 
registration requests automatically, you join the meeting immediately.

About the Today view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 
Today tab.

What you can do here

The Today view lists the live meetings that are scheduled for the present day, 
including those in process, those concluded, and those that have not yet begun.

The meeting information displayed in the list can be sorted by clicking the column 
headings. For details, see Sorting the meeting calendar on page 22.

Click this button... To...

Register for the meeting.

Join the meeting, if the meeting is currently in progress.

View detailed information about the meeting.

View the agenda for the meeting.
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Options on this page

About the Daily view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 
Daily tab.

Option Description

Click the Refresh icon at any time to display the most current list of 
meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Show past meetings 
check box

Select to include concluded meetings in the list of meetings.

Show only meetings 
that require 
registration check 
box

Select to display only those meetings that require registration in the 
list of meetings.

The Ascending Sort indicator appears next to a column heading, and 
the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the meetings are sorted by the column, in descending order.

Time Lists the starting time for each scheduled meeting.

Topic Lists the scheduled meetings by name. Click the topic name to get 
meeting information.

Host Lists the host for the meeting.

Duration Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Join link Click the link to join the meeting from the Meeting Information page.

Register link Click to open the Register for page, where you can enter the required 
information to register for the meeting.

Indicates that this is an Audio Only meeting.

Start link (Host only) Click to start your meeting.

End link (Host only) Click to end your meeting.
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What you can do here

The Daily view lists the live meetings that are scheduled for the present day. From 
the Daily view you can navigate to the previous or next day, or use the calendar to 
view the schedule for another day.

The meeting information displayed in the list can be sorted by clicking the column 
headings. For details, see Sorting the meeting calendar on page 22.

Options on this page

Option Description

Click the Refresh icon at any time to display the most current list of 
meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Click the Previous Day icon to display a list of meetings for the 
previous day.

Click the Next Day icon to display a list of meetings for the next day.

Click the Calendar icon to open the Calendar window for the current 
month. Click on any date to open its schedule.

Show past meetings 
check box

Select to include concluded meetings in the list of meetings.

Show only meetings 
that require 
registration check 
box

Select to display only those meetings that require registration in the 
list of meetings.

The Ascending Sort indicator appears next to a column heading, and 
the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the meetings are sorted by the column, in descending order.

Time Lists the starting time for each scheduled meeting.

Topic Lists the scheduled meetings by name. Click the topic name to get 
meeting information.

Host Lists the host for the meeting.

Duration Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Join link Click the link to join the meeting from the Meeting Information page.

Register link Click to open the Register for page, where you can enter the required 
information to register for the meeting.
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About the Weekly view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 
Weekly tab.

What you can do here

The Weekly view lists the live meetings that are scheduled, but not ended for the 
selected week.

The meeting information displayed in the list can be sorted by clicking the column 
headings. For details, see Sorting the meeting calendar on page 22.

Options on this page

Indicates that this is an Audio Only meeting.

Start link (Host only) Click to start your meeting.

End link (Host only) Click to end your meeting.

Option Description

Option Description

Click the Refresh icon at any time to display the most current list of 
meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Click the Previous Week icon to display a list of meetings for the 
previous week.

Click the Next Week icon to display a list of meetings for the next 
week.

Click the Calendar icon to open the Calendar window for the current 
month. Click on any date to open its schedule.

Show only meetings 
that require 
registration check 
box

Select to display only those meetings that require registration in the 
list of meetings.

Day link Opens the Daily view, which shows the scheduled meetings for the 
selected day.
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About the Monthly view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 
Monthly tab.

What you can do here

The Monthly view shows when the live meetings are scheduled in a monthly 
calendar view. You can navigate to a specific day or week within the current month, 
or navigate to the previous or next month.

Options on this page

The Ascending Sort indicator appears next to a column heading, and 
the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the meetings are sorted by the column, in descending order.

Time Lists the starting time for each scheduled meeting.

Topic Lists the scheduled meetings by name. Click the topic name to get 
meeting information.

Host Lists the host for the meeting.

Duration Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Join link Click the link to join the meeting from the Meeting Information page.

Register link Click to open the Register for page, where you can enter the required 
information to register for the meeting.

Indicates that this is an Audio Only meeting.

Start link (Host only) Click to start your meeting.

End link (Host only) Click to end your meeting.

Option Description

Option Description

Click the Previous Month icon to display a list of meetings for the 
previous month.

Click the Next Month icon to display a list of meetings for the next 
month.
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About the Search Results page

What you can do here

■ Find a meeting on your Meeting Center Web site.

■ Display past meetings.

■ Display meetings that require registration.

■ Sort the search results.

■ Select a language for your Meeting Center Web site.

■ Select a time zone for your Meeting Center Web site.

The meeting information displayed in the search results can be sorted by clicking 
the column headings. For details, see Sorting the meeting calendar on page 22.

Options on this page

Click the Refresh icon at any time to display the most current view of 
the month’s meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Week link Opens the Weekly view, which shows the scheduled meetings for 
each day of the selected week.

Day link Opens the Daily view, which shows the scheduled meetings for the 
selected day.

Appears on the calendar to indicate that one or more meetings are 
scheduled on that day.

Option Description

Option Description

Search for...
text box

Enter a host name, meeting topic, or any text that may appear in the 
agenda, and click Search.

Note You cannot search for a meeting number. 

Click the Refresh icon at any time to display the most current view of 
the month’s meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Show past meetings 
check box

Select to include concluded meetings in the search results.
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Show only meetings 
that require 
registration check 
box

Select to display only those meetings that require registration in the 
search results.

Navigation links Click page numbers or next to navigate through the search results.

The Ascending Sort indicator appears next to a column heading, and 
the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the meetings are sorted by the column, in descending order.

Date & Time Lists the date and starting time of the meeting.

Topic Lists the meetings name. Click the topic name to get meeting 
information.

Host Lists the host for the meeting.

Duration Lists the meeting duration.

Indicates that the live meeting is in process.

Join link Click the link to join the meeting from the Meeting Information page.

Register link Click to open the Register for page, where you can enter the required 
information to register for the meeting.

Indicates that this is an Audio Only meeting.

Start link (Host only) Click to start your meeting.

End link (Host only) Click to end your meeting.

Option Description
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4
Scheduling a Meeting

Choosing the scheduler that works for you
Meeting Center provides several ways to set up meetings. Review the details about 
the different means of scheduling a meeting and then pick the one that meets your 
needs.

Short on time?

Use the one-page Quick Scheduler. Simply enter a few details and you are ready to 
host your meeting. For details, see Using the Quick Scheduler on page 34.

Looking for more meeting options, such as adding additional security?

Use the Advanced Scheduler. Enter the level of detail you need. You can schedule 
or start the meeting from any page in the wizard. For details, see Using the Advanced 
Scheduler on page 39

If you want to... See...

get an overview of scheduling a meeting Choosing the scheduler that works for you on 
page 33

allow another user to schedule meetings for 
you

Allowing another user to schedule meetings 
for you on page 39

use the Quick Scheduler to start a meeting 
quickly

Using the Quick Scheduler on page 34

use the Advanced Scheduler to include an 
agenda and other options in your meeting

Using the Advanced Scheduler on page 39

set up a meeting that recurs on a regular basis Setting up a recurring meeting on page 73

start a scheduled meeting Starting a scheduled meeting on page 77

edit details for a scheduled meeting Editing a scheduled meeting on page 76

cancel a scheduled meeting Canceling a scheduled meeting on page 78
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Want to reuse the information you saved in the scheduler?

You do not have to type in the same information every time you set up a meeting. 
If the meeting recurs on a regular basis, with the same attendees, you can set up a 
whole series of meetings. If the meeting details (such as attendees, meeting options) 
are constant, you can save those details in a template, which you can apply to any 
meeting you schedule. For details, see:

■ Setting up a recurring meeting on page 73

■ Using meeting templates on page 70

Note If you decide to switch from the Advanced Scheduler to the Quick Scheduler 
(or from the Quick Scheduler to the Advanced Scheduler) any information you 
have typed is saved and available in the other scheduler. 

About the Quick Scheduler
Use this one-page scheduler to set up a meeting with just a few mouse clicks.

Your site administrator decides whether your site displays the Quick Scheduler or 
the Advanced Scheduler, a wizard that helps you step through the process of 
selecting meeting options.

If your site displays the Advanced Scheduler automatically, you can easily switch to 
the Quick Scheduler. Simply click the Return to Quick Scheduler link at the top of 
the Required Information page.

Using the Quick Scheduler

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The Required Information page appears.

4 Check whether you are viewing the Advanced Scheduler. Click the Return to 
Quick Scheduler link to display the Quick Scheduler.

The Advanced Scheduler consists of several pages, with the links to them on the 
right side of the page. The Quick Scheduler is one page.

5 Enter the details about your meeting. For information about the fields on this 
page, see About the Quick Scheduler page on page 35.

6 Start or schedule the meeting:

■ If the meeting's starting time is the current time, click Start to start the 
meeting.
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■ If the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled. 
You also receive a confirmation email message that includes information about 
the scheduled meeting.

About the Quick Scheduler page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.

Choose a 
meeting 
template, if you 
want to use 
settings you 
have applied 
previously and 

You can go to your address book, time zone settings, 
audio options page to make changes to these settings.

Select this check box to receive a copy of 
the email invitation sent to attendees
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What you can do here

Set up a meeting quickly, using this one-page scheduler.

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Topic Enter the topic or a name for the meeting.

Tracking codes Identify your department, project, or other information 
that your organization wants to associate with your 
meetings. Tracking codes can be optional or required, 
depending on how your site administrator set them up. 

If your site administrator requires you to select a code 
from a predefined list, a list of codes appears. Select a 
code from the list on the left. Then do one of the following 
in the box on the right:

■ If a list of codes appears, select a code from the list.

■ Type a code in the box.

Click the links to change settings, such as the account 
and opportunity you want to assign, the time zone, or 
audio options available in this meeting.

Choose a meeting template, if you want to use 
settings you have applied previously and saved in a 
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 About the Advanced Scheduler
When scheduling a meeting, use the Schedule a Meeting wizard to set several 
options for your meeting. These options allow you to customize your meeting for 
your specific needs, such as additional security. Once you schedule a meeting, you 
can change its options at any time, or cancel the meeting. 

Password

Confirm password

Require participants to enter the password you set to join 
your meeting.

Your site may require that all passwords comply with 
security criteria, such as a minimum length and a 
minimum number of letters, numbers or special 
characters. A password:

■ Can contain a maximum of 16 characters. 

■ Cannot contain spaces or any of the following 
characters: \ ̀  “ / & < > == [ ]

Each participant that you invite to your meeting receives 
an invitation email message that includes the password, 
unless you request that passwords do not appear in email 
invitations.

Date Set the date you want the meeting to occur. Select the 
month, day, and year in the drop-down lists. Or, you can 
click the Calendar icon, and then select a date.

Time Set the meeting's starting time and the time zone. To 
select another time zone, click the time zone link.

Important The time zone you select does not affect the 
time zone setting for the meeting calendar on the Browse 
Meetings page. You and each attendee can select the 
time zone for your view of the calendar independently, 
using the Your time zone option on the Preferences 
page. To access this page, on the navigation bar, click 
Set Up > Preferences

Duration Enter the length of time you estimate that the meeting will 
continue. The meeting does not end automatically after 
the duration that you set.

Attendees Enter the email addresses of the attendees you want to 
invite to your meeting. 

You can type the addresses, separating them with a 
comma or semicolon or you can click Select Attendees 
to choose attendees from your address book. 

Select the “Send a copy of the email invitation to me” 
check box to receive a copy of the invitation. Later, you 
can forward this email invitation, if you find you have 
forgotten to invite someone.

Audio options The default settings appear. To select a different options, 
click Change audio option.

Use this option... To...
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If another user has granted scheduling permission to you in his or her or her user 
profile, you can schedule a meeting on behalf of that user. For details about granting 
scheduling permission to another user, see Allowing another user to schedule 
meetings for you on page 39.

Note If you use Microsoft Outlook 2000 or a later version, you can schedule, start, 
and join online meetings using Outlook. For instructions on using Integration to 
Outlook, refer the Integration to Outlook User's Guide, which is available on your 
Meeting Center Web site.

Choosing a level of security for a scheduled 
meeting

When scheduling a meeting, you can provide security for the meeting using these 
means:

■ Require a password: Attendees must provide the password you set before joining 
the meeting. For more information, see About the Required Information page on 
page 42.

■ Decline to list this meeting on the meeting calendar: An unlisted meeting does 
not appear in the meeting calendar on the Browse Meetings page or on your 
Personal Meetings page. To join an unlisted meeting, attendees must provide a 
unique meeting number. For more information, see About the Required 
Information page on page 42

■ Exclude the meeting password from email invitations: If you invite attendees to 
a meeting, you can prevent the password from appearing in the email invitations 
that your Meeting Center Web site sends automatically to attendees. For details, 
see How can I enhance meeting security? on page 56

■ Require attendees to log in: You can require attendees to have a user account on 
your Meeting Center Web site to join the meeting. Thus, attendees must log in 
to your site before they can attend the meeting. For more information, see How 
can I enhance meeting security? on page 56

■ Require attendees to register for the meeting: If you require each attendee to 
send a registration request to you before joining a meeting, you can accept or 
reject each registration request. For more information, see About the Registration 
page on page 56.
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Tip Choose a level of security based on the meeting's purpose. For example, if you 
schedule a meeting to discuss your company picnic, you probably need to set only 
a password for the meeting. On the other hand, if you schedule a meeting in which 
you will discuss sensitive financial data, you may not want to list the meeting on the 
meeting calendar. You may also choose to restrict access to the meeting once all 
attendees have joined it.

Allowing another user to schedule meetings for 
you

You can grant permission to one or more Meeting Center users to schedule 
meetings on your behalf. A user to whom you grant permission to schedule 
meetings must have an account on your Meeting Center Web site.

Once a user schedules a meeting for you, the meeting appears in your list of 
meetings on your My Meetings page. You can then start the meeting and host it as 
you normally do when you schedule meetings yourself.

To allow another user to schedule meetings for you:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

3 Click My Profile.

The My Profile page appears.

4 Under Session Options, do either or both of the following:

In the Scheduling permission box, type the email addresses of the users to 
whom you want to grant scheduling permission. Separate multiple addresses 
with either a comma or semicolon.

Click Select From Host List to select users from a list of all users who have 
accounts on your Meeting Center Web site.

5 Click Update.

Using the Advanced Scheduler
When scheduling a meeting, you must provide a meeting topic and a starting time. 
You can also set options to customize your meeting and enhance its security.

Using the Advanced Scheduler, you can schedule a meeting quickly. You can click 
the Start button at any time to start your meeting. If you have questions about the 
information requested on a page, click the Help button, which is located in the 
upper right corner of each wizard page.
39



Chapter 4: Scheduling a Meeting
To start the Advanced Scheduler:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The Advanced Scheduler appears, showing the Required Information page.

To schedule a meeting:

1 Click Required Information.

Enter the requested information, such as the meeting topic, meeting password, 
tracking codes, and whether you want to display this meeting on your list of 
meetings.

For details, see About the Required Information page on page 42.

2 Click Date & Time.

Set the date and time for the meeting. You also set the meeting duration, how 
many minutes in advance you will allow participants to join the meeting, 
whether the meeting recurs and how often and other information related to 
meeting times. 

For details, see About the Date & Time page on page 45.

3 Click Audio Conference.

Set up an audio conference for the meeting. Select the type of voice conference 
(call back or call in). Also, you can include VoIP as well as the traditional 
teleconference.

For details, see About the Audio Conference Settings page on page 48.

4 Click Invite Attendees.

Enter the email addresses of the attendees you want to invite or you can select 
them from your contact list. You can also make your meeting more secure by: 

■ Selecting the option not to send the meeting password in the meeting 
invitation

■ Requiring attendees to have an account on your Web site before they can join 
a meeting.

For details, see About the Invite Attendees page on page 53.

5 Click Registration.

If you want to have participants register for the meeting, select information to 
be requested on registration page.

For details, see About the Registration page on page 56.

6 Click Agenda & Welcome.
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Type an agenda for the meeting or a welcome message for attendees, which they 
can view before the meeting starts. Select a file that you want to open 
automatically in each attendee's Meeting window once he or she joins the 
meeting. 

For details, see About the Agenda & Welcome page on page 59.

7 Click Meeting Options.

Select the meeting options you want to be available to all participants during the 
meeting. You can also choose an alert to play once a participant either joins or 
leaves the teleconference. 

For details, see About the Meeting Options page on page 63.

8 Click Attendee Privileges.

Select the privileges attendees have during the meeting. 

For details, see About the Attendee Privileges Page on page 67.

9 Click Review.

You view all the information you’ve entered on each page of the Advanced 
Scheduler. If you need to make a change, return to that page in the wizard and 
edit the information.

For details, see About the Review page on page 69.

10 Optional. Save your meeting settings in a template.

If you may need to use these same meeting settings (for example, with the same 
attendees, telephony options, and other meeting details), you can save the 
settings in a meeting template. 

For more details about using meeting templates, see Using meeting templates on 
page 70.

11 Start or schedule the meeting:

■ If the meeting's starting time is the current time, click Start to start the 
meeting.

■ If the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled. 
You also receive a confirmation email message that includes information about 
the scheduled meeting.
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Page-by-page guide to the Advanced Scheduler
Scheduling a meeting can be done in one click, or you can take a bit of time and set 
up teleconferencing options, invite attendees, assign privileges, and select other 
options in advance of the meeting. If you have questions about any options or how 
to complete the information requested on any page in the Advanced Scheduler, 
refer to these topics:

About the Required Information page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting > Required 
Information

If you want to... See...

learn about meeting types, listed and 
unlisted meetings, meeting passwords

About the Required Information page on 
page 42

set the day and time for a meeting or set up 
a recurring meeting

About the Date & Time page on page 45

set up an audio conference with VoIP or 
voice teleconferencing or both

About the Audio Conference Settings page 
on page 48

invite attendees in advance and set security 
measures

About the Invite Attendees page on page 53

require attendees to register for a meeting About the Registration page on page 56

create an agenda and select a presentation 
to share while attendees wait for the meeting 
to start

About the Agenda & Welcome page on 
page 59

set options for participants, such as allowing 
them to chat, transfer files, and take notes

About the Meeting Options page on page 63

set privileges for attendees, such as allowing 
them to view a list of meeting participants, 
control another computer or a Web browser 
remotely

About the Attendee Privileges Page on 
page 67

review all meeting details About the Review page on page 69
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What you can do on this page 

■ Set up a meeting on behalf of someone else

You can select the hosts you want to include in the Schedule for drop-down list 
from the list of hosts available in the Profiles area of My WebEx.

■ Select the type of meeting you are setting up.

■ Define a topic for the meeting.

■ Indicate whether the meeting is listed on the meeting calendar. For information 
about listed and unlisted meetings, see About joining a meeting on page 7.

■ Decide whether the meeting is deleted from My Meetings on My WebEx after it 
is over.

■ Set the meeting password, if required.

■ Select tracking codes, if your administrator has set them up.

Options on this page

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Schedule for Schedule a meeting on someone else’s behalf. Select 
that person’s name in the drop-down list.

You see this option if you have permission to perform this 
task for at least one other user and only after that user 
has granted you permission, by using the Scheduling 
permission option on his or her My Profile page.
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Meeting type Select the type of meeting you want to host. 

Some Meeting Center sites have set up custom meeting 
types, which your site administrator creates. For 
information about which features are available for a 
meeting type, ask your site administrator.

(Optional for some organizations.)

Meeting topic Enter the topic or a name for the meeting.

Listed on calendar List this meeting on the meeting calendar. 

To enhance meeting security, you can opt not to list the 
meeting on the meeting calendar. Just remove the check 
mark from this option to:

■ Hide information about the meeting, such as its host, 
topic, and starting time.

■ Help prevent unauthorized access to the meeting.

Delete from My Meetings 
when completed

Remove this meeting from your list of meetings in the My 
Meetings area of My WebEx after the meeting ends.

If you do not select this option, you must delete this 
meeting from My Meetings to remove it from the list.

Meeting password

Confirm password

Require participants to enter the password you set to join 
your meeting.

Your site may require that all passwords comply with 
security criteria, such as a minimum length and a 
minimum number of letters, numbers or special 
characters. A password:

■ Can contain a maximum of 16 characters. 

■ Cannot contain spaces or any of the following 
characters: \ ̀  “ / & < > == [ ]

Each participant that you invite to your meeting receives 
an invitation email message that includes the password, 
unless you request that passwords do not appear in 
email invitations.

Tracking codes Identify your department, project, or other information 
that your organization wants to associate with your 
meetings. Tracking codes can be optional or required, 
depending on how your site administrator set them up. 

If your site administrator requires you to select a code 
from a predefined list, a list of codes appears. Select a 
code from the list on the left. Then do one of the following 
in the box on the right:

■ If a list of codes appears, select a code from the list.

■ Type a code in the box.

Use this option... To...
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Questions about required information for setting up a meeting

Why set up an unlisted meeting?

You can prevent a scheduled meeting from appearing on the meeting calendar and 
any other publicly accessible pages on your Meeting Center Web site, by setting up 
an unlisted meeting. If a meeting is unlisted, the meeting details, such as its host, 
topic, and starting time are not available on the calendar and other places. This 
additional security may help prevent unauthorized access to the meeting.

To join an unlisted meeting, a participant must provide a unique meeting number.

If you invite a participant to an unlisted meeting, the participant receives an 
invitation email message that includes complete instructions for joining the 
meeting—including the meeting number—and a URL that links directly to a Web 
page on which the participant can join the meeting.

What are tracking codes?

Your site administrator can include tracking codes in the Advanced Scheduler. 
Tracking codes may identify your department, project, or other information that 
your organization wants to associate with your meetings. Tracking codes can be 
optional or required, depending on how your site administrator sets them up. 

How can I learn about the fields on the Required Information 
page?

Click the Help link in the top right corner of the Required Information page, or 
review About the Required Information page on page 42.

About the Date & Time page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Date & Time.
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What you can do on this page:

■ Set the date and time for the meeting

■ Set the duration for the meeting

■ Select the number of minutes before the meeting's starting time during which 
attendees can join the meeting

■ Select the number of minutes before the meeting you want to receive a reminder 
email message

■ Set a recurrence pattern for the meeting

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Meeting date Set the date you want the meeting to occur. Select the 
month, day, and year in the drop-down lists. Or, you can 
click the Calendar icon, and then select a date.

Meeting time Set the meeting's starting time and the time zone. To 
select another time zone, click the time zone link.

Important The time zone you select does not affect the 
time zone setting for the meeting calendar on the Browse 
Meetings page. You and each attendee can select the 
time zone for your view of the calendar independently, 
using the Your time zone option on the Preferences 
page. To access this page, on the navigation bar, click 
Set Up > Preferences
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Attendees can join [x] 
minutes before the 
starting time

Allow attendees to join the meeting within a set number 
of minutes before the meeting's starting time. 

Note: If you clear this check box or set this option to 0 
minutes, you must start the meeting before attendees can 
join it

For more information about starting a meeting, see 
Starting a scheduled meeting on page 77.

Attendees can also 
connect to the WebEx 
teleconference

If you allow attendees to join the meeting before the 
scheduled starting time, you can also allow attendees to 
join in a teleconference before the meeting starts. 

You set up the teleconference on the next page.

Estimated duration Enter the length of time you estimate that the meeting will 
continue. The meeting does not end automatically after 
the duration that you set.

Email reminder Set the number of minutes before the meeting's 
scheduled starting time at which you want to receive a 
reminder email message. If you do not want to receive a 
reminder, in the drop-down list, select None.

Recurrence Set the recurrence pattern for this meeting. 

None: Specifies that the meeting does not recur.

Daily: Repeats the meeting every day until the ending 
date that you select.

■ Every [x] days: Repeats the meeting after the 
specified number of days pass. 

■ Every weekday: Repeats the meeting each day, from 
Monday to Friday.

■ Weekly: Repeats the meeting every week until the 
ending date that you select.

■ Sunday - Saturday: Specifies the day on which the 
meeting repeats every week. You can select one or 
more days. 

Monthly: Repeats the meeting every month until the 
ending date that you select.

■ Day [x] of every [x] months: Specifies the specific 
day of the month on which to repeat the meeting, and 
the number of months that pass before the meeting 
repeats.

■ [x] [x] of every [x] months: Specifies the specific 
week and day of the week on which to repeat the 
meeting, and the number of months that pass before 
the meeting repeats.

Yearly: Repeats the meeting every year until the ending 
date that you select.

■ Every [month] [date]: Specifies the specific month 
and date on which to repeat the meeting each year.

■ [x] [day] of [month]: Specifies the specific week, day 
of the week, and month on which to repeat the meeting 
each year

Use this option... To...
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Questions about setting the date and time for a meeting

Does the meeting end automatically at the time I set?

You can set the time a scheduled meeting starts and the meeting's estimated 
duration. This information allows attendees to reserve the appropriate length of 
time in their schedules. The meeting does not end automatically after the duration 
you set.

What happens if I allow participants to join the meeting before the 
start time?

Participants can see the agenda and other details about the meeting. You can also 
set up a presentation to inform or entertain the participants while they wait for the 
meeting to start. You set up this option on the Agenda & Welcome page.

The option to let participants join the meeting before the host is available only if the 
administrator for your meeting service has turned the option on for your site and 
you schedule the meeting for a time in the future.

How can I learn about the fields on the Date & Time page?

Click the Help link in the top right corner of the Date & Time page, or review About 
the Date & Time page on page 45.

About the Audio Conference Settings page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting >Audio 
Conference.

Ending:

■ No end date: Repeats the meeting indefinitely. That 
is, the meeting recurs until you cancel it.

■ Ending: Specifies the last day on which the meeting 
recurs. You can select the month, day, and year in the 
drop-down lists. Or, you can click Calendar icon, and 
then select a date.

After [x] meetings: Specifies the number of meetings 
after which the meeting stops recurring.

Use this option... To...
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What you can do on this page

■ Include a VoIP (voice over Internet Protocol) session

■ Choose the telephony service you want to use in the meeting you are scheduling

If you choose WebEx Audio, you can set other options, such as whether meeting 
participants call in to the meeting or receive a call back and if the participants 
use a toll or toll-free number.

■ Choose the sound that plays when participants enter or leave the meeting. 

For instance, you can hear a “beep” or have the name of the participant 
announced.

Options on this page

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Use VoIP only Indicate whether you want to set up VoIP only for the 
meeting. Notes:

■ You must start VoIP after you start the meeting. For 
details, see Starting or joining an Integrated VoIP 
conference on page 146.

■ Only participants whose computers meet the system 
requirements for VoIP can participate in the 
conference.

Audio Conference Select the type of audio conference you would like to use:
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WebEx Audio: Specifies that the meeting includes an 
integrated audio conference. If you select this option, 
choose one of the following types of audio conferences:

■ Display toll-free number: If attendees call in to the 
conference, they can call a toll-free number.

Toll number is always displayed: Attendees have 
the option of using the toll number that appears.

■ Allow access to the audio conference via global call-in 
numbers: This option provides a list of numbers—such 
as toll-free or local numbers—that attendees in other 
countries can call to join the audio conference. For 
more details, click here.

Enable teleconference CLI authentication when 
participants call in 
CLI (caller line identification) is a form of caller ID, a 
telephony intelligent service that transmits a caller’s 
telephone number before the call is answered. If you 
use WebEx audio conferencing, you can help 
participants join the meeting more quickly, if 
participants have:

❏ a WebEx host account 

❏ saved their phone numbers in their WebEx profiles

Note This option is not available for Cisco Unified 
MeetingPlace users.

WebEx Personal Conference Number: Displays the 
personal teleconference accounts you have set up in the 
My Profile area of My WebEx. Select the account you 
want to use for your meeting. A maximum of three 
accounts appears. 

Click Edit to make changes, such as updating the 
subscriber or attendee access code.

Note If you have not yet set up any accounts, click 
Create Personal Conference Number to get started. 
This option is not available for Cisco Unified 
MeetingPlace users.

Other teleconferencing service: Specifies that the 
meeting includes a teleconference that another service 
provides. 

■ Instructions: Provides space for you to type 
instructions for joining the teleconference.

Note Instructions for any conferencing option that you 
select automatically appear:

■ On the Meeting Information page on your site, which 
participants can view before you start the meeting

■ In invitation email messages, if you invite participants 
using the Schedule a Meeting page options

■ On the Info tab, which appears in the content viewer in 
the Meeting window

Use this option... To...
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Questions about setting up an audio conference

What kinds of audio conferencing are available?

■ WebEx audio conference—you can use either your telephone or a headset 
connected to your computer as your audio device for participating in a meeting:

■ Computer conference—you can use VoIP (Voice over Internet Protocol), an 
Internet-based telephony service. Any participant whose computer has a 
supported sound card can join the conference. 

■ Telephone conference—you can use your telephone to receive a call back, or 
you can dial in to join the conference.

If you are a host, you can invite up to 500 attendees to participate in the audio 
conference. Participants can choose how they want to join the audio conference. 

If your site includes the international call-back option, participants in other 
countries can receive a call back. For more information about this option, ask 
your meeting administrator. 

■ Third-party or internal teleconference—Any conferencing service other than 
the WebEx Audio conferencing service. You can use any third-party 

Cisco Unified MeetingPlace audio conferencing: 
Specifies that the meeting include an integrated audio 
conference. If you select this option, choose the type of 
conference:

■ Attendees call in: Select if you want customers to dial 
a number to join

■ Attendees receive call back: Select if you want 
customers to type in a phone number and receive a 
call back from the conferencing service.

Tip A participant must have a direct phone line to 
receive a call from the conferencing service. However, a 
participant without a direct phone line can join an audio 
conference by dialing a call-in number, which is always 
available in the meeting window.

None: Specifies that the meeting does not include a 
teleconference, or the meeting includes a teleconference 
for which you will provide information for participants 
using a method other than your meeting service.

Entry & exit tone Select the sound you would like all participants to hear 
when an attendee joins or leaves the meeting:

■ Beep: A simple tone plays

■ Announce name: Upon joining the conference, a 
participant records his or her name, which is then 
played in the conference.

■ No Tone: No alert plays 

Use this option... To...
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conferencing service or internal conferencing system, and provide instructions 
for joining the audio conference when setting up a meeting. Your instructions 
automatically appear in a message box when a participant joins the meeting.

■ Use VoIP Only—A voice conference in which participants use computers with 
audio capability to communicate over the Internet rather than the telephone 
system. 

What are the system requirements for a computer conference?

To include a computer conference, sometimes called VoIP (voice over Internet 
protocol), ensure that your computer meets the following system requirements:

■ A supported sound card

For a current list of supported sound cards, refer to the Frequently Asked 
Questions page on your Meeting Center Web site. You can access this page from 
your site's Support page.

■ Speakers or headphones 

■ Microphone, if you want to speak during the conference

Tip For better audio quality and greater convenience, use a computer headset with 
a high-quality microphone.

When should I select “Use VoIP Only?”

■ Your meeting includes remote attendees who do not want to be charged for 
long-distance phone calls.

■ Your meeting will not involve much interaction—for example, attendees will 
listen to a presentation instead of engage in a discussion.

■ You want to minimize the voice conferencing costs for the meeting.

Check that your computer has the minimum system requirements for VoIP. For 
details, see About the Audio Conference Settings page on page 48.

How can I learn about the fields on the Audio Conference Settings 
page?

Click the Help link in the top right corner of the Audio Conference Settings page, 
or review About the Audio Conference Settings page on page 48.
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About the Invite Attendees page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Invite 
Attendees.

What you can do on this page

■ Invite attendees to your meeting, by entering their email addresses or selecting 
them from your address book.

■ Include a request for attendees to verify that their computers can play Universal 
Communications Format (UCF) media files

■ Enhance meeting security by choosing options for email messages and joining 
the meeting

Options on this page

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Attendees Enter the email addresses of the attendees you want to 
invite to your meeting. 

You can type the addresses, separating them with a 
comma or semicolon or you can click Select Attendees 
to choose attendees from your address book. 
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Questions about inviting attendees

What is an alternate host?

When inviting attendees to a scheduled meeting, you can designate one or more 
attendees as alternate hosts for the meeting. An alternate host can start the meeting 
and act as the host. Thus, an alternate host must have a user account on your 
Meeting Center Web site. 

Once you invite an attendee to a meeting as an alternate host, the attendee receives 
an invitation email message that provides information about acting as the alternate 
host. Your scheduled meeting appears on the alternate host's My WebEx Meetings 
page.

What information is included in the email invitation to my 
meeting?

Each attendee that you invited receives an invitation email message, which includes:

■ A link that the attendee can click to join the meeting or obtain more information 

Request that attendees 
verify rich media players 
before joining meeting

Add a request to invitation email messages for attendees 
to verify that these components are installed on their 
computers for playing a UCF media file:

■ Flash Player, for playing a Flash movie or interactive 
Flash files

■ Windows Media Player for playing audio or video files

This option is useful if you or another presenter plans to 
share a UCF multimedia presentation or standalone UCF 
media files during the meeting.

Send a copy of the invitation 
email to me

Receive a copy of the invitation you are sending to 
attendees. Later, if you decide to invite additional 
attendees, you can simply forward this email message to 
them.

Select Attendees/Edit 
Attendees

Open the Select Attendees page. You can select contacts 
in your personal address book to invite to the meeting.

You can also add a new contact to your address book and 
then invite that contact to your meeting. 

Security Exclude password from email invitations: If you invite 
attendees to a meeting, the meeting password does not 
appear in the email invitations that attendees receive. You 
must provide the password to attendees by another 
means, such as by phone.

Require attendees to have an account on this Web 
site to join this meeting: All attendees must have a user 
account on your site to attend the meeting. 

For information about how attendees can obtain a user 
account, ask your site administrator.

Use this option... To...
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about it

■ The meeting password, if you specified one

■ Audio conference information, if your meeting includes an integrated 
conference

■ The meeting number, which the attendee must provide if your meeting is 
unlisted

Once you start a scheduled meeting, you can invite additional attendees. For details, 
see Inviting attendees to a meeting in progress on page 120.

Can I use my online address book to invite attendees?

You do not have to type the email address of each person you want to invite to your 
meeting. You can select attendees from your address book.

You can access your address book from the Invite Attendees page in the Advanced 
Scheduler.

Why should I request that attendees to check their systems for UCF 
compatibility?

When scheduling a meeting, you can add a request to invitation email messages for 
attendees to verify that the following components are installed on their computers 
for playing Universal Communications Format (UCF) media files:

■ Flash Player, for playing a Flash movie or interactive Flash files

■ Windows Media Player for playing audio or video files

This option is useful if you or another presenter plans to share a UCF multimedia 
presentation or standalone UCF media files during the meeting. 

Your request automatically appears in any invitation email messages that you send 
to attendees using the Advanced Scheduler invitation options. Your request also 
includes a link that attendees can click to access the Verify Rich Media Players page 
on your Meeting Center Web site. This page allows attendees to automatically verify 
that the required players are installed on their computers.

Note If you intend to allow attendees to share to share UCF multimedia 
presentations or standalone UCF media files, ensure that the Enable UCF rich 
media for attendees check box is selected on the Meeting Options page in the 
Advanced Scheduler. For details, see Why should I request that attendees to check 
their systems for UCF compatibility? on page 55.
55



Chapter 4: Scheduling a Meeting
How can I learn about the fields on the Invite Attendees page?

Click the Help link in the top right corner of the Invite Attendees page, or review 
About the Invite Attendees page on page 53.

How can I enhance meeting security?

When scheduling a meeting, you can require all attendees to have a user account on 
your site. If you include this requirement (an option on the Invite Attendees page), 
attendees must log in to your Meeting Center Web site to attend the meeting, which 
enhances meeting security.

Each invited attendee automatically receives an invitation email message. To help 
increase the security for your meeting, you can prevent the meeting password from 
appearing in these invitations by selecting the Exclude password from email 
invitation option on the Invite Attendees page. If you exclude the password in 
email invitations, however, you must provide the password to attendees using 
another method—for example, by phone.

 About the Registration page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Registration

What you can do on this page

■ Determine whether attendees must register to attend a meeting.

■ If attendees must register, select which information attendees must provide on 
the registration form.

■ Accept registration requests automatically.
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Questions about registration

What are the benefits of requiring attendees to register for a 
meeting?

You can require meeting attendees to register for a meeting before they can join it. 
Requiring registration allows you to:

■ View a list of attendees to determine whether they have registered for the 
meeting

■ Obtain attendees' names, email addresses, and optionally additional personal 

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Registration ■ None: Specifies that attendees need not register to 
attend the meeting.

■ Require attendee registration: All attendees must 
register to attend the meeting. An attendee cannot 
attend the meeting until his or her registration you 
accept his or her registration request.

You can accept registration requests in either of two 
ways:

■ Automatically, by selecting the Automatically accept 
all registration requests option on this page.

■ Manually, by using the options on the Registered 
Attendees page. For details, see Accepting or 
Rejecting Registration Requests.

Obtain detailed attendee 
information

Select which information attendees must provide to 
register for the meeting. Information that you do not 
select still appears on the form, but attendees need not 
provide it to register for the meeting.

Automatically accept all 
registration requests

Accept all registration requests automatically, and lets all 
registrants attend the meeting. You do not receive 
registration requests. If this option is not selected, you 
must accept or reject each registration request 
individually, using the options on your meeting service 
Web site.
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information before they can join the meeting

■ Accept or reject individual registration requests

■ Increase the security of your meeting

If you invite an attendee to a meeting that requires registration, the attendee 
receives an invitation email message that includes information about the meeting 
and a link that the attendee can click to register for the meeting.

Important If you accept registration requests automatically for a meeting that 
requires a password—and an attendee registers after the meeting has already 
started—the attendee can join the meeting immediately, without providing the 
password. Therefore, to secure a meeting from unauthorized access, you must clear 
the Automatically accept all registration requests check box, and manually accept 
or reject all registration requests. 

If you do not accept registration requests automatically for a meeting that requires 
a password—and an attendee registers after the meeting has already started—the 
attendee cannot join the meeting until he or she receives a registration confirmation 
email message and can provide the meeting password. During the meeting, you can 
check for registration requests in your email program and accept them to allow 
attendees to join the meeting.

How do I accept or reject registration requests?

If you scheduled a meeting for which attendees must register, you can accept or 
reject attendees' registration requests. If you accept a registration request, a 
registration confirmation email message which provides the meeting password, if 
any is sent the attendee. If you reject a registration request, a registration rejection 
email message is sent to the attendee. 

Note If you select the Automatically accept all registration requests check box on 
the Registration page, all registration requests are accepted automatically and a 
registration confirmation email message is sent to each attendee who registers.

To accept or reject registration requests:

1 Log in to your meeting service Web site. For details, see Logging In to Your 
Meeting Service Web Site.

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, click the meeting topic link for the meeting for which you 
want accept or reject registration requests.
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The Meeting Information page appears.

4 Click Attendees.

The Registered Attendees page appears, showing a list of attendees who have 
registered for the meeting. 

5 Select the check box for each attendee for whom you want to accept or reject a 
registration request. 

■ To select all attendees currently appearing in the list, click Select All. 

■ To clear all selections in the current list, click Clear All. 

6 Opt to approve or reject selected registration requests.

■ Click Accept to approve the registration requests for all attendees that you 
selected

■ Click Reject to reject the registration requests for all attendees that you 
selected.

Tip You can sort the registered attendees list by clicking the column headings.

You can also open the Registered Attendees page by selecting the meeting on the 
public Browse Meetings page. Then click Get Info> Attendees.

How can I learn about the fields on the Registration page?

Click the Help link in the top right corner of the Registration page, or review About 
the Registration page on page 56.

About the Agenda & Welcome page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Agenda & 
Welcome.
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What you can do on this page

■ Enter an agenda for your meeting.

■ Choose a template for the Info tab in the Meeting window.

■ Automatically show a document or presentation to participants once they join 
the meeting.

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Agenda Set the agenda for the meeting. You can type up to 2500 
characters, including spaces and punctuation. The 
agenda appears on the Meeting Information page for the 
meeting on your meeting service Web site.

Info tab templates Lets you choose a template for the Info tab, which 
appears in the content viewer during the meeting. The 
Info tab contains information about the meeting, such as 
the:

■ Meeting host

■ Conference phone numbers

■ Host key (if you are the host) 

You can choose another template only if your site 
administrator has provided one or more customized Info 
tab templates for your meeting service. 
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Automatically share 
presentation or document 
once a participant joins the 
meeting

Select a presentation or document to share automatically. 
after a participant joins the meeting. This option is useful 
if you allow attendees to join the meeting before the host.

The file that you select must:

■ Be in the Universal Communications Format (UCF). 
For information about creating UCF files, refer to the 
guide, Getting Started with WebEx Universal 
Communications Toolkit, which is available on your 
meeting service Web site. 

■ Reside in your personal folders on your meeting 
service Web site. You can select a UCF file that 
already resides in your folders, or upload a new file to 
your folders while scheduling a meeting. 

■ Browse Opens the Add/Select Presentation page. You can select 
a UCF presentation or document that resides in your 
personal folders, or upload a new file to your folders.

■ Delete Delete the selected presentation or document from the 
box.

■ Start automatically Have presentation slides or document pages advance 
automatically in the content viewer at the time interval you 
choose.

■ Select this option only if the presentation or document 
contains multiple slides or pages. 

■ Do not select this option if the presentation or 
document contains UCF media files.

Continuous play: Available only if you select Start 
automatically. Specifies that shared presentation or 
document restarts once it is finished, and continues 
advancing page automatically.

Advance page every [x] seconds: Available only if you 
select Start automatically. Lets you select the frequency 
at which slides or pages advance automatically.

Allow participants to control file: Let participants 
navigate the presentation or document independently in 
their content viewers. The slides or pages do not advance 
automatically. 

Select this option if the presentation or document contains 
only one slide or page, or if it contains any UCF rich media 
objects, such as audio or video objects.

Quick Start Select this option to display the Quick Start page to host 
and presenter at the start of the meeting. If not selected, 
the Info page displays at the start of the meeting.

The Quick Start page provides easy access for sharing a 
document, application, Web browser or other item with 
participants.

Use this option... To...
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Questions about setting the meeting agenda and welcome

Can I change how the information on the Info tab displays?

You can choose a template for the Info tab, which appears in the content viewer 
during the meeting. The Info tab contains information about the meeting, 
including the meeting host, conference phone numbers, and host key (for the host 
only). 

Note You can choose another template only if one or more customized Info tab 
templates are available for your meeting service. Your site administrator can add 
templates for your service.

Why would I want to share a document before the meeting starts?

When scheduling a meeting, you can select a presentation or document to share 
automatically in the content viewer once a participant joins the meeting. If the 
presentation or document contains multiple pages, you can also automatically 
advance its pages at a specified interval.

You can use this opportunity to share a presentation that informs or entertains 
participants while they wait for you to start the meeting.

The presentation or document that you select must:

■ Be in the Universal Communications Format (UCF). For information about 
creating UCF files, review the Getting Started with WebEx Universal 
Communication Toolkit, available on your Meeting Center Web site; click 
Support > User Guides from the Welcome page.

■ Reside in your personal folders in the My WebEx area on your Meeting Center 
Web site. You can select a UCF file that already resides in your folders, or upload 
a new file to your folders while scheduling a meeting.

Important If you share a UCF multimedia presentation that includes rich media 
files—such as audio or video files—follow these guidelines:

■ Ensure that each media file is embedded in the presentation file or resides on a 
publicly accessible Web server. If the presentation contains a link to a media file 
that resides on your computer, participants cannot view that media file. For 
more information about creating UCF multimedia presentations, refer to the 
guide Getting Started with WebEx Universal Communications Toolkit, which is 
available on your Meeting Center Web site. 

■ Select Allow participants to control file on the Agenda and Welcome page. If 
you do not select this option, the pages or slides in the document or presentation 
will advance automatically, which may prevent participants from viewing the 
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media files.

■ Ensure that each media file is set to play automatically for participants. For more 
information about setting this option for a UCF media file, refer to the guide 
Getting Started with WebEx Universal Communications Toolkit, which is available 
on your Meeting Center Web site.

What is the Quick Start page? 

The Quick Start page allows a presenter to quickly display a document, application 
or other item they want to share during a meeting. If the Quick Start option is 
selected by the host on the Meeting Agenda & Welcome page, Quick Start is 
available to participants throughout the meeting by clicking the Quick Start tab in 
the content viewer. 

For more details about any of the actions available from Quick Start, click the Learn 
More link.

Can I change the meeting agenda or add one after I have set up my 
meeting?

You can easily edit a scheduled meeting. You can edit it from the link in the 
confirmation email message you received or from your Meeting Center Web site. 
For detailed instructions, see Editing a scheduled meeting on page 76.

How can I learn about the fields on the Agenda & Welcome page?

Click the Help link in the top right corner of the Agenda & Welcome page, or review 
About the Agenda & Welcome page on page 59.

About the Meeting Options page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Meeting 
Options
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What you can do here

■ Select which options are available during the meeting.

■ Decide whether you want to receive feedback forms that participants fill out at 
the end of the meeting.

Your site administrator determines whether the Feedback form appears after 
each meeting. If the form does not appear after a meeting, your site 
administrator has turned off this option for your meeting service.

■ Specify whether attendees can share UCF rich media files.

■ Select alerts that sound when a participant joins or leaves the teleconference, if 
you use integrated teleconferencing.

Options on this page

Use this option... To...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, see 
Using meeting templates on page 70.

Meeting Options Select which meeting options are available during the 
meeting. If an option is not selected, it is unavailable 
during the meeting.

A presenter can turn any option on or off during the 
meeting.

Chat: Specifies that chat options are available in the 
Meeting window during the meeting. 
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Video: Specifies that video options are available in the 
Meeting window during the meeting.

■ Single-point: Lets only the presenter send live video 
during the meeting.

■ Multipoint: Lets the presenter and up to three other 
participants send live video during the meeting.

■ Single-point and Multipoint options appear only if 
your meeting service Web site has the multipoint video 
option. To turn on the multipoint video option for your 
site, please contact WebEx Communications.

Notes: Specifies that note-taking options are available in 
the Meeting window during the meeting.

■ Allow participants to take notes: Lets all participants 
take their own notes during the meeting, and save 
them to their computers.

■ Single note taker: Lets only one participant take notes 
during the meeting. By default, the host is the 
note-taker, but can designate another participant as 
the note-taker during the meeting. A note-taker can 
publish notes in all participants' Meeting windows at 
any time during the meeting. The host can send a 
transcript of the notes to participants at any time.

Enable closed captioning: Lets one participant—the 
closed captionist—transcribe notes during the meeting. 
Closed captioning is useful if hearing-impaired 
participants are attending the meeting. By default, the 
host is the closed captionist, but can designate another 
participant as the closed captionist during the meeting. 
Meeting Manager publishes closed captions in all 
participants' Meeting windows once the closed captionist 
presses the Enter key on his or her keyboard. Thus, notes 
are usually published one line at a time. The host can 
send a transcript of the closed captions to participants at 
any time.

File transfer: Specifies that the presenter can publish 
files and attendees can download them during a meeting. 

Recording: Specifies that recording options are available 
during a meeting—that is, the host and presenter can 
record the meeting, and attendees can record the meeting 
if they have recording privileges. 

Send feedback form to host: Sends all Feedback forms 
that any participants fill out to the host's email address. 
The Feedback form automatically appears on each 
participant's screen after the meeting ends.

Enable UCF rich media for attendees: Allows attendees 
to share Universal Communications Format (UCF) media 
files during the meeting, either in a UCF multimedia 
presentation or as standalone UCF media files. A meeting 
host who is also the presenter can always share UCF 
media files, whether or not you select this check box.

Use this option... To...
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Note A presenter can change the default privileges for all attendees or individual 
attendees at any time during a meeting.

Questions about setting meeting options

Why would I want to include a feedback form?

Once you end a meeting, a feedback form appears in each participant's Web 
browser. On the form, participants can provide their comments about your 
meeting or meeting service. You can have the completed feedback forms sent to 
your email address.

Note Your site administrator determines whether the feedback form appears after 
each meeting. If the form does not appear after a meeting, your site administrator 
has turned off this option for your meeting service.

What are some rules of thumb for sharing UCF media files?

When scheduling a meeting, you can allow attendees to share Universal 
Communications Format (UCF) media files during the meeting, either in a UCF 
multimedia presentation or as standalone UCF media files.

You can also prevent attendees from sharing UCF media files during a meeting. If 
you do so, only the meeting host can share UCF media files when also acting as the 
presenter.

You may want to prevent attendees from sharing UCF media files, for example, if 
you intend to allow attendees to share presentations or documents but want to 
prevent an attendee from inadvertently sharing a very large media file.

Note The alerts options are applicable only if you select an integrated 
teleconference on the Teleconference page in the Advanced Scheduler. For more 
information about setting up an integrated teleconference, see About the Audio 
Conference Settings page on page 48.

How can I learn about the fields on the Meeting Options page?

Click the Help link in the top right corner of the Meeting Options page, or review 
About the Meeting Options page on page 63.
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About the Attendee Privileges Page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Attendee 
Privileges

What you can do on this page

Select the meeting privileges that attendees have once the meeting starts.

Note A presenter can grant any privileges to or remove them from attendees during 
a meeting

Options on this page

With this privilege... Attendees can...

Choose a Template/

Set options using

Select a template and use the settings saved in that 
template for this meeting.

You can save time by using a template that includes the 
list of attendees you want to invite, a presentation you 
want to show before the meeting starts, and other options 
you have used in a previous meetings and saved as a 
template. 

For more details about creating and editing templates, 
see Using meeting templates on page 70.

Save Save any shared documents, presentations, or 
whiteboards that appear in their content viewers.

Print Print any shared documents, presentations, or 
whiteboards that appear in their content viewers.
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Questions about attendee privileges

Besides the host, who can grant and remove attendee privileges?

A presenter can grant any privileges to or remove them from attendees during a 
meeting.

Can I change attendee privileges during a meeting?

Yes, you can. On the Meeting menu, choose Attendees Privileges. Make any changes 
to the privileges you set when you scheduled the meeting.

Annotate Annotate any shared documents or presentations, or 
write and draw on shared whiteboards that appear in their 
content viewers, using the toolbar that appears above the 
viewer. An attendee's annotations are visible to all 
participants.

View participant list View the participant list on the Participants panel. 

View thumbnails Display miniatures of any pages, slides, or whiteboards in 
any document, presentation, or whiteboard that appear in 
their content viewers.

However, attendees with this privilege cannot display a 
miniature at full size unless they also have the View any 
page privilege.

Control applications, Web 
browser, or desktop 
remotely

Request that the presenter grant them remote control of 
a shared application, Web browser, or desktop.

View any document View any document, presentation, or whiteboard that 
appears in the content viewer, and navigate to any pages 
or slides in documents or presentations.

View any page View any pages, slides, or whiteboards that appear in 
their content viewers. This privilege allows attendees to 
navigate independently through pages, slides, or 
whiteboards.

Contact operator privately Dial 00 at any time during a teleconference to contact the 
operator for your teleconferencing service.

Available only if your site includes the private operator 
option.

Participate in private chat 
with:

Send private chat messages to another participant. 
Private chat messages appear only in the recipient's 
Chat viewer.

Host: Chat privately with the meeting host.

Presenter: Chat privately with only the presenter.

All attendees: Chat privately with any other attendee. 

With this privilege... Attendees can...
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How can I learn about the fields on the Attendee Privileges page?

Click the Help link in the top right corner of the Attendee Privileges page, or review 
About the Attendee Privileges Page on page 67.

About the Review page

How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting > Review

What you can do on this page

■ Review all the information you’ve entered on each page of the Advanced 
Scheduler. 

■ If you want to make any changes, return to the page where you entered the 
information and enter new information.

■ Rather than using the settings and options you have just selected in the 
scheduler, replace these setting with those in one of the meeting templates. 

For more details about creating and editing templates, see Using meeting 
templates on page 70

When you have finished making changes, click Schedule or Start.

Saving time when scheduling meetings

If you want to... See...

use a template with preset options when 
scheduling your meeting

Using an existing meeting template for 
scheduling a meeting on page 70

use a template with preset options and save 
your changes to the template

Using an existing meeting template and 
overwriting the template settings on page 71
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Using meeting templates

If you meet with the same group of people and often schedule a meeting with the 
same tracking codes, audio settings and other meeting options, you can save these 
settings in a template. When you set up the first meeting, you can save your settings 
in a template. Later, when it is time to schedule another meeting, you can select that 
template from any page on the Quick Scheduler or Advanced Scheduler. 

You have three ways to use an existing meeting template:

■ Use the template, without saving any changes to it

You can use the template as is or make changes to the settings without saving 
these changes to the template itself. For details, see Using an existing meeting 
template for scheduling a meeting on page 70.

■ Make changes to the template settings and save the changes in the template

You can save these changes in the template, if you want to make permanent 
changes to the template. For details, see Using an existing meeting template and 
overwriting the template settings on page 71.

■ Make changes to the template settings and save them in a new template

You can make changes to the template as you schedule your meeting. Then save 
your changes in the template, if you want to make a permanent change to the 
template.

For details, see Using an existing meeting template and saving the changes in a new 
template on page 72.

Using an existing meeting template for scheduling a meeting

You can use the template without making changes to any details, or you can make 
changes on any page in the scheduler. 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The meeting scheduler appears.

4 Select the template you want to use in the Set options using template drop-down 
list.

Look for the list on any title bar in the Quick Scheduler or Advanced Scheduler.

use a template with preset options and save 
the changes in a new template

Using an existing meeting template and 
saving the changes in a new template on 
page 72

set up a recurring meeting Setting up a recurring meeting on page 73

If you want to... See...
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5 Optional. Make changes to the settings on any page. 

For instance, you can add or remove attendees or show a new presentation as 
attendees join the meeting. Just go to the page in the scheduler that you want to 
change.

6 Start or schedule the meeting:

■ If the meeting's starting time is the current time, click Start to start the 
meeting.

■ If the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled. 
You also receive a confirmation email message that includes information about 
the scheduled meeting.

Using an existing meeting template and overwriting the template 
settings

You can open an existing meeting template and change the settings. You can save 
your changes to the template.

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The meeting scheduler page appears.

4 Select the template you want to use in the Set options using template drop-down 
list.

These templates are available. 
You can select one from this list 
and use it to quickly schedule 
your meeting.

The template in brackets is the 
default template provided by your 
site administrator. 
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5 Make changes to the details on any page. 

For example, you can add or remove attendees, change the meeting time, add a 
multimedia document to display before the meeting starts. For details about 
fields on each page, see Page-by-page guide to the Advanced Scheduler on page 42.

6 Click Save as Template.

You see a list of templates you can assign these new settings to.

7 To update an existing meeting template with your changes, select the template 
you want to change and click Save.

A message box appears, asking if you want to replace the template you have 
selected with the edited template.

8 To save your changes in the template, click OK.

Using an existing meeting template and saving the changes in a 
new template

You may host a series of meetings with the same agenda, but different attendees. To 
save time, you can reuse the settings in a template, make changes (such as adding or 
removing attendees) and then save the updates in a new template. 

Find the existing meeting template with similar settings. You can save the changes 
in a new template.

1 Log in to your Meeting Center Web site. 

These templates are available. 
You can select one from this list 
and use it to quickly schedule 
your meeting.

The template in brackets is the 
default template provided by your 
site administrator. 

Select the template you 
want to update with new 
settings from this list.

Then click Save.
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2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The meeting scheduler appears.

4 Select the template you want to use in the Set options using template drop-down 
list.

5 Make changes to the details on any page. 

For example, you can add or remove attendees, change the meeting time, add a 
multimedia document to display before the meeting starts. For details about 
fields on each page, see Page-by-page guide to the Advanced Scheduler on page 42.

6 Click Save as Template.

7 In the Template Name box, type a name for this new template.

8 Click Save.

Setting up a recurring meeting

For meetings that occur on a regular basis, such as a monthly company meeting or 
weekly status meeting, you can set up a recurring meeting. You set up the meeting 
one time and include the email addresses of attendees, the teleconferencing details, 
the time and interval (for instance, daily, weekly, or monthly). You send out one 
invitation for a series of meetings. 

These templates are available. 
You can select one from this list 
and use it to quickly schedule 
your meeting.

The template in brackets is the 
default template provided by your 
site administrator. 

Type a name for this new 
version of the template 
here. 

Then click Save.

Note: You have not changed 
the original template.
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To set up a recurring meeting:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The Schedule a Meeting Wizard appears, showing the Required Information 
page.

4 Click Date & Time.

Set the date and time for the meeting. Review the information below about the 
options for recurring meetings.

5 Add other details about your recurring meeting. For details information about 
the other pages in the Advanced Scheduler, see Page-by-page guide to the 
Advanced Scheduler on page 42.

6 When you have finished scheduling your meeting, click Schedule or Start.

Options for setting up a recurring meeting

Option Description

Daily Repeats the meeting every day until the ending date that you select.

■ Every [x] days: Repeats the meeting after the specified number of 
days pass. 

■ Every weekday: Repeats the meeting each day, from Monday to 
Friday.

■ Weekly: Repeats the meeting every week until the ending date that 
you select.

■ Sunday - Saturday: Specifies the day on which the meeting repeats 
every week. You can select one or more days. 

Monthly Repeats the meeting every month until the ending date that you select.

■ Day [x] of every [x] months: Specifies the specific day of the month 
on which to repeat the meeting, and the number of months that pass 
before the meeting repeats.

■ [x] [x] of every [x] months: Specifies the specific week and day of the 
week on which to repeat the meeting, and the number of months that 
pass before the meeting repeats.

Yearly Repeats the meeting every year until the ending date that you select.

■ Every [month] [date]: Specifies the specific month and date on which 
to repeat the meeting each year.

■ [x] [day] of [month]: Specifies the specific week, day of the week, 
and month on which to repeat the meeting each year
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Managing and maintaining your scheduled 
meetings

You can easily invite more participants to a scheduled meeting, change the day or 
time, or even add the meeting to your calendar program.

Adding a scheduled meeting to your calendar program

Once you schedule a meeting, you can add the meeting to your calendar program, 
such as Microsoft Outlook. This option is applicable only if your calendar program 
supports the iCalendar standard, a common format for exchanging calendaring and 
scheduling information across the Internet.

To add a scheduled meeting to your calendar:

1 Do one of these tasks, as appropriate:

■ On the Meeting Scheduled page, click Add to My Calendar.

■ On the Meeting Updated page, click Update My Calendar.

■ On the Meeting Information page for the meeting, click Add to My Calendar.

■ In the confirmation email message that you receive once you schedule or edit 
a meeting, click the link to add the meeting to your calendar.

A meeting item opens in your calendar program.

2 Select the option to accept the meeting request. For example, in Outlook, click 
Accept to add the meeting item to your calendar.

Ending ■ No end date: Repeats the meeting indefinitely. That is, the meeting 
recurs until you cancel it.

■ Ending: Specifies the last day on which the meeting recurs. You can 
select the month, day, and year in the drop-down lists. Or, you can 
click Calendar icon, and then select a date.

After [x] meetings: Specifies the number of meetings after which the 
meeting stops recurring.

Option Description

If you want to... See...

add a scheduled meeting to your calendar Adding a scheduled meeting to your calendar 
program on page 75

make changes to a scheduled meeting Editing a scheduled meeting on page 76

start a scheduled meeting Starting a scheduled meeting on page 77

cancel a scheduled meeting Canceling a scheduled meeting on page 78
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Note

■ If you cancel a meeting, the Meeting Deleted confirmation page and the 
confirmation email message that you receive contains an option that lets you 
remove the meeting from your calendar program. 

■ If you invite attendees to a meeting, the invitation email message that they 
receive contains an option to add the meeting to their calendar programs.

Editing a scheduled meeting

Once you schedule a meeting, you can make changes to it at any time before you 
start it—including its starting time, topic, password, agenda, attendee list, and so 
on.

If you update any information about a meeting, including adding or removing 
attendees, you can choose to send attendees a new invitation email message that 
informs them that you have modified information about the meeting. Attendees 
whom you removed from the attendee list receive an email message informing them 
that you have retracted their invitations.

You can modify a meeting from the confirmation email message that you received 
after you scheduled the meeting or from your list of meetings in My WebEx.

To edit a meeting from the confirmation email message: 

1 Open your confirmation email message, and then click the link.

If you are not already logged in to your Meeting Center Web site, the Log In page 
appears.

2 If the Log In page appears, provide your account user name and password, and 
then click Log In.

The Meeting Information page appears.

3 Click Edit.

4 Modify the meeting. For more information about the options that you can 
modify, see Using the Advanced Scheduler on page 39.

5 To save your changes to the meeting, click Save.

If you invited attendees, a message appears, asking you whether you want to send 
an updated email invitation to attendees.

6 If a message box appears, click the appropriate update option, and then click 
OK.

The Meeting Updated page appears.

You receive a confirmation email message that includes information about the 
changes that you made to the meeting.
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7 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, on the Meeting Updated page, click Update My Calendar.

To edit a scheduled meeting from your list of meetings on your Meeting Center 
Web site:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, under Topic, click the topic for the meeting.

4 Click Edit. 

5 Modify the meeting. For more information about the options that you can 
modify, see Using the Advanced Scheduler on page 39.

6 Click Save.

If you invited attendees, a message appears, asking you whether you want to send 
an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click 
OK.

If you click Cancel in the message box, the meeting is not updated.

The Meeting Updated page appears. You receive a confirmation email message 
that includes information about the changes that you made to the meeting.

8 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, in the confirmation email message, click Update My Calendar.

Starting a scheduled meeting

Meetings do not start automatically at scheduled times. If, when scheduling the 
meeting, you did not select the option that allows participants can join the meeting 
before the host, you must start the meeting before participants can join it.

After you schedule a meeting, you receive a confirmation email message that 
includes a link that you can click to start the meeting. Or, you can start the meeting 
from your list of meetings in My WebEx.

To start a meeting from the confirmation email message:

1 Open your confirmation email message, and then click the link.

If you are not already logged in to your Meeting Center Web site, the Log In page 
appears.

2 If the Log In page appears, provide your account user name and password, and 
then click Log In.

The Meeting Information page appears.
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3 Click one of the following:

■ Start Now. Appears if the meeting is not in progress.

■ Join Now. Appears if you allowed participants to join the meeting before its 
starting time and participants have already joined the meeting.

The Meeting window appears.

To start a scheduled meeting from your list of meetings on your Meeting Center 
Web site:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, under Status, click one of the following:

■ Start. Appears if the meeting is not in progress.

■ Join Now. Appears if you allowed participants to join the meeting before its 
starting time and participants have already joined the meeting.

The Meeting window appears.

Canceling a scheduled meeting

You can cancel any meeting that you have scheduled. Once you cancel a meeting, 
you can choose to send a cancellation email message to all attendees whom you 
invited to the meeting. Canceling a meeting deletes it from your personal list of 
meetings.

You can cancel a meeting from the confirmation email message that you received 
after you scheduled the meeting or from your list of meetings in My WebEx.

To cancel a meeting from a confirmation email message:

1 Open your email confirmation message, and then click the link.

If you are not already logged in to your Meeting Center Web site, the Log In page 
appears.

2 If the Log In page appears, provide your account user name and password, and 
then click Log In.

The Meeting Information page appears.

3 Click Delete.

If you invited attendees, a message appears, asking you whether you want to send 
a cancellation email message to all attendees whom you invited to the meeting.

4 In the message box, click Yes or No, as appropriate.

If you click Cancel in the message box, the meeting is not canceled.
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The Meeting Deleted page appears.

5 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, on the Meeting Deleted page, click Remove From My Calendar to 
remove the meeting from your calendar.

To cancel a scheduled meeting from your list of meeting on your Meeting Center 
Web site:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, under Topic, click the topic for the meeting.

4 Click Delete. 

If you invited attendees, a message appears, asking you whether you want to send 
a cancellation email message to all attendees whom you invited to the meeting.

5 In the message box, click Yes or No, as appropriate.

If you click Cancel in the message box, the meeting is not canceled.

You receive a cancellation confirmation email message.

6 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, in the confirmation email message, click the link to remove the 
meeting from your calendar.
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5
Scheduling an Audio Only 
meeting

About Audio Only meetings
If you do not need to share a presentation, document, or application with meeting 
attendees, you can set up an Audio Only meeting. As in any teleconference, your 
phone is the only means of communicating with attendees; no chatting or drawing 
on the whiteboard. 

When you invite attendees, you assign them speaking privileges, so you control who 
can speak.

Setting up an Audio Only meeting

1 Log in to your Meeting Center Web site.

2 On the left navigation bar, click Host a Meeting> Audio Only.

The Audio Only Scheduler displays.

3 On the Required Information. page, type the details that are required.

If you want to... See...

Schedule an Audio Only meeting Setting up an Audio Only meeting on page 81

Make changes to the meeting you 
have scheduled

Editing an Audio Only meeting on page 83

Start your Audio Only meeting Managing and maintaining your scheduled meetings on 
page 83

Cancel your Audio Only meeting Canceling an Audio Only meeting on page 85
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You can choose other options, such as removing this meeting from your meeting 
calendar after the meeting is over.

For an overview of this page and the information requested, click the Help 
button in the upper-right corner of the page.

4 Schedule your meeting now, or add more details.

■ To schedule your meeting with these details, click Schedule Meeting

■ To add more options, click Next or click a link to another page in the 
scheduler. After you have added the details you need, click Schedule Meeting.

Starting an Audio Only meeting

Meetings do not start automatically at scheduled times. To start a Audio Only 
meeting, dial the number listed in the confirmation email or on the Audio Only 
Meeting Information page. 

To access the Audio Only Meeting Information page:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, click the Topic or Display Info link for your Audio Only 
meeting.

The Audio Only Meeting Information page displays.

Under Teleconference, look for the valid phone number or numbers for your 
teleconference. You’ll also find the meeting number, password, and host key.
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Managing and maintaining your scheduled 
meetings

Adding a scheduled meeting to your calendar program

Once you schedule a meeting, you can add the meeting to your calendar program, 
such as Microsoft Outlook. This option is applicable only if your calendar program 
supports the iCalendar standard, a common format for exchanging calendaring and 
scheduling information across the Internet.

To add a scheduled meeting to your calendar

1 Choose either method:

■ On the Audio Only Meeting Information page for the meeting, click Add to 
My Calendar.

■ In the confirmation email message that you receive once you schedule or edit 
a meeting, click the link to add the meeting to your calendar.

A meeting item opens in your calendar program.

2 Select the option to accept the meeting request. For example, in Outlook, click 
Accept to add the meeting item to your calendar.

Note

■ If you cancel a meeting, the Meeting Deleted confirmation page and the 
confirmation email message that you receive contains an option that lets you 
remove the meeting from your calendar program. 

■ If you invite attendees to a meeting, the invitation email message that they 
receive contains an option to add the meeting to their calendar programs.

Editing an Audio Only meeting

Once you schedule a meeting, you can make changes to it at any time before you 
start it—including its starting time, topic, password, agenda, attendee list, and so 
on.

If you want to... See...

add a scheduled meeting to your calendar Adding a scheduled meeting to your calendar 
program on page 83

make changes to a scheduled meeting Editing an Audio Only meeting on page 83

start a scheduled meeting Managing and maintaining your scheduled 
meetings on page 83

cancel a scheduled meeting Canceling an Audio Only meeting on page 85
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If you update any information about a meeting, including adding or removing 
attendees, you can choose to send attendees a new invitation email message 
containing the new details about the meeting. Attendees removed from the attendee 
list receive an email message letting them know that they are no longer asked to 
attend.

If you are logged in, you can edit meeting details from the confirmation email 
message that you received after you scheduled the meeting or from your list of 
meetings in My WebEx.

To edit a meeting from the confirmation email message: 

1 Open your confirmation email message, and then click the link to view your 
meeting information.

The Audio Only Meeting Information page appears.

2 Click Edit.

3 Make changes to the meeting details.

For details about the information requested on any page, click the Help button 
in the upper-right corner of the page.

4 To save your changes to the meeting, click Save.

If you invited attendees, a message appears, asking you whether you want to send 
an updated email invitation to attendees.

5 If a message box appears, click the appropriate update option, and then click 
OK.

The Audio Only Meeting Information page appears.

You receive a confirmation email message that includes information about the 
changes that you made to the meeting.

6 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, on the Meeting Updated page, click Add to My Calendar.

To edit a scheduled meeting from your list of meetings on your Meeting Center 
Web site:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, under Topic, click the topic for the meeting.

4 Click Edit. 

5 Make changes to the meeting details. 

For details about the options on each page, click the Help button in the 
upper-right corner of the page.
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6 Click Save.

If you invited attendees, a message appears, asking you whether you want to send 
an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click 
OK.

If you click Cancel in the message box, the meeting is not updated.

8 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, in the confirmation email message, click Update My Calendar.

Canceling an Audio Only meeting

You can cancel any Audio Only meeting you have scheduled. Once you cancel an 
Audio Only meeting, you can choose to send a cancellation email message to all 
attendees whom you invited to the meeting. The meeting is removed automatically 
from your list of meetings in My WebEx.

If you are logged in, you can cancel an Audio Only meeting from the confirmation 
email message that you received after you scheduled the meeting or from your list 
of meetings in My WebEx.

To cancel an Audio Only meeting from a confirmation email message:

1 Open your confirmation email message, and then click the link to view your 
meeting information.

The Audio Only Meeting Information page appears.

2 Click Delete.

If you invited attendees, a message appears, asking you whether you want to send 
a cancellation email message to all attendees whom you invited to the meeting.

3 In the message box, click Yes or No, as appropriate.

If you click Cancel in the message box, the meeting is not canceled.

The Meeting Deleted page appears.

4 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, on the Meeting Deleted page, click Remove From My Calendar to 
remove the meeting from your calendar.

To cancel a scheduled meeting from your list of meeting on your Meeting Center 
Web site:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

The My Meetings page appears, showing a list of any meetings that you have 
scheduled.

3 In the list of meetings, under Topic, click the topic for your Audio Only meeting.
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4 Click Delete. 

If you invited attendees, a message appears, asking you whether you want to send 
a cancellation email message to all attendees whom you invited to the meeting.

5 In the message box, click Yes or No, as appropriate.

If you click Cancel in the message box, the meeting is not canceled.

You receive a cancellation confirmation email message.

6 Optional. If you added the meeting to your calendar program, such as Microsoft 
Outlook, on the Meeting Deleted page, click Remove From My Calendar to 
remove the meeting from your calendar.

Adding a meeting to your Lotus Notes calendar

You need to move your meeting invitation from your Lotus Notes inbox to your 
calendar

1 Open the meeting invitation.

2 Right-click the icon to view attachments to this message.

3 On the list of attachments, select the file in iCalendar format (*.ics).

4 Save this file.

Saving it to your desktop provides easy access to it. Also, give the file a 
memorable name, such as Project Kickoff.ics, or Weekly Team 
Meeting.ics.

5 Display your Lotus Notes calendar.

6 Drag the file you just saved to your Lotus Notes Calendar icon on the Windows 
Taskbar.

This file contains the 
information Lotus 
Notes needs to 
schedule this meeting 
on your calendar.

Drag this file to the 
Lotus Notes Calendar 
icon on the Windows 
Task bar
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7 In Lotus Notes calendar, select the Meetings tab.

8 Display the invitation you just dragged to the Lotus Notes Calendar icon.

9 On the Respond menu, choose Accept.

Review your Lotus Notes calendar. The invitation you just accepted now displays as 
an entry in your calendar.

Updating a meeting on your Lotus Notes calendar

If you receive an email message that includes an update to a meeting you have 
scheduled on your Lotus Notes calendar, you can easily update your calendar with 
the latest details.

1 Open the updated meeting invitation.

2 Right-click the icon to view attachments to this message.

3 On the list of attachments, select the file in iCalendar format (*.ics).

4 Save this file.

Saving it to your desktop provides easy access to it. Also, give the file a 
memorable name, such as Updated Team Meeting.ics, or New time 
Project Kickoff.ics.

5 Display your Lotus Notes calendar.

6 Drag the file you just saved to your Lotus Notes Calendar icon on the Windows 
Taskbar.

7 In Lotus Notes calendar, select the Meetings tab.

Choose Accept in this list.

This file contains the 
information Lotus 
Notes needs to 
schedule this meeting 
on your calendar.
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8 Display the updated invitation you just dragged to the Lotus Notes Calendar 
icon.

9 On the Respond menu, choose Accept.

Review your Lotus Notes calendar. The updated invitation you just accepted now 
displays as in your calendar.

Choose Accept in this list.
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Setting Up a One-Click Meeting

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

About setting up a One-Click Meeting
WebEx One-Click allows you to start a meeting instantly from your desktop 
(desktop version) and from your WebEx service Web site (Web version). You can 
set up one or both versions, depending on your needs:

■ Web version: allows you to start a One-Click Meeting from your WebEx service 
Web site. Doing so does not require you to download any application. For more 
information about the web version, refer to the WebEx One-Click User’s Guide.

■ Desktop version: if this feature is enabled by your site administrator, allows you 
to start and join meetings and send meeting invitations without logging in to 
your Meeting Center site or navigating Web pages. For more information about 

If you want to... See...

get an overview of starting a One-Click 
Meeting from your WebEx service Web site

About setting up a One-Click Meeting on 
page 89

specify settings for your One-Click Meeting Setting up your One-Click Meeting on the Web 
on page 90

install WebEx One-Click, which includes the 
One-Click panel and One-Click shortcuts

Installing the WebEx One-Click Desktop 
Version on page 93

start a One-Click Meeting from your WebEx 
service Web site

Starting a One-Click Meeting on page 95

remove WebEx One-Click, including all 
One-Click shortcuts, from your computer

Removing WebEx One-Click on page 98
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the desktop version, refer to the WebEx One-Click User’s Guide, which is 
available on the Support page of your Meeting Center web site.

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

Setting up your One-Click Meeting on the Web
The One-Click Meeting Setup page allows you to specify options a One-Click 
Meeting. You can return to the One-Click Meeting Setup page at any time to 
modify your meeting.

The settings you specify apply to both the One-Click Web version and the desktop 
version.

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

To set up your One-Click Meeting:

1 Log in to your Meeting Center Web site.

2 Click My WebEx > One-Click Setup (on the left navigation bar).

The One-Click Setup page appears. 

On this screen, you can also download WebEx One-Click to install the WebEx 
One-Click panel and One-Click shortcuts. For details, see Installing the WebEx 
One-Click Desktop Version on page 93.

3 Click Set Up Now.

4 Specify the meeting information and settings on the page. 

For details about the options on the One-Click Settings page, see About the 
One-Click Settings page on page 91.

5 Click Save.

Tip Whenever you want to edit options for your One-Click Meeting, return to 
the One-Click Settings page by clicking My WebEx > One-Click Setup > Edit 
Settings.
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About the One-Click Settings page

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

How to access this page: 

On your Meeting Center Web site, do one of the following:

■ If you are setting up your One-Click Meeting for the first time, on your Meeting 
Center Web site, click My WebEx > One-Click Setup (on the left navigation bar) 
> Set Up Now.

■ If you already set up your One-Click Meeting, on your Meeting Center Web site, 
click My WebEx > One-Click Setup (on the left navigation bar) > Edit Settings.

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

What you can do here:

■ Set options for your One-Click Meeting

■ Download the desktop version of WebEx One-Click. For details, refer to the 
WebEx One-Click User’s Guide, which is available on the Support page of your 
Meeting Center web site.

Meeting Options

Use this option... To...

Service type Select the type of WebEx session for which you want to start a 
One-Click Meeting.

This option lists only the session types available for your site and 
user account.

Meeting template Select the meeting template you want to use to set options for your 
One-Click Meeting. The drop-down list of templates includes:

Standard templates: Templates that your site administrator set up 
for your account.

My Templates: Any personal templates that you created by saving 
the settings for a meeting you previously scheduled, using the 
scheduling options on your site.

Topic Specify the topic for the meeting

Meeting password Specify the password for the meeting.
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Tracking Codes

Audio Conference

Confirm password Type the password again to prevent typing errors.

Listed on calendar Specify that the meeting appears on the calendar on your site.

Use this option... To...

Tracking code Identify your department, project, or other information that your 
organization wants to associate with your meetings. Tracking 
codes can be optional or required, depending on how your site 
administrator set them up. 

If your site administrator requires you to select a code from a 
predefined list, click the link Select Code, and then select a code 
from the list or enter one in the box above. 

Use this option... To...

Use Select the type of audio conference you would like to use:

Use VoIP Only Specify that the meeting includes only Integrated VoIP, which 
allows meeting participants to use computers with audio 
capability to communicate over the Internet rather than the 
telephone system. 

MeetingPlace audio 
conferencing

Specifies that the meeting includes a Cisco Unified 
MeetingPlace audio conference. Call one of the listed 
numbers and follow the instructions that you hear on the 
phone. Select Attendees receive call back if your site 
includes an integrated call-back teleconference, in which 
participants provide their phone numbers and receive a call 
back.

Note This option is only available for Cisco Unified 
MeetingPlace users.

Use this option... To...
92



Chapter 6: Setting Up a One-Click Meeting
Installing the WebEx One-Click Desktop Version
If your site administrator has enabled you to download the WebEx One-Click 
desktop version, you can start a One-Click Meeting using the WebEx One-Click 
panel or a One-Click shortcut.

WebEx teleconferencing Specifies that the meeting includes an integrated 
teleconference. If you select this option, select one of the 
following options:

■ Display toll-free number: Select if your site provides 
toll-free call-in teleconferencing, in which both a toll-free 
number and a toll number are available. If your 
participants dial a toll-free call-in number, your 
organization assumes the charges for the calls. 
Otherwise, participants assume the charges for their calls.

■ Attendees receive call back: Select if your site includes 
an integrated call-back teleconference, in which 
participants provide their phone numbers and receive a 
call back.

■ Integrated VoIP: Meeting participants will use computers 
with audio capability to communicate over the Internet 
rather than the telephone system.

Note
■ After you start the meeting, you must start an Integrated 

VoIP conference so that other participants can join the 
VoIP conference.

■ Only participants whose computers meet the system 
requirements for Integrated VoIP can participate in the 
conference. 

Teleconferencing Service Available only if your site has the Personal Conference 
Number (PCN) option.

Select the PCN account that you want to use for your 
meeting. 

For more information about PCN, see the My WebEx section 
in the documentation for your service

Other teleconference 
service

Specifies that the meeting includes a teleconference that 
another service provides, such as a third-party 
teleconferencing service or internal teleconferencing system, 
such as a PBX (private branch exchange).

In the text box, type instructions for joining the 
teleconference.

None Specify that the meeting does not include either 
teleconference or Integrated VoIP.

Use this option... To...
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Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

Before installing WebEx One-Click, ensure that your computer meets the following 
minimum system requirements:

■ Windows 2000 or XP 

■ Intel x86 (Pentium 400MHZ +) or compatible processor 

■ Microsoft Internet Explorer 6, Mozilla 1.6, Netscape 7.x, or Firefox 1.0

■ JavaScript and cookies enabled in the browser

To install WebEx One-Click:

1 Log in to your Meeting Center Web site. 

2 Click My WebEx > One-Click Setup (on the left navigation bar).

The One-Click Setup page appears.

3 Click Download.

The File Download dialog box appears.

4 Save the installation program to your computer. 

The name of the installation file has a .msi extension.

5 Run the installation file and follow the instructions.

Once you complete installation, log in using your WebEx account information 
and then verify your One-Click settings.

The WebEx One-Click panel appears. For instructions about using the 
One-Click panel and shortcuts, see the WebEx One-Click User’s Guide.

The Help in the WebEx One-Click panel also provides detailed information 
about how to use the One-Click panel and shortcuts.
94



Chapter 6: Setting Up a One-Click Meeting
Tip For instructions on using the WebEx One-Click panel, refer to the WebEx 
One-Click User’s Guide, which is available on the Support page of your Meeting 
Center web site.

Starting a One-Click Meeting
Before you start a One-Click Meeting from your Meeting Center Web site, ensure 
that you set up One-Click settings. For details about setting up One-Click settings, 
see Setting up your One-Click Meeting on the Web on page 90. 

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

To start a One-Click Meeting from your WebEx service Web site:

1 Log in to your Meeting Center Web site.

2 Click My WebEx > Start One-Click Meeting.

Your meeting starts.

If your site includes Meeting Center, you can also start a One-Click Meeting from 
this specific service.

To learn about using the desktop 
version of WebEx One-Click, 
right-click the WebEx One-Click icon 
on the taskbar of your desktop, and 
then choose Help.
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To start a One-Click Meeting from the Meeting Center service:

1 Log in to your WebEx service Web site, and click Meeting Center.

2 On the left navigation bar, click Host a Meeting > One-Click Meeting.

Your meeting starts.

To start a One-Click Meeting using the WebEx One-Click panel:

1 Open your WebEx One-Click panel by doing any of the following:

■ Double-click the WebEx One-Click shortcut on your desktop.

■ Go to Start > Programs > WebEx > WebEx One-Click > WebEx One-Click.

■ Right-click the WebEx One-Click icon on the taskbar of your desktop.

If you did not specify automatic login, enter the required WebEx account 
information in the dialog box, and then click Log In.

2 On the WebEx One-Click panel, click Start Meeting.
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Tip For instructions on using the WebEx One-Click panel, refer to the WebEx 
One-Click User’s Guide.

To start a One-Click Meeting using a One-Click shortcut:

Click one of the following shortcuts:

Shortcut Description

Web browser shortcut: Click this icon to start 
your meeting.

Note If you previously customized your 
Internet Explorer toolbar, the shortcut button 
does not automatically appear on the toolbar. 
Instead, it is added to the list of available toolbar 
buttons in Internet Explorer. In this case, you 
must add the button to the toolbar, using the 
Internet Explorer Customize option. To access 
this option, on the View menu, point to 
Toolbars, and then choose Customize.

Microsoft Office shortcut: On the WebEx 
menu in any Microsoft Office application, 
choose a sharing option:

■ Share as Document: Starts the meeting 
and automatically shares the document. 
This option lets you share the document as a 
presentation in the content viewer.

■ Share as Application: Starts the meeting 
and automatically shares the application you 
are using. This option lets you work in the 
application during the meeting.
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■ Once you start a One-Click Meeting, it appears on your Personal Meeting Room 
page, unless you specified it to be an unlisted meeting. If you provide others with 
the URL for this page, they can quickly join your meeting by clicking the link for 
the meeting on this page.

■ You can uninstall any of the shortcuts at any time from the WebEx One-Click 
panel. 

■ For instructions on using the WebEx One-Click shortcuts, refer to the WebEx 
One-Click User’s Guide.

Removing WebEx One-Click
You can uninstall WebEx One-Click at any time. Uninstalling One-Click removes 
the WebEx One-Click panel and One-Click shortcuts from your computer.

Note If you are using the new WebEx Productivity Tools, there are updates for this feature. For 
more information, refer to the WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

To uninstall WebEx One-Click:

1 Click Start > Programs > WebEx > WebEx One-Click > Uninstall One-Click.

2 Click Yes to confirm that you want to uninstall WebEx One-Click.

Right-Click menu shortcut: Right-click the 
icon for an application or document file on your 
computer, and then point to Share in WebEx 
Meeting.

Choose a sharing option:

■ As Document: Starts the meeting and 
automatically shares the document in the 
meeting content viewer. This option lets you 
share the document as a presentation in the 
content viewer.

If you right-clicked an application icon, this 
option is not available.

■ As Application: Starts the meeting and 
automatically shares the application. This 
option lets you work in the application during 
the meeting.

Shortcut Description
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7
Understanding the Meeting 
Window

The Meeting window displays the content viewer on the left side, where the 
Presenter shares documents, applications, and other items. The right side of the 
window contains panels, which you can display or hide as you need them. For 
example, you may want to send a quick chat message to another participant. You 
can minimize or close the Chat panel after your exchange to reduce the clutter or 
provide more space for another panel. Panels are just a click away, so you can open 
a panel quickly. If you’ve closed or minimized a panel and it needs your attention, 
you receive an alert.

This chapter gives you a quick overview of the Meeting window the elements that 
compose it.

A quick tour of the Meeting window
The Meeting window provides the online environment where meeting participants 
interact.

You share or view documents, presentations, desktops, and Web content using the 
tools in the Meeting window. You can also chat, take notes, and perform other 
meeting management tasks.

If you want to... See...

get an overview of the Meeting window, 
including menus and tools

A quick tour of the Meeting window on 
page 99

understand panels Working with panels on page 104

manage or access panels during full-screen 
activity

Accessing panels in full-screen view on 
page 110

find out when something changes in a panel 
that you have closed or minimized

Viewing Panel alerts on page 116
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These features help control the meeting:

■ Sharing icons in the upper left corner provide easy access to presentations, 
documents, applications, desktops, or whiteboards that are shared.

■ Documents and whiteboards that are open appear as tabs at the top of the 
Meeting window

■ Panels appear on the right side of the Meeting window. You manipulate panels 
using a mouse; click to open, close, and minimize them

■ The content viewer displays one or more documents, presentations, 
applications, and whiteboards that are shared during the meeting. Document 
tabs at the top of the viewer allow you to switch among multiple shared 
documents, presentations, and whiteboards.

■ Viewing icons in the bottom left corner help you to view content in standard, 
thumbnail, full screen, or rotated view in the content viewer. You can zoom in 
or out of a view or synchronize your display.
100



Chapter 7: Understanding the Meeting Window
Using menus and tools
You can perform most tasks in the content viewer using menus and tool bars.

Use these tools to share 
applications, 
documents, your 
desktop or a white 
board.

Select an annotation tool for directing 
attention to something onscreen using 
pointers, a highlighter, or drawing a 
shape. 

Change to full-screen, rotate pages, zoom in or 
out of information in the content viewer.

Use the menu bar 
commands to manage 
all the elements of your 
meeting. 

Use panels to chat with participants, view live 
video, or take notes. Click the Panels button to 
perform actions on panels, such as opening or 
closing panels.

If you want to... See...

learn how to manage your meeting with 
menus

Understanding the menu bar on page 102

understand how to use meeting tools for 
sharing information

Sharing information on page 102

change the view in the content viewer Changing views on page 103

learn how to annotate information in the 
content viewer

Using annotation tools on page 104
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Understanding the menu bar

A menu bar appears at the top of the Meeting window:

Sharing information

You can open a document, whiteboard, desktop, or application to share by clicking 
the sharing icons in the upper left corner:

Menu Description

File Provides commands for saving, opening, transferring, or printing 
files during a meeting; and ending or leaving a meeting.

Edit Provides commands for editing shared content in the content 
viewer.

Share Provides commands for sharing documents, presentations, and 
whiteboards. In addition, hosts or presenter can share applications, 
Web browsers, desktops, remote computers, multimedia Web 
pages, and whiteboards.

View Provides commands for displaying information in the content viewer 
on your screen. In addition, hosts or presenters can display 
information in the content viewer of attendees’ screens.

Communicate Provides commands for a host to set up a teleconference and a 
participant to join a teleconference, and other audio features.

Participant ■ Host: Provides commands pertaining to participants, such as 
inviting a participants to a meeting, assigning roles and 
privileges, providing remote control, controlling participants’ 
audio, and so on.

■ Participant: Provides commands, such as finding a participant.

Meeting Provides commands pertaining to the meeting, such as viewing 
meeting information. In addition, hosts or presenters can restrict 
access to the meeting.

Help Provides information about the product

Share 
document

Share 
whiteboard

Share
desktop

Share 
application
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Changing views

You can switch views in the content viewer by clicking the viewing icons in the 
bottom left corner:

Tool Description

Share Document Share a document or presentation that resides on your computer. 
Participants view the shared document or presentation in their content 
viewers.

Share 
Application

Share any application on your computer with meeting attendees. 
Attendees can view the shared application in a sharing window on 
attendees' screens.

Share Desktop Share your computer desktop with meeting attendees, including any 
applications, windows, and file directories that are currently open. 
Attendees can view the shared desktop in a sharing window on 
attendees' screens

Share 
Whiteboard

Share a whiteboard on which you can draw and write. Attendees can 
view a shared whiteboard in their content viewers.

Tool Description

Standard View/
View Thumbnails

Displays the shared content as you would normally view it. 

Displays thumbnails, or miniatures, of shared pages, slides, or whiteboards 
to the side of the content,. This tool helps you locate a page or slide quickly.

Click Standard View to return to normal viewing of the shared content.

Full-Screen View Displays shared content in a full-screen view. Helps you to ensure that 
participants can view all activity on your screen. Also helps to prevent 
participants from viewing or using other applications on their screens during 
a presentation.

Click ESC to return to the content viewer.

Rotate Page Left
Rotate Page Right

Lets you rotates the content of the viewer to the left or right.

Zoom In/
Zoom Out

Lets you display shared content at various magnifications. Click this button, 
and then click the page, slide, or whiteboard to change its magnification. For 
more magnification options, click the downward-pointing arrow.

Sync Display with 
Presenter

Synchronize your onscreen display with the presenter’s display. This 
command is useful if your attention has been drawn elsewhere for a time and 
you need to catch up with the meeting’s presenter.

Synchronize 
Displays for All

For presenters, synchronizes all participants' displays with your display. 
Helps to ensure that all participants are viewing the same page or slide, at 
the same magnification, as in your display.

Standard View Full-Screen View Zoom In/ZoomOut

Synchronize Displays for AllView Thumbnails Rotate page (left or right)
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Using annotation tools

Working with panels
The panels on the right side of the sharing window are very flexible. You can 
expand, close, or minimize them quickly and easily. You can also reduce the panels 
to icons, providing greater space for sharing documents, applications, and other 
items with meeting participants.

Your service selects which panels display initially. 

Tool Description

Pointer Lets you point out text and graphics on shared content. The pointer displays 
an arrow with your name and annotation color. To display the laser pointer, 
which lets you point out text and graphics on shared content using a red “laser 
beam,” click the downward-pointing arrow. Clicking this button again turns off 
the pointer tool.

Text Lets you type text on shared content. Attendees can view the text once you 
finish typing it and click your mouse in the content viewer, outside the text box.

To change the font, on the Edit menu, choose Font. Clicking this button 
again turns off the text tool.

Line Lets you draw lines and arrows on shared content. For more options, click 
the downward-pointing arrow. Clicking this button closes the Rectangle 
tool.

Rectangle Lets you draw shapes, such as rectangles and ellipses on shared content. 
For more options, click the downward-pointing arrow. Clicking this button 
again closes the Rectangle tool.

Highlighter Lets you highlight text and other elements in shared content. For more 
options, click the downward-pointing arrow. Clicking this button again 
closes the Highlighter tool

Annotation 
Color

Displays the Annotation Color palette, on which you can select a color to 
annotate shared content. Clicking this button again closes the Annotation 
Color palette.

Eraser Erases text and annotations or clears pointers on shared content. To erase a 
single annotation, click it in the viewer. For more options, click the 
downward-pointing arrow. Clicking this button again turns off the eraser tool.

Text tool Rectangle tool

Eraser tool

Annotation Color tool

Line toolPointer tool Highlighter tool
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Minimizing and restoring panels

Minimizing or restoring panels has no effect on attendees’ displays.

To minimize a panel:

Click the Minimize icon on the title bar of the panel you want to minimize. 

The panel no longer displays. It appears as an icon on the icon tray at the top of the 
panels.

To display the Select Panel menu, click 
Panels.

You can minimize all the panels at once 
using the Minimize All command.

In this example, the Polling panel is 
minimized. Click Polling in the icon tray to 
restore it

The Video panel is collapsed. 

Use the icon on the left side of the panel title 
bar to collapse or expand a panel.

Click the Minimize icon to minimize 
this panel.

Minimized panels 
display as icons.
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To restore a minimized panel:

Click its icon on the icon tray.

To minimize all panels:

1 On the icon tray, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, choose Minimize All.

The open panels shrink to icons on the icon tray.

To restore all minimized panels:

The Restore All command quickly restores all panels you have minimized using the 
Minimize All command.

1 In the icon tray, click Panels.

The Select Panel menu displays.

2 On the Select Panels menu, choose Restore Panels.

Minimized panels now display. 

Expanding and collapsing panels

Expanding and collapsing panels has no effect on the attendees’ displays.

To collapse a panel:

Click the icon in the upper left corner of a panel to collapse it.

The panel collapses, leaving just the title bar visible.

Click to restore
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To expand a panel:

If a panel is collapsed (you only can see its title bar), click the icon in the left corner 
of the title bar to expand it.

Opening and closing panels

You can hide a panel completely so it will not display as an icon on the icon tray. 

Important If the meeting host closes a panel, that panel also closes for attendees. It 
remains closed for all attendees until the host opens the panel again.

To close a panel:

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

Use the icon on the left side of the panel title bar to 
collapse or expand a panel.

The Video panel is 
collapsed.

Panels without check marks are 
currently closed.

Panels with check marks currently 
display.
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2 On the Select Panel menu, click to remove the check mark next to the panel you 
want to close.

The panel no longer displays and it is not available as an icon on the icon bar.

If you close the last remaining panel, the large panel area on the right side of the 
screen disappears. You still have access to the panels through the Select Panel 
menu, available by clicking the Panels button.

To open a panel:

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, click to place a check mark next to any panel you 
want to open.

The panel or panels you selected display. This panel is now available for all 
attendees.

Resetting the panels

You can return the panels to the display settings that were preset by your service.

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, choose Reset to Default.

The panels return to the display settings originally selected by your service. The 
size, order, and location of the panels are reset to their original settings.

Accessing panel options 

You can easily access the options related to any panel. Simply right-click in the 
panel title bar to see a menu of commands related to the panel. In addition, you can 
manipulate the panels, such as collapsing, minimizing, and closing them using the 
commands on the panel options menus.

Panel Options

Participants Sound Alerts: Lets you choose a sound to play when a participant:

■ Joins a meeting

■ Leaves a meeting

■ Selects the Raise Hand button on the Participants panel.

Attendee Privileges: Displays the Participant Privileges dialog box. For 
details about these privileges, see About granting privileges to attendees 
on page 133.
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Resizing the content viewer and panels area

You can control the size of the content viewer by making the panel area narrower 
or wider.

Chat Sound Alerts: Lets you choose the kinds of chat messages for which you 
want a sound to play. Select a sound from the drop-down list or click 
Browse to find a sound in a different location on your computer.

Attendee Privileges: Displays the Participant Privileges dialog box. For 
details about these privileges, see 

Video Single-point video: Lets only the presenter and one participant send live 
video during the meeting.

Multipoint video: Lets the presenter and up to five other participants 
send live video during the meeting. This option uses more resources on 
your computer and bandwidth for your Internet connection, which may 
affect the performance of Meeting Manager.

Video Options: Displays the Meeting Options dialog box, where you can 
set video options as well as other options you want to make available 
during the meeting.

■ Video frame rate: Using the slider, adjust the number of video frames 
per second that your camera sends. Or type a number in the box. You 
can specify a rate of 0 to 30 frames per second. A higher frame rate 
produces faster video, but uses more resources on your computer and 
bandwidth for your Internet connection

■ Video resolution: Select the resolution of the video image that your 
camera sends. A higher resolution produces clearer video images, but 
uses more resources on your computer and bandwidth for your Internet 
connection.

■ Capture device: If more than one video camera is attached to your 
computer, select which camera you want to use in the drop-down list. 

Allow others to remotely control my cam—Available only if your 
video camera has remote control capability. Specifies that the 
presenter can remotely control your video camera that is, move the 
camera left, right, up, or down.

■ Advanced Properties: Displays additional options specific to your 
webcam. For details, consult the documentation that accompanied 
your webcam

Notes Notes: Displays the Meeting Options dialog box, where you can set 
note-taking options as well as other options

■ Allow participants to take notes: Lets all participants take their own 
notes during the meeting, and save them to their computers.

■ Single note taker: Lets only one participant take notes during the 
meeting. By default, the host is the note-taker, but can designate 
another participant as the note-taker during the meeting. A note-taker 
can publish notes in all participants’ Meeting windows at any time 
during the meeting. The host can send a transcript of the notes to 
participants at any time.

■ Closed captions: Lets only one participant—the closed captionist—
take notes during the meeting. 

Panel Options
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To change the size of the content viewer and panels:

Click the dividing line between the content viewer and the panels. 

■ Drag the line to the left to make the area devoted to the panels wider. 

■ Drag the line to the right to make the content viewer larger.

For details about hiding, minimizing, and closing the panels, see Accessing panels in 
full-screen view.

Accessing panels in full-screen view
While you are viewing a document or remotely controlling a shared application, 
desktop, or Web browser, or viewing a shared remote computer, a presenter can 
switch between a standard window and full-screen view. In full-screen view, you 
access the panels on a floating icon tray located in the lower right corner of your 
screen.

Tip Use the Move Handle to move the floating icon tray to another spot on the 
desktop.

Drag this line to the right or left to change the size of the conten
and panels area

Return to Main Window

Move Handle Video Panel Recorder Panel

Select PanelChat Panel Polling Panel

Participants Panel

Notes Panel

Tools Panel
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To display a panel in full-screen view:

Click its icon on the floating icon tray. For example, to display the Chat panel, click 
the Chat icon. 

The panel “floats” on top of the shared document, presentation, web browser or 
other shared item. You can drag the panel to move it.

To open all panels in full-screen view:

You can have all panels float on top of the shared document, presentation, web 
browser, or other shared item.

1 On the floating icon tray, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Float All Panels.

All panels display, even those you had minimized previously.

What you can do

Resize individual panels using the Resize Control in the bottom right corner of any 
floating panel.

To organize the floating panels:

As you reopen the panels to jot a few notes or chat with a participant, you may find 
you need to arrange the panels.

1 On the floating icon tray, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Open Right Panel.

An empty panel appears on the right side of the screen.

The icon tray now resides at the top of the right panel.

What you can do

■ Drag any floating panels into this larger panel. Panels resize to fill the space.

Drag the Resize Control to change 
the size of the panel.
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■ Drag the panel out of the larger panel to “float” it.

■ Switch between full-screen view and standard view. 

After you return to standard view, all panels (those that are floating and those 
that you have minimized) return to their preset locations in the right panel.

Sharing in full-screen view

Host and Presenter only

In full-screen view, you have access to sharing and viewing options from the Select 
Panel menu.

If you are sharing a document

If you have already opened several documents, you can switch to share any of these 
documents.

To display a different document:

1 On the floating icon tray, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Select Document.

You see a list of documents that are currently open in this meeting.

3 Select the document you want to share.

Drag individual panels into the 
panel on the far right of the screen.

The panels align and resize inside 
the larger panel.
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To select a sharing option:

1 In the floating icon tray, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Share.

You see the list of sharing commands. 

3 Choose the kind of sharing you want to do. 

To resize the display of attendees to match your display:

1 On the icon tray above the panels, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose View > Synchronize Views.

All attendees’ displays now match your display. 
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If you are sharing an application

To display a different application:

1 On the floating icon tray, click the Select Panel button.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Select Application.

The Share Application dialog displays.

3 Select the application you want to share. Or click New Application to open an 
application not already running on your desktop.

To select another sharing option:

1 On the floating icon tray, click the Select Panel button.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Share.

You see the list of sharing commands.
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3 Choose the kind of sharing you want to do. 

To resize the display of attendees to match your display:

1 On the floating icon tray, click the Select Panel button.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose View > Synchronize Views.

All attendees’ displays now match your display.

If you are sharing a desktop

To select another sharing option:

1 On the floating icon tray, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose Share.

Synchronize Views command
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You see the list of sharing commands. 

3 Choose the kind of sharing you want to do. 

To resize the display of attendees to match your display:

1 On the floating icon tray, click Panels.

It is the last button on the floating icon tray.

2 On the Select Panel menu, choose View > Synchronize Views.

All attendees’ displays now match your display. 

Viewing Panel alerts
If you have closed, minimized, or collapsed any panels, you will see an alert if a 
panel you no longer can see requires your attention.

Some reasons for seeing alerts:

■ A participant arrives or leaves a meeting

■ A Raise Hand indicator appears in the Participants list

■ The note taker publishes notes

■ An attendee sends a chat message

■ A poll opens or closes

■ Poll answers are received

Alerts for closed panels

If you have closed a panel, the Panels button changes color to alert you to a change. 
For example, if a participant leaves your meeting, and you have closed the 
Participants panel, the Select Panel menu button turns into an alert.

Panels button changes color 
to alert you.

In this example, a participant 
has left the meeting. The 
Participants panel is closed, so 
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Alerts for minimized panels

If you have minimized a panel, the icon representing that panel alerts you of a 
change.

Alerts for collapsed panels

If you have collapsed a panel, the Expand/Collapse icon changes color when you 
need to pay attention to that panel.

The Chat icon changes color to let you know you have a 
new chat message.

The icon changes color to let you know you should 
check the contents of this panel.
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8
Managing Meetings

About managing meetings
You can run a seamless and smooth meeting, using the features available in Meeting 
Center. For instance, you can:

■ Invite others, including coworkers, prospective clients, subject matter experts, 
or managers to join a meeting that has already started

■ Ask another participant to host the meeting, if you need to leave unexpectedly; 
you can rejoin later and reclaim the host role

■ Ask another participant to present materials, such as a presentation, file, 
spreadsheet or other document.

■ Control access to the meeting

■ Distribute meeting notes

■ Send a meeting transcript

If you want to... See...

invite others to a meeting that is already in 
progress

Inviting attendees to a meeting in progress on 
page 120

choose a participant to present documents or 
other information to meeting attendees

Designating a presenter on page 123

appoint another participant as meeting host Transferring the host role to another attendee 
on page 124

stop attendees from joining a meeting in 
progress

Editing a message or greeting during a 
meeting on page 126

distribute details about a meeting Sending a meeting transcript to participants 
on page 128

stop the meeting Ending a meeting on page 129
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Inviting attendees to a meeting in progress
After you start a meeting, you can invite additional attendees to the meeting. You 
can use either of these methods:

■ Instant message, using WebEx AIM Pro

■ Email message, using your email client

Inviting attendees by instant message to a meeting in progress 

If you have WebEx AIM Pro installed, you can invite attendees by IM to a meeting 
in progress.

Note Start WebEx AIM Pro if it is not currently running. 

To invite attendees to a meeting in progress:

1 In the Meeting window, on the Participant menu, choose Invite > By IM.

The Invite More dialog box appears.

2 Type a attendees’s screen name or domain name the text box. and click the Plus 
button.

To quickly find the screen names, click the Address Book button to open your 
address book.

Enter the screen name or domain 
name here.

Click the Plus key to add the 
name to the list of attendees 
below.

Click the Address Book button to see your 
address book.
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3 In the Method drop-down list, select IM.

If the attendee is not currently available, you can send an email invitation 
instead. Simple select Email in the drop-down list.

4 Click Invite.

Each attendee receives an IM message, which includes:

■ A link that the attendee can click to join the meeting

■ Meeting topic

■ Meeting start time

Tip If you invite attendees by IM, and your meeting requires a password, remember 
to provide the password to attendees.

To send the meeting link using other IM services:

If you do not have WebEx AIM Pro installed and use a different IM service, you can 
copy the link and send it to attendees. 

1 In the meeting window, select the Quick Start tab.

2 On the Quick Start tab, select the Invite Participants tab.

3 Click Copy Link to copy the meeting URL. 

4 Paste the URL in an IM message and send the message.

Quick Start tab

Copy Link button
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Inviting attendees by email to a meeting in progress 

Each person that you invite receives an invitation email message, which provides 
information about the meeting—including the password, if any—and a link that 
the invitee can click to join the meeting.

You have two options for sending an email invitation:

■ Have WebEx send the message to the participants. 

Your name does not appear as the sender of the message in message “From” box. 
For details, see To invite attendees to a meeting in progress using WebEx: on 
page 122.

■ You send the message to participants using your own email program (MS 
Outlook or Lotus Notes only). 

Your name appears in the “From” text box. For details, see To invite attendees to a 
meeting in progress using your local email program: on page 123.

To invite attendees to a meeting in progress using WebEx:

1 In the Meeting window, on the Participant menu, choose Invite > By 
Email>Use WebEx.

The Invite by Email dialog box appears.

2 Type each attendee's email address in the text box.

Separate the email addresses with commas. Do not include spaces between the 
addresses.

3 Click Invite.

Each attendee receives an invitation email message, which includes:

■ A link that the attendee can click to join the meeting

■ The meeting password, if you specified one

■ Teleconferencing information, if your meeting includes an integrated 
teleconference
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■ The meeting number, which the attendee must provide if your meeting is 
unlisted and he or she joins the meeting from your meeting service Web site, 
instead of clicking the link in the email message

Tip If you invite attendees by another means, such as by phone, and your meeting 
requires a password, remember to provide the password to attendees.

To invite attendees to a meeting in progress using your local email program:

1 In the Meeting window, on the Participant menu, choose Invite >Use Your 
Local Email Program.

You see a new email message with information about your meeting.

■ A link that the attendee can click to join the meeting

■ The meeting password, if you specified one

■ Teleconferencing information, if your meeting includes an integrated 
teleconference

■ The meeting number, which the attendee must provide if your meeting is 
unlisted and he or she joins the meeting from your meeting service Web site, 
instead of clicking the link in the email message.

2 In the To: box, type the email address of each person you want to invite.

3 Click Send.

Tip If you invite attendees by another means, such as by phone, and your meeting 
requires a password, remember to provide the password to attendees.

Designating a presenter

As the meeting host, you are initially the presenter as well. However, during a 
meeting, you can designate any meeting attendee as the presenter. You can also 
reclaim the presenter role or change the presenter at any time.

Caution Changing the presenter discontinues any application or Web browser 
sharing session currently in progress. However, any documents, presentations, or 
whiteboards that the current presenter is sharing remain in the content viewer. 
Also, any poll that the current presenter opened remains on the Polling tab.

To designate a presenter:

1 In the Meeting window, in the participant list on the Participants tab, select the 
name of the attendee whom you want to designate as the presenter.
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2 Do either of the following:

■ On the Participants panel, click Make Presenter.

■ On the Participant menu, choose Change Role To> Presenter.

The green presenter indicator appears to the left of the attendee's name.

To reclaim the presenter role:

On the Participants panel, select your name, and then click Make Presenter.

Transferring the host role to another attendee

As a meeting host, you can transfer the host role—and thus control of the 
meeting—to an attendee at any time. This option can be useful if you need to leave 
a meeting for any reason. You can reclaim the host role at any time.

To transfer the host role to an attendee:

1 Optional. If you plan to reclaim the host role later, write down the host key that 
appears on the Info tab in the content viewer in the Meeting window.

2 Display the Participants panel.

3 In the participant list, select the name of the attendee to whom you want to 
transfer the host role.

4 On the Participant menu, choose Change Role To> Host.

A confirmation message appears, in which you can verify that you want to 
transfer control of the meeting to the attendee whom you selected.

5 Click OK.

The word (host) appears to the right of the attendee's name in the participant 
list.

Reclaiming the host role

To take over the role of meeting host:

If an attendee has control of a meeting, you can assume control of the meeting by 
reclaiming the host role. 

Important If you leave a meeting—whether intentionally or inadvertently—then 
log back in to your meeting service Web site, you automatically become the meeting 
host once you rejoin the meeting. You can rejoin a meeting using either the public 
meeting calendar or your private meeting calendar.
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To reclaim the host role:

1 In the Meeting window, open the Participants panel.

For details about using the panels, see Working with panels on page 104.

2 In the participant list, select your own name.

3 On the Participant menu, choose Reclaim Host Role.

The Reclaim Host Role dialog box appears.

4 Type the host key in the Host key box.

5 Click OK.

In the participant list, the word (host) appears to the right of your name. 

Tip If you did not write down the host key before transferring the host role to 
another attendee, you can ask the current host to send you the host key in a private 
chat message. The host key appears on the current host's Info tab in the content 
viewer.

Obtaining information about a meeting after it starts

During a meeting, you can obtain general information about the meeting, including 
the:

■ Meeting name or topic 

■ Location, or URL, of the Web site where the meeting is taking place

■ Meeting number

■ Teleconferencing information

■ Current host

■ Current presenter

■ Current user—that is, your name

■ Current number of participants

To obtain information about a meeting in progress:

In the Meeting window, on the Meeting menu, choose Information.
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The Meeting Information dialog box appears listing general information about the 
meeting.

Editing a message or greeting during a meeting

When scheduling a meeting, you can create a message or greeting for attendees, and 
optionally specify that the message or greeting automatically appears in attendees' 
session windows once they join the meeting. During a meeting, you can edit the 
message or greeting that you created, or edit the default greeting.

In your message or greeting, you can welcome the attendee to the meeting, provide 
important information about the meeting, or provide special instructions.

To edit a message or greeting during a meeting:

1 In the meeting window, on the Meeting menu, choose Welcome Message.

The Create an Attendee Greeting page appears.

2 Optional. Select the Display this message when attendees join the meeting 
check box.

The message or greeting automatically appears once the attendee joins the 
meeting.

3 Type a message or greeting in the Message box.

A message or greeting can contain a maximum of 255 characters.

4 Click OK.

Note Attendees can view the message or greeting at any time by choosing Welcome 
Message on the Meeting menu.
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Restricting access to a meeting

Once a host starts a meeting, the host can restrict access to it at any time. This 
option prevents anyone from joining the meeting, including attendees who have 
been invited to the meeting but have not yet joined it.

To restrict access to a meeting:

1 In the Meeting window, on the Meeting menu, choose Restrict Access.

Attendees can no longer join the meeting.

2 Optional. To restore access to the meeting, on the Meeting menu, choose 
Restore Access.

Removing an attendee from a meeting

The meeting host can remove an attendee from a meeting at any time.

To remove an attendee from a meeting:

1 In the Meeting window, open the Participants panel.

For details about using the panels, see Working with panels on page 104.

2 Select the name of the attendee whom you want to remove from the meeting.

3 On the Participant menu, choose Expel.

A confirmation message appears, in which you can verify that you want to 
remove the attendee from the meeting.

4 Click Yes.

The attendee is removed from the meeting.

Tip To prevent an expelled attendee from rejoining a meeting, you can restrict 
access to the meeting. For details, see Editing a message or greeting during a meeting 
on page 126.

Leaving a meeting

You can leave a meeting at any time. If you are participating in either a call-back 
teleconference or an Internet phone conference, Meeting Manager disconnects you 
from the conference automatically once you leave the meeting.

To leave a meeting:

1 In the Meeting window, on the File menu, choose Leave Meeting. 

A confirmation message appears, in which you can verify that you want to leave 
the meeting.

2 Click Yes.
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The Meeting window closes.

Note If you are the meeting host, first transfer the host role to another attendee 
before leaving the meeting. For more information, see Transferring the host role to 
another attendee on page 124.

Sending a meeting transcript to participants

You can send a transcript of a meeting to all participants at any time during the 
meeting. The transcript is an email message that contains the following general 
information:

■ Meeting topic

■ Meeting number

■ Meeting starting and ending times

■ URL for the Meeting Information page for the meeting on your meeting service 
Web site

■ List of all participants

■ Meeting agenda

■ Any public notes that you took during the meeting 

You can optionally attach any of the following files to the transcript, if you saved 
them during the meeting:

■ Shared documents

■ Poll questionnaire

■ Poll results

■ Chat

■ Public notes or closed captions that you took or that the note taker or closed 
captionist published during the meeting

To send a meeting transcript to participants:

1 In the Meeting window, on the File menu, choose Send Transcript.

If you have saved any files during the meeting, the Send Transcript dialog box 
appears, allowing you to attach the files to the transcript email message.

If you have not saved any files during the meeting, a transcript email message 
opens.

2 If the Send Transcript dialog box appears, select the check box for each file that 
you want to attach to the transcript, and then click OK.

The transcript email message opens.
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3 Review the email message and make any changes that you want.

4 Send the email message.

Note

The transcript is sent to all participants who provided their email addresses when 
joining the meeting, whether or not they are still attending the meeting when you 
send the transcript. 

For security purposes, a participant who receives a transcript email message cannot 
see the email addresses for the other participants. 

The transcript contains notes only if you are the meeting host, the public note taker, 
or the closed captionist, and you have saved the notes to a file. If all participants can 
take private notes, the transcript email message does not include your private notes, 
and the option to attach your notes in a file is not available.

If you saved notes or closed captions to a file, the transcript email message and the 
attached notes file contain the latest version of notes that you saved. 

If you are the meeting host and end the meeting—and you have not sent a 
transcript—a message appears, asking you if you want to send a transcript. 

Ending a meeting

Once you end a meeting, the Meeting window closes for all attendees. If the meeting 
includes an integrated voice teleconference, the conference also ends.

To end a meeting:

1 In the Meeting window, on the File menu, choose End Meeting.

A confirmation message appears, in which you can verify that you want to end 
the meeting.

2 Click Yes.

The Meeting window closes.

Note If there is any meeting information that you have not yet saved—including 
shared documents, chat messages, a poll questionnaire, poll results, or notes—
Meeting Manager asks you whether you want to save it before ending the meeting. 
If you choose to a save file, Meeting Manager uses the default file name for the file. 
Thus, if you have already saved the file using another name, Meeting Manager does 
not overwrite that file.
129



Chapter 8: Managing Meetings
Tip Alternatively, as the meeting host, you can leave a meeting without ending it. 
Before you leave a meeting, you should first transfer the host role to another 
attendee. For more information, see the following topics: Transferring the host role 
to another attendee on page 124 and Leaving a meeting on page 127.
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Assigning Sounds to Participant 
Actions

About assigning sounds to participant actions
Host only

During a meeting, you can specify sound alerts to play when participants take 
specific actions, such as joining or leaving the meeting.

Meeting Manager saves your sound preferences on your computer. However, if you 
start or join a meeting on another computer, you must specify your preferences 
again.

Assigning sounds to participant actions
Host only

During a meeting, you can assign sounds to play when a participant:

■ joins the meeting

■ leaves the meeting

■ clicks Raise Hand on the Participants panel

If you want to ... See ...

get an overview of specifying sound 
preferences for Meeting Manager

About assigning sounds to participant actions 
on page 131

assign sounds to specific actions that 
participants take during a meeting

Assigning sounds to participant actions on 
page 131
131



Chapter 9: Assigning Sounds to Participant Actions
To assign sounds to participant actions:

1 In the Meeting window, on the Edit menu, choose Preferences.

The Preferences dialog box appears.

2 Click the Participants tab.

3 Under When a participant, select the check box for each action for which you 
want to play a sound.

4 Do one of the following:

■ In the drop-down list for each selected action, choose a sound to play.

By default, the drop-down list contains the names of all sound files that 
reside at the default location on your computer.

■ Click Browse, and then select a sound file that resides in another folder.

5 Optional. To play the currently selected sound, click the following button.

6 Click Apply > OK.

Note

■ The Media folder is the default location on your computer for sound files.

■ You can copy other sound files to the Media folder, or any other directory, to 
make them available in the Preferences dialog box.

■ Sound files must have a .wav extension.
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Assigning Privileges during a 
Meeting

About granting privileges to attendees
Once a meeting starts, all meeting attendees automatically receive privileges:

■ If the host scheduled the meeting and specified attendee privileges, attendees 
receive those privileges. 

■ If the host scheduled the meeting but did not specify attendee privileges, 
attendees receive the default privileges.

■ If the host started an instant meeting, attendees receive the default privileges.

You can grant or remove privileges for the following meeting activities:

■ Document sharing, including privileges for saving, printing, and annotating 
shared content in the content viewer

■ Viewing miniatures, or thumbnails, of pages, slides, or whiteboards in the 
content viewer 

■ Zooming in and out on pages, slides, and whiteboards in the presentation viewer

■ Viewing any page, slide, or whiteboard in the content viewer, regardless of the 
content that the presenter is viewing

■ Controlling full-screen view of pages, slides, or whiteboards in the content 

If you want to... See...

get an overview of privileges About granting privileges to attendees on 
page 133

specify particular privileges for meeting 
attendees

Granting attendee privileges during a meeting 
on page 134
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viewer

■ Viewing the participant list

■ Chatting with participants

■ Recording a meeting

■ Requesting remote control of shared applications, desktops, or Web browsers

■ Contacting the operator for a teleconference privately, if your meeting service 
includes the private operator option

Granting attendee privileges during a meeting
During a meeting, you can grant privileges to or remove them from all attendees at 
once or an individual attendee.

To specify attendee privileges during a meeting:

1 In the Meeting window, on the Participant menu, choose Assign Privileges.

The Attendee Privileges dialog box appears.

2 Do one of the following:

■ To grant privileges to or remove them from all attendees at once, in the pane 
on the left, select All Attendees.

■ To grant privileges to or remove them from an individual attendee, in the 
pane on the left, expand All Attendees, and then select the attendee's name.

3 Specify attendee privileges, as follows:

■ To grant a privilege to attendees, select its check box.

■ To grant all privileges to attendees, select the Assign all privileges check box.

■ To remove a privilege from attendees, clear its check box.

■ To reset to the preset meeting privileges, click Reset to Meeting Defaults.

4 Click Assign.
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Using Teleconferencing

An integrated teleconference can be either a call-in teleconference or call-back 
teleconference. 

Your user role in a teleconference determines your level of participation. Whichever 
role you take, the following table describes the basic tasks associated with that role. 
For detailed instructions on a particular task, click “More” by the task description.

Role Task description:

Host Start and manage a 
teleconference:

■ start the conference 
More...

■ invite participants 
More...

■ use caller 
identification to start 
or join 
teleconferences 
More...

■ mute or unmute one 
or more microphones 
More...

Participant Participate in a 
teleconference:

■ Join, rejoin, or leave 
a conference More...

■ Mute or unmute your 
microphone More...

■ Ask to speak More...
135



Chapter 11: Using Teleconferencing
Note If you set up another type of teleconference—such as that of a third-party 
teleconferencing service—you must manage the conference using the options that 
service provides.

Starting a teleconference during a meeting
If you did not select a teleconferencing option when you set up your meeting, you 
can start a call-in teleconference at any time during the meeting.

To start a call-in teleconference during a meeting:

On the Communicate menu, choose Join Teleconference.

The Join Teleconference dialog box appears. For example:

Using caller authentication to start or join a dial-in 
teleconference

Host only

CLI (caller line identification), or ANI (automatic number identification), is a form 
of caller ID, a telephony intelligent service that transmits a caller’s telephone 
number before the call is answered. Any dial-in caller with a host site account can 
be authenticated and placed into the correct teleconference without needing to 
enter a meeting number.

If you have a host account, and your site is enabled for ANI/CLI, you can 

■ schedule a meeting with dial-in ANI/CLI teleconferencing authentication. 

■ be authenticated whenever you dial into any ANI/CLI enabled teleconference to 
which you have been invited by email. Call-in authentication is established by 
mapping your email address to a phone number in your user profile.

■ specify a call-in authentication PIN to prevent “spoofers” from using your 

Follow the instructions to start a 
call-in teleconference.
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number to dial into a teleconference

To schedule a teleconference with ANI/CLI authentication:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a Meeting to view a list of links.

3 Click Schedule a Meeting. 

The Required Information page appears.

4 Click Change audio options.

The Audio Options dialog box appears.

5 Select the Enable teleconference CLI authentication when participants call in 
checkbox.

6 Select the Attendees call in radio button.

Note Caller authentication will only be available to participants if they are invited 
to a CLI/ANI enabled teleconference by email during the meeting scheduling 
process. Any participant invited to the teleconference once it has begun cannot use 
caller authentication.

Specifying call-in authentication for your host account

If you have a host account, and your site is enabled for ANI/CLI, you can set 
CLI/ANI authentication for any phone number listed in your user profile. Your call 
will be authenticated by mapping your email address against specified phone 
numbers in your profile whenever you dial into a ANI/CLI enabled teleconference 
to which you have been invited by email. 

Note Caller authentication will only be available if you have been invited to a 
CLI/ANI enabled teleconference by email during the meeting scheduling process. 
Caller authentication will not be available if you are dialing in to a CLI/ANI enabled 
teleconference:

■ from an invitation other than email. 

■ from an email invitation originated during the meeting.

To specify call-in authentication for your host account:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

3 Click My Profile.
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The My Profile page appears.

4 Under Personal Information, select the Call-in authentication checkbox beside 
any phone number for which you want dial-in authentication.

5 Click Update.

Using a call-in authentication PIN

If you have a host account, and your site is enabled for ANI/CLI teleconferences, 
you can use a call-in authentication PIN to prevent “spoofers” from using your 
number to dial into a teleconference. 

If your site administrator sets the authentication PIN as mandatory for all accounts 
using call-in authentication on your site, then you must specify a PIN number or 
caller authentication will be disabled for your account.

To specify a call-in authentication PIN:

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx.

3 Click My Profile.

The My Profile page appears.

4 Under Personal Information, in the Call-in authentication PIN: text box, enter 
a 4-digit PIN number of your choosing.

5 Click Update.

Inviting a participant to join a teleconference
Host only

If you have set up a call-back teleconference, you can invite people who are not 
participants in your online meeting to join the teleconference.

To invite a participant to a teleconference:

Do either of the following:

■ On the Participant menu, choose Invite > By Phone.

■ On the Participants panel, click the Invite drop-down list and choose Invite By 
Phone.

The Invite By Phone dialog box appears. 
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Joining or leaving a teleconference
Participant

Once you join a meeting, instructions for joining the teleconference automatically 
appear on your screen. The instructions differ, depending on whether the host set 
up a call-back teleconference or a call-in teleconference.

During a meeting, you can leave a teleconference without leaving the meeting. You 
can also rejoin the teleconference at any time.

To join a call-back teleconference:

In a call-back teleconference, provide your phone number, and the automated 
system will call you and add you to the teleconference.

Enter the required information, 
including name, country and area 
code, and click Call:

■ The teleconferencing service 
calls the participant. When the 
connection is made, the Status 
display changes from Ready to 
Connected. 

■ The Conference button becomes 
available on the Invite By Phone 
dialog box, allowing you to invite 
another participant.

Once you join a teleconference, the 
Teleconference indicator appears to the left of 
your name on the Participants panel.
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Tip

■ Select the Remember phone number on this computer checkbox if you want this 
number to be entered automatically each time you join a teleconference.

■ If you are unable to join a call-back conference, you can dial the backup call-in 
number instead. This number appears in your invitation email message, if you 
received one; on the Info tab in your Meeting window; or in the status bar at the 
bottom of your Meeting window.

To join a call-in teleconference:

In a call-in teleconference, dial the appropriate number to join the teleconference.

Note If the global call-in numbers option is available, a list of international phone 
numbers appears on the Join Teleconference dialog box. Dial the appropriate 
number for your location, and then click OK to close the dialog box. For a list of 
toll-free calling restrictions by country, see 
www.webex.com/pdf/tollfree_restrictions.pdf.

To display teleconference instructions during a meeting:

On the Communicate menu, choose Join Teleconference.

To rejoin a teleconference:

On the Communicate menu, choose Join Teleconference.

To leave a teleconference:

On the Communicate menu, choose Leave Teleconference.
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Muting and unmuting microphones in a 
teleconference

The following table illustrates how to quickly mute and unmute microphones in a 
teleconference depending on your user role. If you want detailed instructions, click 
“More” by the task description.

Muting participants’ microphones automatically when they join 
a meeting

Host only

In a teleconference, you can automatically mute all participants' microphones as 
they join the meeting. You can then allow specific participants to speak by 
unmuting their microphones.

To mute all participants' microphones when they join the meeting:

On the Participant menu, choose Mute on Entry.

Once a participant joins the meeting, the Muted indicator appears to the left of the 
participant’s name. For example:

Note Participants for whom you have muted microphones can request to speak at 
any time during a meeting, by clicking Raise Hand on their Participant panels. 

Role Fast track Task description:

Host You can:

■ mute all attendees’ 
microphones automatically 
when they join a meeting 
More...

■ mute or unmute a specific 
participant’s microphone 
More...

■ mute or unmute all attendees’ 
microphones simultaneously 
at any time during a meeting 
More...

Participant mute or unmute your own 
microphone at any time More...
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Muting and unmuting a specific participant’s microphone

Host only

In a teleconference, you can mute or unmute a specific participant’s microphone, 
including the microphone for:

■ An attendee

■ The presenter

To mute or unmute a specific participant’s microphone:

1 On the Participants panel, select one or more participants for whom you want 
to mute or unmute microphones.

To select multiple attendees, hold down the Ctrl key on your keyboard.

2 On the Participants panel, click Mute or Unmute to control each participant’s 
microphone.

Note Attendees for whom you have muted microphones can request to speak at 
any time during a meeting, by clicking Raise Hand on their Participant panels. 

Muting and unmuting all attendees' microphones 
simultaneously

Host only

During a teleconference, you can mute or unmute all attendees’ microphones 
simultaneously. 

This option does not affect the host’s and presenter’s microphones.

The indicator to the left of each participant’s name changes state:

The indicator beside the attendee’s name 
changes state when you mute or unmute 
the attendee’s microphone.

To mute all attendees’ microphones To unmute all attendees’ microphones

■ using your phone keys, press “##”

■ on the Participant menu, choose Mute All

■ using your phone keys, press “99”

■ on the Participant menu, choose Unmute 
All
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Note Participants for whom you have muted microphones can request to speak at 
any time during a meeting, by clicking Raise Hand on their Participant panels. 

Muting and unmuting your microphone in a teleconference

Participant

In a teleconference, you can mute or unmute your microphone at any time. 
However, if the host has muted your microphone, you cannot unmute it.

To mute or unmute your microphone:

1 On the Participants panel, select your name. 

2 Click Mute or UnMute.

Asking to speak in a teleconference
Participant

If the host has muted your microphone during a teleconference, you can ask the 
host to unmute your microphone so that you can speak. You can cancel a request 
to speak at any time.

The indicator to the left of your name 
changes state.

To ask to speak result

click Raise Hand On 
the Participants’ panel 

The Raised Hand indicator appears on the 
Participant panel for the host and presenter.
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Determining who is speaking in a teleconference
Participant

During a teleconference, you can quickly determine which participants are 
speaking. When a participant speaks, the Teleconference indicator on the 
Participants panel animates. For example:

To cancel a request to speak result

click Lower Hand On the 
Participants’ panel

The Raised Hand indicator is removed 
from the Participant panel for the host 
and presenter.
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Using Integrated VoIP 
Conferences

You can use an Integrated VoIP conference (VoIP powered by GIPS) in addition to, 
or instead of, a teleconference. This option allows participants to speak to each 
other using voice over IP (VoIP)—an Internet–based telephony service—rather 
than the telephone system. Integrated VoIP conferences are useful if:

■ Attendees are located a great distance away and do not want to incur long 
distance phone charges

■ The meeting is a presentation rather than a discussion and does not involve 
interaction among attendees

Your user role in an Integrated VoIP conference determines your level of 
participation. Whichever role you take, the following table describes the basic tasks 
associated with that role. For detailed instructions on a particular task, click “More” 
by a task description.

Role What you can do:

host Start and manage a 
VoIP conference:

■ set conference 
options More...

■ start or end a 
conference More...

■ Allow a participant to 
speak More...

■ mute or unmute 
participant 
microphones More...

■ Mute or unmute your 
microphone More...
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Note For better audio quality and greater convenience, use a computer headset 
with a high-quality microphone, rather than speakers and a microphone.

Starting or joining an Integrated VoIP conference
Once a host starts an Integrated VoIP conference, any participant whose computer 
has a supported sound card can join the conference. Up to seven participants can 
speak at a time in an Integrated VoIP conference. The host determines who can 
speak by passing the microphone to a participant.

A host can end an Integrated VoIP conference at any time. 

To start or end an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > Start Conference or End 
Conference.

To join or leave an Integrated VoIP conference, do one of the following:

■ Click Yes to join the conference when the Join Integrated VoIP message appears 
on your screen.

■ On the Communicate menu, choose Integrated VoIP > Join Conference or 
Leave Conference respectively.

During a meeting, you can leave an Integrated VoIP conference without leaving the 
meeting. You can also rejoin the conference at any time.

To rejoin an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > Join Conference.

Tip

■ Before starting or joining an Integrated VoIP conference, use the Audio Setup 
Wizard to fine-tune your computer’s settings for Integrated VoIP. For details, 

participant Participate in a VoIP 
conference:

■ Join or leave a 
conference More...

■ Mute or unmute your 
microphone More...

■ Ask to speak More...

Role What you can do:
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see Setting Integrated VoIP conference options on page 151.

■ As a participant, at any time during an Integrated VoIP conference, you can ask 
the meeting host to pass the microphone to you. For details, see Asking to speak 
in an Integrated VoIP conference on page 147.

Asking to speak in an Integrated VoIP conference
Participant only

During an Integrated VoIP conference, you can indicate to the meeting host that 
you want to speak. You can cancel a request to speak at any time.

To request to speak, or to cancel a request to speak:

On the Participants panel, click Raise Hand or Lower Hand, respectively.

■ If you ask to speak, the Raised Hand indicator appears on the Participant panel 
for the host and presenter.

■ If you cancel a request to speak, the Raised Hand indicator is removed from the 
Participant panel for the host and presenter.

Allowing a participant to speak in an Integrated 
VoIP conference

Host only

Once you start an Integrated VoIP conference, participants can join the conference 
and listen to Integrated VoIP audio. Up to seven participants can speak at a time.

You can specify which participants can speak, by passing the microphone to a 
participant.

To allow a participant to speak in an Integrated VoIP conference:

1 On the Participants panel, select the name of the participant whom you want to 
allow to speak.

2 On the Participant panel, click Pass Mic.
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The Integrated VoIP indicator appears to the left of the participant’s name on 
the Participants panel. For example:

The participant can now speak until you either pass the microphone to another 
participant or mute the participant’s microphone.

Note A panelist or attendee can request to speak at any time during a meeting, by 
clicking Ask for Mic on the Participants panel.

Meeting Manager then places the panelist or attendee in the speaker queue. For 
more information, see Understanding the speaker queue for Integrated VoIP on 
page 150.

Speaking in an Integrated VoIP conference
If you are a current speaker in an Integrated VoIP conference, the method by which 
you speak depends on the speaker setup option that is currently selected for your 
Integrated VoIP session:

■ Desktop speakers (default): If this option is selected, the following appears in the 
bottom-right corner of your Meeting window:

Simply speak into your microphone.

■ Headset: If this option is selected, the following appears in the bottom-right 
corner of your Meeting window: 

Press the Ctrl key on your keyboard while speaking. Pressing this key mutes your 
speakers, thereby preventing your voice from echoing in the conference.

Tip Before you join an Integrated VoIP conference, you can use the Audio Setup 
Wizard to select your speaker setup. For details, see Setting Integrated VoIP 
conference options on page 151.
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Muting and unmuting microphones in an 
Integrated VoIP conference

The following table illustrates how to quickly mute and unmute microphones in a 
conference depending on your user role. If you want detailed instructions, click 
“More” by the task description.

Muting and unmuting participant microphones
Host

In an Integrated VoIP conference, you can mute or unmute one or more participant 
microphones.

To mute or unmute a specific participant’s microphone:

1 On the Participants panel, select the participant for whom you want to mute or 
unmute the microphone.

2 Click Mute or Unmute to control the participant’s microphone

The Muted or Unmuted indicator appears to the left of the participant’s name. 
For example:

Note If a participant is a current speaker in an Integrated VoIP conference and you 
have not muted his or her microphone, that participant can mute or unmute his or 
her own microphone independently.

Role What you can do

Host ■ mute or unmute your own 
microphone at any time 
More...

■ mute all attendees’ 
microphones More...

■ mute or unmute a specific 
participant’s microphone 
More...

Participant mute or unmute your own 
microphone at any time More...

The indicator beside the attendee’s name 
changes state when you mute or unmute 
the attendee’s microphone.
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To mute or unmute all participant microphones at time of joining:

On the Participant menu, choose Mute on Entry.

To mute or unmute all participants’ microphones during a meeting:

On the Participant menu, choose Mute All or Unmute All, respectively.

Muting and unmuting your microphone

If you are the current speaker in an Integrated VoIP conference, you can mute or 
unmute your microphone at any time. However, if the host has muted your 
microphone, you cannot unmute it.

To mute or unmute your microphone:

1 On the Participants panel, select your name. 

2 Click Mute or Unmute.

Understanding the speaker queue for Integrated 
VoIP

During an Integrated VoIP conference, a participant can request to speak.

Once a participant requests to speak, Meeting Manager places the participant in the 
speaker queue, as indicated by a number to the right of the Integrated VoIP symbol. 
For example:

The speaker queue lets you keep track of the order in which participants have 
requested to speak. To let a participant speak, the host can pass the microphone to 
the participant. For details, see Allowing a participant to speak in an Integrated VoIP 
conference on page 147.

Once the host passes the microphone to a participant, Meeting Manager removes 
the participant from the speaker queue, and then renumbers the remaining 
participants. For example, speaker 2 in the queue becomes speaker 1.

The indicator to the left of your name 
changes state.

The number next to a participant’s name 
indicates that participant’s position in the 
speaker queue.
150



Chapter 12: Using Integrated VoIP Conferences
Setting Integrated VoIP conference options
■ Use the Audio Setup Wizard to

specify your audio equipment and set optimal volume levels. You can specify 
whether you are using speakers and a separate microphone, or a headset with 
an integrated microphone

ensure that your microphone and speakers are set to their optimal volume 
levels. 

■ Use the Volume dialog box to adjust the volume for your speakers or 
microphone at any time.

To set Integrated VoIP conference options:

1 On the Communicate menu, choose one of the following:

■ Audio Setup Wizard

■ Integrated VoIP > Volume

A wizard or dialog box appears.

2 Follow the directions to specify your settings.
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13
Sharing Presentations, 
Documents, and Whiteboards

Your user role in a meeting determines your level of sharing. Whichever role you 
take, the following table describes the basic tasks associated with that role. For 
detailed instructions on a particular task, click “More” by the task description.

Role Task description:

Host Start and control sharing 
a document or 
presentation

■ learn about tools for 
sharing More...

■ start sharing More...

■ assigning sharing 
privileges to 
attendees More...

■ save a document 
More...

Attendee View and interact with 
shared documents and 
presentations

■ display slides or 
pages More...

■ use tools to annotate 
a document More...

■ synchronize your 
view with the host 
More...
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Granting sharing privileges to attendees
By default, only the presenter can share a document, presentation, or whiteboard 
during a meeting. However, you can allow all attendees or individual attendees to 
share their own presentations or documents or interact with pages, slides, and 
whiteboards that others share. You can also remove these sharing privileges from 
attendees at any time.

To specify attendee privileges for shared content in the content viewer:

1 In the Meeting window, on the Participant menu, choose Privileges. 

The Attendee Privileges dialog box appears.

2 Do one of the following:

■ To grant privileges to or remove them from all attendees at once, in the pane 
on the left, select All Attendees.

■ To grant privileges to or remove them from an individual attendee, in the 
pane on the left, expand All Attendees, and then select the attendee's name.

3 Click the Participants tab; then, under Document, select or clear the check boxes 
for any sharing privileges you want to grant to or remove from all or selected 
attendees:

■ Save

■ Print

■ Annotate

4 Under View, select or clear the check boxes for any sharing privileges that you 
want to grant to or remove from all or selected attendees:

■ Participant list

■ Any document

■ Thumbnails

■ Any page

5 Under Meeting, select or clear the check boxes to grant to or remove these 
privileges from all or selected attendees:

■ Record a meeting

■ Share documents

■ Control shared applications, or web browser, or desktop remotely

6 Click Assign.

Note

■ A meeting host can also grant sharing privileges to attendees when scheduling a 
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meeting. 

■ Attendees with sharing privileges cannot share UCF multimedia presentations 
or standalone UCF media files, unless the meeting host selects this option when 
scheduling a meeting.

Content viewer tools

The tools on the content viewer toolbar allow you to share and perform actions on 
presentations, documents, and whiteboards.

Use these tools to share applications, 
documents, your desktop or a white 
board. For details, see Annotation tools 
on page 156.

Select an annotation tool for directing attention to 
something onscreen using pointers, a highlighter, or 
drawing a shape. For details, see Annotation tools on 
page 156.

Change to full-screen, rotate pages, zoom in or out using 
these tools. For details, see Annotation tools on page 156.
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Annotation tools

View tools

Tool Description

Pointer Lets you point out text and graphics on shared content. The pointer displays 
an arrow with your name and annotation color. To display the laser pointer, 
which lets you point out text and graphics on shared content using a red “laser 
beam,” click the downward-pointing arrow. Clicking this button again turns off 
the pointer tool.

Text Lets you type text on shared content. Attendees can view the text once you 
finish typing it and click your mouse in the content viewer, outside the text box.

To change the font, on the Edit menu, choose Font. Clicking this button 
again turns off the text tool.

Line Lets you draw lines and arrows on shared content. For more options, click 
the downward-pointing arrow. Clicking this button closes the Rectangle 
tool.

Rectangle Lets you draw shapes, such as rectangles and ellipses on shared content. 
For more options, click the downward-pointing arrow. Clicking this button 
again closes the Rectangle tool.

Highlighter Lets you highlight text and other elements in shared content. For more 
options, click the downward-pointing arrow. Clicking this button again 
closes the Highlighter tool

Annotation 
Color

Displays the Annotation Color palette, on which you can select a color to 
annotate shared content. Clicking this button again closes the Annotation 
Color palette.

Eraser Erases text and annotations or clears pointers on shared content. To erase a 
single annotation, click it in the viewer. For more options, click the 
downward-pointing arrow. Clicking this button again turns off the eraser tool.

Text tool Rectangle tool

Eraser tool

Annotation Color tool

Line toolPointer tool Highlighter tool

Standard View Full-Screen View Zoom In/ZoomOut

Synchronize Displays for AllView Thumbnails Rotate page (left or right)
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Sharing presentations or documents
You can share almost any type of document or presentation that you can print from 
your computer. Attendees view shared documents presentations in their content 
viewers, without the need for the application with which it was created. Attendees 
can also view any animation and transition effects on shared Microsoft PowerPoint 
slides.

After a meeting starts, you can open a document or presentation to share. You do 
not need to select it or “load” it before the meeting. 

Document and presentation sharing is ideal for presenting information that you do 
not need to edit during the meeting, such as a slide presentation

While sharing a document or presentation, you can:

■ Make annotations More...

■ Use a pointer to emphasize text or graphics More...

■ Save it to a file More...

■ Print it More...

■ Display it at various magnifications, in miniature (thumbnails), and in a 
full-screen view More...

■ Synchronize all participants’ displays with the display in your content viewer 
More...

Tool Description

Standard View/
View Thumbnails

Clicking Standard View displays the shared content as you would normally 
view it. To display thumbnails, or miniatures, of shared pages, slides, or 
whiteboards to the side of the content, click View Thumbnails. This tool 
helps you locate a page or slide quickly.

Click Standard View to return to normal viewing of the shared content.

Full-Screen View Displays shared content in a full-screen view. Helps you to ensure that 
participants can view all activity on your screen. Also helps to prevent 
participants from viewing or using other applications on their screens during 
a presentation.

Click ESC to return to the content viewer.

Rotate page For documents in landscape orientation, you can rotate the pages to the left 
or right so they appear correctly in the content viewer.

Zoom In/
Zoom Out

Lets you display shared content at various magnifications. Click this button, 
and then click the page, slide, or whiteboard to change its magnification. For 
more magnification options, click the downward-pointing arrow.

Synchronize 
Displays for All

For presenters, synchronizes all participants' displays with your display. 
Helps to ensure that all participants are viewing the same page or slide, at 
the same magnification, as in your display.
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At any time during a meeting, you can grant attendees privileges that allow them to 
annotate, save, print, and display different views of shared presentations or 
documents.

Sharing a document or presentation

You can share a document or presentation that resides on your computer. 
Participants view the shared document or presentation in their content viewers.

To share a document or presentation:

1 On the Share menu, choose Presentation or Document.

The Share Presentation or Document dialog box appears.

2 Select the document or presentation that you want to share.

3 Click Open.

The shared document or presentation appears in the content viewer. 

Tip For tips that can help you to share documents and presentations more 
effectively, see Tips for sharing documents and presentations on page 159.

Determining whether participants can view a page or slide

When sharing a document or presentation, you can check the Participant Ready 
indicator to determine whether the page or slide currently displayed in your content 
viewer is visible to other participants. This indicator is especially useful if you are 
sharing a UCF media file on a slide, and want to wait until the file loads in all 
participants' content viewers before you play it.

25% of the page or slide has loaded in the participant's content viewer.

50% of the page or slide has loaded in the participant's content viewer.

75% of the page or slide has loaded in the participant's content viewer.

100% of the page or slide has loaded in the participant's content viewer.
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Note If the Participant Ready indicator does not appear to the left of a participant's 
name in the participant list, the page, slide, or whiteboard in your content viewer is 
not displayed in the participant's content viewer. For example, the participant may 
be viewing another slide in your presentation. In this case, you can synchronize all 
participant’s displays with your display. For details, see Synchronizing attendees' 
views of slides, pages, or whiteboards on page 170.

Tips for sharing documents and presentations

These tips can help you share documents or presentations more effectively.

■ To import slide presentations quickly:

Limit the number of animations and slide transitions.

Minimize the number of screen shots that you add to slides, especially bitmap 
graphics. Bitmaps do not compress well.

Limit the number of a slides in a presentation to fewer than 30. If you want 
to share more slides, create a separate presentation file for each set of 20 to 30 
slides.

Keep the size of the presentation file smaller than 5MB.

■ To save time during a meeting, begin sharing the document or presentation 
before the meeting's starting time. That way, after attendees join the meeting, 
they can begin viewing your presentation.

■ To improve the speed at which shared pages or slides appear in attendees' 
content viewers, save the document or presentation as a .ucf (Universal 
Communications Format) file before the meeting starts. Then share the .ucf 
file instead of the document or presentation itself. For details, see Saving a 
presentation, document, or whiteboard on page 174.

■ You can annotate shared presentations or documents in the content viewer; 
however, you cannot edit them. If you want to edit shared information, you can 
use application sharing instead. 

■ If you are sharing a PowerPoint presentation, you can open the PowerPoint 
Notes panel and view any notes you have added to the slide in the presentation.
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Choosing an import mode for document or presentation sharing

Before you share a document or presentation, you can choose one of the following 
import modes:

■ Universal Communications Format (UCF)—The default mode. Lets you 
display animations and slide transitions in Microsoft PowerPoint presentations. 
In the UCF mode, Meeting Manager imports documents and presentations 
more quickly than it does in the printer driver mode. However, pages or slides 
may not appear consistently in Meeting Manager across platforms. 

■ Printer driver—Displays shared documents and presentations as they appear 
when you print them, providing a consistent appearance of pages and slides in 
Meeting Manager across platforms. However, this mode does not support 
animations or slide transitions. In this mode, the first page or slide may appear 
quickly, but the total import time for all pages or slides is usually longer than it 
is in the UCF mode.

Note Changing the import mode does not affect any presentations or documents 
that you are currently sharing. To apply a new import mode to a shared document 
or presentation, you most close it first, and then share it again.

To choose an import mode for shared documents and presentations:

1 In the Meeting window, on the Meeting menu, choose Options.

The Meeting Options dialog box appears, with the Options tab selected by 
default.

2 Click the Import Mode tab.

The Import Mode tab options appear.

3 Select either Universal Communications Format or Printer driver.

4 Click OK.
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Closing shared documents and presentations

You can close any presentations or documents that you are sharing in your content 
viewer.

To close a shared document or presentation:

1 In the content viewer, select the tab for the document or presentation that you 
want to close.

2 On the File menu, choose Close.

If you have not yet saved any annotations that you made on the document or 
presentation, a message appears, allowing you to save it.

Sharing a whiteboard
Sharing a whiteboard allows you to draw objects and type text that all attendees can 
see in their content viewers. You can also use a pointer to emphasize text or graphics 
on a whiteboard. 

While sharing whiteboard, you can:

■ Display it at various magnifications, in miniature (thumbnails), and in a 
full-screen view More...

■ Save it 

■ Print it 

■ Synchronize attendees’s displays with the display in your content viewer More...

If you allow attendees to annotate slides and pages, you and attendees can draw and 
type on a whiteboard simultaneously. You can also allow attendees to save, print, 
and display different views of shared whiteboards. For details, see Granting sharing 
privileges to attendees on page 154.

Starting whiteboard sharing

You can share a whiteboard on which you can draw and write. Attendees can view 
a shared whiteboard in their content viewers.

To share a whiteboard:

On the Share menu, choose Whiteboard.

Note

■ You can add multiple pages to a shared whiteboard. For details, see Adding new 
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pages or slides on page 166.

■ You can share multiple whiteboards. For each whiteboard that you share, 
Meeting Manager creates a new Whiteboard tab in the content viewer.

Closing a shared whiteboard

You can close any whiteboards that you are sharing in your content viewer.

To close a shared whiteboard:

1 In the content viewer, select the tab for the whiteboard you want to close.

2 On the File menu, choose Close.

If you have not yet saved any annotations that you made on the whiteboard, a 
message appears, allowing you to save it.

Navigating presentations, documents, or 
whiteboards

When sharing a document, presentation, or whiteboard, you can:

■ Navigate slides, pages, or whiteboards using the toolbar More...

■ Advance pages or slides automatically, at an interval of time that you specify 
More...

■ Perform animations and slide transitions in a presentation More...

■ Use keys on your computer’s keyboard to navigate a presentation and display 
animations on the slides More...

Navigating slides, pages, or whiteboards using the toolbar

You can navigate to different pages, slides, or whiteboard “pages” in the content 
viewer. Each document, presentation, or whiteboard being shared appears on a tab 
at the top of the content viewer.

To display pages or slides in the content viewer:

1 In the Meeting window, in the content viewer, select the tab for the document, 
presentation, or whiteboard that you want to display.

If there are more tabs than can appear at one time, click the Next Tab button to 
cause the next tab to scroll into view.

Click this button to view 
other tabs
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2 On the toolbar, click a button to change the page or slide you are viewing.

■ To display the next page or slide, click the Next button.

■ To display the previous page or slide, click the Previous button.

■ To display any page or slide, select it in the Go To drop-down list.

If Microsoft PowerPoint slides are being shared, the drop-down list also dis-
plays the title of each slide.

Note

■ Alternatively, you can navigate to different pages or slides in a shared document, 
presentation, or whiteboard by opening the thumbnail viewer. For details, see 
Viewing thumbnails of slides, pages, or whiteboards on page 169.

■ You can advance pages or slides automatically at a time interval that you specify. 
For details, see Advancing pages or slides automatically on page 163.

■ You can also use the keys on your computer's keyboard to display different pages 
or slides and perform animations and slide transitions. For details, see Using 
keyboard shortcuts to control a presentation on page 165.

■ If you your presentation includes animations or slide transitions, you can use the 
toolbar or keyboard shortcuts to perform them. For details, see Animating and 
adding effects to shared slides on page 164.

Advancing pages or slides automatically

When sharing a document or presentation in the content viewer, you can 
automatically advance pages or slides at a specified interval. Once you start 
automatic page or slide advancement, you can stop it at any time.

To automatically advance pages or slides:

1 In the Meeting window, in the content viewer, select the tab for the document 
or presentation for which you want to advance pages or slides automatically.

2 On the View menu, choose Automatically Advance Pages.

The Automatically Advance Pages dialog box appears.

Next buttonPrevious button

Select a slide
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3 In the Advance to next page every box, specify an interval of time at which to 
advance pages or slides, by selecting the minutes or seconds, and then doing 
either of the following:

■  Type a time.

■  Click the Up button to increase the number or click the Down button to 
decrease the number.

4 Optional. To restart page or slide advancement once all pages or slides are 
displayed, select the Return to beginning and continue advancing pages check 
box. 

5 Click Start.

6 Optional. Close the Automatically Advance Pages dialog box by clicking the 
Close button in the upper-right corner of the dialog box.

The pages or slides continue to advance at the specified interval.

To stop automatic page or slide advancement:

1 If you closed the Automatically Advance Pages dialog box, on the View menu, 
choose Automatically Advance Pages.

The Automatically Advance Pages dialog box appears.

2 Click Stop.

Animating and adding effects to shared slides

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you 
can animate text and slide transitions, just as you can when using the Slide Show 
option in PowerPoint. 

Note To show slide animations and transitions, you must share the presentation as 
a Universal Communications Format (UCF) file (.ucf). The UCF import mode 
automatically converts a PowerPoint file (.ppt) to a UCF file when you share it. For 
information about choosing an import mode, see Sharing a document or 
presentation on page 158.

■ For best results when sharing a presentation created using Microsoft PowerPoint 

Up button

Down button
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2002 for Windows XP, use a computer with an Intel Celeron or Pentium 500 
MHz or faster processor.

■ Alternatively, use the keys on your computer keyboard to show animations and 
slide transitions in a PowerPoint slide presentation. For details, see Using 
keyboard shortcuts to control a presentation on page 165.

■ If at least one meeting participant is using the Java Meeting Manager, 
animations and slide transitions will not display during the meeting. The 
meeting host can prevent participants from joining a meeting using the Java 
Meeting Manager when scheduling the meeting. 

To show slide animations and transitions in a shared presentation:

1 Ensure that the content viewer has input focus by clicking in the viewer.

The content viewer has input focus if a blue border appears around the outside 
of the slide in the viewer.

2 On the toolbar, click the Previous or Next button to move through your 
presentation.

Using keyboard shortcuts to control a presentation

When sharing a document or presentation in the content viewer, you can use the 
keys on your keyboard to display pages or slides. If you are sharing a Microsoft 
PowerPoint slide presentation, you can also use keyboard keys to show animations 
on the slides and in slide transitions, just as you can when using the Slide Show 
option in PowerPoint. 

Note Before using keyboard shortcuts, click in the viewer to set the input focus in 
the content viewer. A blue border around the shared page or slide indicates that the 
viewer has input focus.

Sharing a Presentation

Use these keystrokes to move quickly through your presentation.

Previous button Next button

To... Press...

Display the next slide or perform the next 
animation or slide transition

Space Bar, Page Down, Right Arrow, or 
Down Arrow

Display the previous slide or perform the 
previous animation or slide transition

Page Up, Left Arrow, or Up Arrow
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Note To show animations and slide transitions, you must share the presentation as 
a Universal Communications Format (UCF) file. The UCF import mode 
automatically converts a PowerPoint file to a UCF file when you share it. For 
information about choosing an import mode, see Choosing an import mode for 
document or presentation sharing on page 160.

Sharing a Document

Use these keystrokes to move quickly through your document.

Working with pages or slides
When sharing a document, presentation, or whiteboard, you can

■ Add new, blank pages or slides for annotation More...

■ Paste images that you copy to your computer’s clipboard into a new page or slide 
in a shared document, presentation, or whiteboard More...

Adding new pages or slides

When sharing a document, presentation, or whiteboard in the content viewer, you 
can add a new, blank page or slide for annotation.

To add a new page or slide:

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard to which you want to add a page or slide.

2 On the Edit menu, choose Add Page.

A new page appears in the content viewer, at the end of the currently selected 
document, presentation, or whiteboard.

Display the first slide Home

Display the last slide End

To... Press...

Display the next page Space Bar, or Page Down, Right Arrow, 
or Down Arrow

Display the previous page Page Up, Left Arrow, or Up Arrow

Display the first page Home

Display the last page End

To... Press...
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Pasting images in slides, pages, or whiteboards

If you copy any bitmap image to your computer's clipboard, you can paste the 
image into a new page, slide, or whiteboard in the content viewer. 

For example, you can copy an image on a Web page or in an application, then 
quickly share that image by pasting it in the content viewer.

To paste an image in a page, slide, or whiteboard in the content viewer:

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard in which you want to paste an image.

2 On the Edit menu, choose Paste Page Image.

The image appears on a new page in the content viewer, at the end of the 
currently selected document, presentation, or whiteboard.

Note You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF 
image in the content viewer. However, you cannot paste other types of images—
such as EPS or Photoshop (PSD) images—in the content viewer.

Managing views of presentations, documents, or 
whiteboards

All shared presentations, documents, or whiteboards appear in the content viewer 
in the Meeting window. A tab at the top of the content viewer appears for each 
document, presentation, or whiteboard that is being shared. 

Depending on your role and the privileges that you have, you can do the following 
when viewing shared content in the content viewer:

■ View slides, pages, or whiteboards at various magnifications.

■ View slides, pages, or whiteboards in miniature.

■ Display a full-screen view of a page, slide, or whiteboard.

■ Synchronize all participants’ views of a page or slide with the view that appears 
in your content viewer
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Zooming in and out on slides, pages, or whiteboards

Using the tools on the content viewer toolbar, you can:

■ Zoom in to or out from on a page, slide, or whiteboard 

■ Adjust the size of a page, slide, or whiteboard to fit the content viewer

■ Adjust the size of a page, slide, or whiteboard to fit it width in the content viewer

■ Turn off the Zoom tool at any time

To zoom in to or out from on a page, slide, or whiteboard:

Do one of the following on the content viewer toolbar:

■ To zoom in or out incrementally, click the downward pointing arrow to the left 
of the Zoom In/Zoom Out button, and then choose Zoom In or Zoom Out. To 
continuing zooming in or out, click the Zoom In/Zoom Out button.

■ To zoom in to a specific area, click the downward-pointing arrow to the right of 
the Zoom In button, and then drag your mouse to the area. Release your mouse 
button.

■ To zoom in or out to a preset percentage, click the downward-pointing arrow to 
the left of the Zoom In/Zoom Out button, and then choose the percentage.

To adjust the size of a page, slide, or whiteboard to fit the content viewer:

1 On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

2 On the menu that appears, choose Fit to Viewer.

To adjust the size of a page, slide, or whiteboard to fit its width in the content 
viewer:

1 On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

2 On the menu that appears, choose Fit to Width.

To turn off the zoom tool:

On the toolbar, click the Zoom In/Zoom Out button.

Click to choose a viewing 
option

Click to choose a viewing 
option
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Controlling full-screen view of slides, pages, or whiteboards

You can maximize the size of a page, slide, or whiteboard in the content viewer to 
fit your monitor's entire screen. A full-screen view replaces the normal Meeting 
window view. You can return to a normal view at any time.

Note If a meeting presenter displays a full-screen view of a page, slide, or 
whiteboard, attendees’ screens automatically display a full-screen view as well. 
However, attendees can control full-screen view independently in their Meeting 
windows. 

To display a full-screen view:

On the toolbar, click the Full-Screen View button.

To return to a normal view:

On the floating icon tray, click Return to Main Window.

Viewing thumbnails of slides, pages, or whiteboards

You can view thumbnails of the shared pages, slides, and whiteboards that appear 
in the content viewer. Viewing thumbnails can help you to locate quickly a shared 
page or slide that you want to display in the content viewer.

To view thumbnails of slides, pages, or whiteboards:

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard for which you want to view miniatures.

2 On the toolbar, click the View Thumbnails button.

Full-Screen View

Return to Main Window

View Thumbnails
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Thumbnails of all pages or slides in the selected document, presentation, or 
whiteboard appear in the thumbnail viewer, in the left column.

3 Optional. To display any page or slide in the content viewer, double-click its 
miniature in the thumbnail viewer.

4 Optional. To control the size of the thumbnail viewer, drag the right edge of the 
viewer to the right or left.

Note Attendees must have both the View thumbnails and View any page privileges 
to display a miniature of a page or slide at full size in the content viewer.

To close the thumbnail viewer:

On the toolbar, click the View Thumbnails button again.

Synchronizing attendees' views of slides, pages, or whiteboards

You can synchronize the display of a shared page, slide, or whiteboard in all 
attendees’ content viewers with the display in your viewer. Once you synchronize 
displays, the page, slide, or whiteboard in attendees’ content viewers appears at the 
same magnification as in your content viewer.

Click Standard View
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To synchronize attendees' views of slides, pages, or whiteboards:

On the content viewer toolbar, click the Synchronize Displays button.

Clearing annotations on slides, pages, or whiteboards

You can clear any annotations that you or another attendee makes on a shared page, 
slide, or whiteboard in the content viewer. You can clear:

■ All annotations at once

■ Only specific annotations

■ If you are the presenter or host, clear all annotation you have made

To clear all annotations on a shared page, slide, or whiteboard:

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser 
Tool icon.

2 Choose Clear All Annotations.

Note Only annotations on the page or slide that currently appears in your content 
viewer are cleared. Annotations on other pages or slides are not cleared.

If you are the host or presenter, you can clear all the annotations you’ve made.

To clear all annotations you have added to a shared page, slide, or whiteboard:

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser 
Tool icon.

2 Choose Clear My Annotations.

To clear specific annotations on a shared page, slide, or whiteboard:

1 On the toolbar, click the Eraser Tool icon.

Your mouse pointer changes to an eraser.

2 Click the annotation you want to clear.

To turn off the eraser tool:

On the toolbar, click the Eraser Tool icon.

Synchronize Displays

Eraser tool
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Clearing pointers on slides, pages, or whiteboards

You can clear your own pointers on all shared slides, pages, or whiteboards in the 
content viewer. If you are a presenter, you can also clear all attendees’ pointers.

To clear your own pointer on all shared slides, pages, or whiteboards: 

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser 
Tool icon.

2 Choose Clear My Pointer.

Renaming the tab for a presentation, document, or whiteboard

As you are sharing an item, such as a presentation, in the content viewer, you can 
easily change its name on the tab. Later, when you end the meeting, you can save 
the document, presentation, or whiteboard with this new name.

To rename a tab in the content viewer:

1 Right click the tab name you want to change.

2 Enter the new name on the tab.

3 Press Enter or click outside the tab.

This tab displays the new name.

Tip You can also click the tab name to select it.

This feature is handy if participants have used the annotation tools to make 
comments and notes or highlight elements in your document. You can save your 
document with the annotations as a new document, separate from your original. 

Click to display Eraser tools

Type the 
name here
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Of course, you can still use the Save As command on the File menu to save the 
document at the end of your meeting. Changing the name on the tab itself allows 
others to see the name you are giving the file. Also, you are making the change at 
the moment that action is meaningful, rather than at the end of the meeting.

Reordering the tabs for documents, presentations, and 
whiteboards

The tabs in the content viewer are arranged in the order you open them. That order 
may not be the most logical way to display them. You can easily move the tabs, so 
the most current and important items are visible.

To reorder the tabs in the content viewer:

1 Right-click any tab.

2 In the Reorder View Tabs dialog box, use the arrows change the order of the tabs.

Moving a tab up in the order moves that tab to the left in the content viewer.

3 Click OK.

Tip To quickly move a tab to the left or right, select the tab and use a drag and drop 
operation to move it.

Use these arrows to put the 
tabs in a different order
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Saving, opening, and printing presentations, 
documents, or whiteboards

Meeting participants (hosts, presenters, and attendees with privileges) can access 
and print documents, presentations, and whiteboards shared in a meeting. For 
example, you can:

■ save a shared presentation More...

■ open a saved document More...

■ print a whiteboard More...

Saving a presentation, document, or whiteboard

You can save any shared document, presentation, or whiteboard that appears in the 
content viewer. A saved file contains all the pages or slides in the document, 
presentation, or whiteboard that is currently displayed in the content viewer, 
including any annotations and pointers that you or other attendees added to them.

Files that you save are in the Universal Communications Format (UCF), which 
have a .ucf extension. You can open a .ucf file either in another meeting or at any 
time outside of a meeting. 

Once you save a new document, presentation, or whiteboard to a file, you can save 
it again to overwrite the file or save a copy to another file.

To save a new document, presentation, or whiteboard that appears in the content 
viewer:

1 On the File menu, choose Save > Document.

The Save Document As dialog box appears.

2 Choose a location at which to save the file.

3 Type a name for the file in the File name box.

To save changes to a saved document, presentation, or whiteboard that appears in 
the content viewer:

1 On the File menu, choose Save > Document.

Meeting Manager saves the changes to the existing file.

To save a copy of a document, presentation, or whiteboard: 

1 On the File menu, choose Save As > Document.

The Save Document As dialog box appears.

2 Do either or both of the following:

■ Type a new name for the file.

■ Choose a new location at which to save the file.
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3 Click Save.

Opening a saved document, presentation, or whiteboard

If you saved a document, presentation, or whiteboard that appeared in the content 
viewer during a meeting, you can do either of the following:

■ Open file in the content viewer during another meeting for sharing. Only a 
presenter or attendees who have the Share documents privilege can open a saved 
file during a meeting.

■ Open the file at any time on your computer's desktop. If you open a saved file 
on your desktop, it appears in the WebEx Document Manager, a standalone, or 
“offline,” version of the content viewer. 

A saved document, presentation, or whiteboard is in the saved Universal 
Communications Format (UCF) and has a .ucf extension.

To open a saved document, presentation, or whiteboard file in the content viewer:

1 On the File menu, choose Open > Document.

The Open Document dialog box appears.

2 Select the document, presentation, or whiteboard file that you want to open.

3 Click Open.

To open a saved document, presentation, or whiteboard on your computer's 
desktop:

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document 
Viewer.

Printing presentations, documents, or whiteboards

You can print any shared presentations, documents, or whiteboards that appear in 
your content viewer. A printed copy of shared content includes all annotations and 
pointers that you or other attendees added to it.

To print shared content:

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard that you want to print.

2 On the File menu, choose Print > Document.

3 Select the printing options that you want to use, and then print the document.
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Note When printing shared content in the content viewer, Meeting Manager 
resizes it to fit on the printed page. However, for whiteboards, the Meeting Manager 
prints only the content that lies within the dashed lines on the whiteboard. 

If you are a meeting attendee...
If you are attending a meeting, (and have not taken on another role, such as host or 
presenter), you can move around independently in shared documents and 
presentations, if the host has assigned these privileges to you. For shared 
documents, presentations, and whiteboards, you can:

■ display any page More...

■ synchronize your view with the host’s view More...

■ save shared documents More...

■ open shared documents More...

■ print shared documents More...

Displaying pages, slides, or whiteboards

For attendees

If you have been granted the necessary privileges, you can navigate to different 
pages, slides, or whiteboard “pages” in the content viewer. Each document, 
presentation, or whiteboard being shared appears on a at the top of the content 
viewer.

To display pages or slides in the content viewer:

1 In the Meeting window, in the content viewer, select the tab for the document, 
presentation, or whiteboard that you want to display.

If you have more tabs than can be displayed on the content viewer, click the 
down-arrow button at the end of the tabs to view the list of other tabs.

2 On the toolbar, click a button to change the page or slide you are viewing:

Click a tab to view a different 
document.

To return to the document or 
page the host is viewing, you can 
synchronize your view More...
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To display the next page or slide, click the Next button.

Synchronizing your view of pages, slides, or whiteboards

During a meeting, you can synchronize the display of shared content in your 
content viewer with the display in the presenter's viewer. This option is useful, for 
example, if you are viewing a previous slide in a presentation and want to quickly 
return to the actual slide that the presenter is discussing. Synchronizing your 
display also resizes it to that in the presenter's content viewer. 

To synchronize your view of shared content in the presentation viewer:

In the Meeting window, on the toolbar, click the Synchronize My Display button.

To move forward and back between pages, 
click the left and right arrows. 

To select any page or slide, select it in the 
Got To drop-down list.

Synchronize My Display button
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Sharing Web Content

About sharing Web content
You can share Web content that resides on:

■ The public Internet or Web

■ Your company’s intranet

■ Your computer or another computer on your private network

Web content includes:

■ Web pages, including pages that contain embedded media files, such as Flash, 
audio, or video files

■ Standalone media files, such as Flash, audio, or video files

The Web content that you share opens in the content viewer on each participant’s 
screen. If you share a Web page, participants view and interact independently with 
the content on the page. If the page contains links to other pages, they can also 
navigate independently to those pages.

If you use Web content sharing, then, participants can experience audio and video 
effects on a Web page. However, unlike Web browser sharing, this option does not 
allow you to guide participants to other Web pages. For more information, see 
Differences between sharing Web content and sharing a Web browser on page 180.

If you want to... See...

get an overview of sharing Web content About sharing Web content on page 179

share Web content with meeting participants Sharing Web content on page 180

understand the differences between sharing a 
browser and sharing Web content

Differences between sharing Web content 
and sharing a Web browser on page 180
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Important If you share content that requires a media player, participants can view 
and interact with the content only if the appropriate player is installed on their 
computers.

Sharing Web content
You can share a Web page that contains multimedia effects. The page opens in the 
content viewer on each participant's screen.

To share Web content:

1 On the Share menu, choose Web Content.

The Share Web Content dialog box appears.

2 In the Address box, enter the address, or URL, at which the content resides.

Or, if you have previously shared the content, select it in the drop-down list.

3 In the Type box, select the type of Web content that you want to share.

4 Click OK.

Tip You can copy a URL from any source, such as another browser window, and 
then paste it in the Address box.

Differences between sharing Web content and 
sharing a Web browser

Meeting Center provides two options for sharing Web-based information. You can 
share Web content or share a Web browser with meeting participants. Choose the 
feature that better suits your needs.
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Sharing option Advantages Disadvantages

Web browser sharing ■ Lets you guide participants 
to various Web pages and 
sites on the Web.

■ Lets you grant attendees 
control of your Web 
browser.

■ Lets you and other 
participants annotate Web 
pages.

■ Does not display media 
effects or transmit sounds 
on Web pages.

■ Does not let participants 
interact with Web pages 
independently.

Web content sharing ■ Displays Web pages, and 
lets participants 
experience media effects 
on Web pages, including 
video and sound.

■ Lets participants interact 
with Web pages 
independently in their 
content viewers.

Does not let you guide 
participants to other Web 
pages.
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Sharing Software

Your user role in a meeting determines your level of participation in sharing 
software. Whichever role you take, the following table describes the basic tasks 
associated with that role. For detailed instructions on a particular task, click “More” 
by the task description.

Role Task description:

Host or 
Presenter

Share software:

■ Share applications 
More...

■ Share your desktop 
More...

■ Share a Web browser 
More...

■ Share a remote 
computer More...

■ Control views of 
shared software 
More...

■ Annotate shared 
software More...

■ Let an attendee 
control your shared 
software More...
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If a presenter shares one of the following types of software during a meeting, it 
appears in a sharing window that automatically opens on all attendees’ screens:

■ Application

■ Computer’s desktop

■ Web browser

■ Applications or the desktop on a remote computer, if the presenter installed the 
Access Anywhere Agent on the computer

The following is an example of a sharing window in which the presenter is sharing 
a Microsoft Word document:

Attendee View and work with 
shared software:

■ Control your view of 
shared software 
More...

■ Request control of 
shared software 
More...

■ Annotate shared 
software More...

■ Switch views 
between the sharing 
window and the 
Meeting window 
More...

■ Stop participating in 
software sharing 
More...

Role Task description:
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Attendees can view all actions that the presenter takes with the shared software. 

Sharing applications

The presenter uses application sharing to show all meeting attendees one or more 
applications on the presenter’s computer. Application sharing is useful for 
demonstrating software or editing documents during a meeting.

If you want to... See...

start sharing an application Starting application sharing on page 186

share multiple applications simultaneously Sharing multiple applications on page 186

stop sharing an application Stopping application sharing for all 
participants on page 188

control views of shared applications Controlling views of shared software on 
page 201

annotate a shared application Annotating Shared Software on page 209

let an attendee annotate a shared application Letting an attendee annotate shared software 
on page 213

let an attendee remotely control a shared 
application

Letting an attendee remotely control shared 
software on page 218

share graphics-intensive applications Sharing applications with detailed color on 
page 220

learn how to share applications effectively Tips for Sharing Software on page 221
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Attendees can view the shared application, including all mouse movements, in a 
sharing window on their screens. Attendees need not run the application that you 
are sharing on their computers.

Starting application sharing

Host or Presenter only

You can share any application on your computer with meeting attendees. 

To share an application:

1 On the Share menu, choose Application.

The Share Application dialog box appears, showing a list of all applications 
currently running on your computer.

2 Do one of the following:

■ If the application you want to share is currently running, select it in the list, 
and then click Share.

■ If the application you want to share is not currently running, click New 
Application. The New Application dialog box appears, showing a list of all 
applications on your computer. Select the application, and then click Share.

Your application appears in a sharing window on attendees' screens.

Tip For tips that can help you to share applications more effectively, see Tips for 
Sharing Software on page 221.

Sharing multiple applications

Host or Presenter only
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If you are already sharing an application, you can share additional applications 
simultaneously. Each application that you share appears in the same sharing 
window on attendees’ screens.

To share an additional application:

1 Do one of the following:

■ On the icon tray, click the Select Panel button.

■ On the title bar of the application that you are currently sharing, click the 
Sharing menu.

■ In the lower-right corner of your computer's desktop, click the Sharing 
menu.

2 On the menu that appears, choose Share Application.

The Share Application dialog box appears, showing a list of all applications that 
are currently running on your computer.

3 Do one of the following:
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■ If the application you want to share is currently running, select it in the list, 
and then click Share. 

■ If the application you want to share is not currently running, click New 
Application. The New Application dialog box appears, showing a list of all 
applications on your computer. Select the application, and then click Share.

Your application appears in a sharing window on attendees' screens.

Important If you close the Share Application dialog box, all application sharing 
stops. Instead, minimize the dialog box to continue sharing the current application.

Tip Alternatively, you can share multiple applications by sharing your computer's 
desktop. For details, see Sharing your desktop on page 190.

Stopping application sharing for all participants

Host or Presenter only

You can stop sharing an application at any time. Once you stop sharing an 
application, attendees can no longer view it. 

If you are sharing multiple applications simultaneously, you can stop sharing either 
a specific application or all applications at once.

To stop sharing a specific application when sharing multiple applications:

1 On the title bar of the application that you are currently sharing, on the Sharing 
menu, choose Share Application.

The Share Application dialog box appears. A check mark appears to the left of 
each application that you are currently sharing. For example:
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2 In the list of applications, select the application that you no longer want to share 
to highlight it.

3 Click Stop Sharing.

To stop all application sharing:

1 Do either of the following:

■ On the title bar of the application that you are currently sharing, click the 
Sharing menu.

■ In the lower-right corner of your computer's desktop, click the Sharing 
menu.

2 On the menu that appears, choose Exit Application Sharing.

Tip You can temporarily pause application sharing, rather than stopping 
application sharing. For details, see Pausing and resuming software sharing on 
page 202.
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Sharing your desktop

The presenter uses desktop sharing to show all meeting attendees his or her entire 
computer desktop—including any applications, windows, and file directories that 
are currently open. The presenter can use desktop sharing to share several 
applications simultaneously or to share other areas of the computer, such as file 
directories.

Attendees can view the presenter’s shared desktop, including all mouse movements, 
in a sharing window on their screens.

Starting desktop sharing

Host or Presenter only

You can share your computer's desktop with meeting attendees.

To share your desktop:

On the Share menu, choose Desktop.

Your desktop appears in a sharing window on attendees’ screens.

Note If your desktop has any background images or patterns, or wallpaper, your 
Meeting Manager software may remove them from attendees' views to improve the 
performance of desktop sharing.

Tip For tips that can help you to share your desktop more effectively, see Tips for 
Sharing Software on page 221.

If you want to... See...

start sharing your desktop Starting desktop sharing on page 190

stop sharing your desktop Stopping desktop sharing on page 191

control views of a shared desktop Controlling views of shared software on 
page 201

annotate a shared desktop Annotating Shared Software on page 209

let an attendee annotate a shared desktop Letting an attendee annotate shared software 
on page 213

let an attendee remotely control a shared 
desktop

Letting an attendee remotely control shared 
software on page 218

share graphics-intensive applications during 
desktop sharing

Sharing applications with detailed color on 
page 220

learn how to share desktops effectively Tips for Sharing Software on page 221
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Stopping desktop sharing

You can stop desktop sharing at any time.

To stop desktop sharing.

1 Do either of the following:

■ On the title bar of any open window, click the Sharing menu.

■ In the lower-right corner of your computer's desktop, click the Sharing 
menu.

2 On the menu that appears, choose Exit Desktop Sharing.

Tip You can temporarily pause desktop sharing, rather than stopping desktop 
sharing. For details, see Pausing and resuming software sharing on page 202.

Depending on your role, the following occurs:

■ If you are the host or presenter, desktop sharing stops for all attendees.

■ If you are an attendee, desktop sharing stops for just you.

Sharing a Web browser

If you want to... See...

start sharing a Web browser Starting Web browser sharing on page 192

stop sharing a Web browser Stopping Web browser sharing on page 192

control views of a shared Web browser Controlling views of shared software on 
page 201

annotate a shared Web browser Annotating Shared Software on page 209

let an attendee annotate a shared Web 
browser

Letting an attendee annotate shared software 
on page 213

let an attendee control a shared Web browser Letting an attendee remotely control shared 
software on page 218

learn how to share Web browsers effectively Tips for Sharing Software on page 221
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A presenter uses Web browser sharing to show all meeting attendees all Web pages 
that he or she accesses in a browser. Web browser sharing is useful for showing 
attendees Web pages on the Internet, or the presenter’s private intranet or 
computer.

Attendees can view the presenters Web browser, including mouse movements, in a 
sharing window on their screens.

Letting an attendee annotate shared software

Starting Web browser sharing

Host or Presenter only

You can share a Web browser with meeting attendees.

To share a Web browser:

1 On the Share menu, choose Web Browser.

Your default Web browser opens.

2 Go to a Web page in your browser.

Note Attendees can view any new Web browser windows that you open. Thus, 
attendees can view several Web pages simultaneously.

Letting an attendee annotate shared software

Stopping Web browser sharing

You can stop sharing a Web browser at any time.

To stop Web browser sharing:

1 Do either of the following:

■ On the title bar of the browser that you are sharing, click the Sharing menu.

■ In the lower-right corner of your computer's desktop, click the Sharing 
menu.

2 On the menu that appears, choose Exit Web Browser Sharing.
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Tip You can temporarily pause Web browser sharing, rather than stopping Web 
browser sharing. For details, see Pausing and resuming software sharing on page 202.

Sharing a remote computer

A presenter uses remote computer sharing to show all meeting attendees a remote 
computer. Depending on how set up the remote computer is set up, the presenter 
can show the entire desktop or just specific applications. Remote computer sharing 
is useful to show attendees an application or file that is available only on a remote 
computer.

Attendees can view the remote computer, including all the presenter’s mouse 
movements, in a sharing window on their screens.

As presenter, you can share a remote computer during a meeting if:

■ You have installed the Access Anywhere Agent on the remote computer

■ You logged in to your Meeting Center Web site before joining the meeting, if 
you are not the original meeting host

For information about setting up a computer for remote access, refer to the Access 
Anywhere User’s Guide.

Starting remote computer sharing

Host or Presenter only

If you have already set up a computer for Access Anywhere, you can share the 
computer during a meeting.

To share a remote computer:

1 On the Share menu, choose Remote Computer.

The Access Anywhere dialog box appears.

If you want to... See...

start sharing a remote computer Starting remote computer sharing on 
page 193

stop sharing a remote computer Stopping remote computer sharing on 
page 195

control views of a shared remote computer Controlling views of shared software on 
page 201

manage settings on a remote computer while 
sharing it

Managing a shared remote computer on 
page 196
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2 Under Remote Computers, select the computer that you want to share.

3 Under Applications, select an application that want to share.

If you set up the remote computer so you can access its entire desktop, the 
option Desktop appears under Applications.

4 Click Connect.

Depending on the method of authentication that you specified when setting up 
the computer for Access Anywhere, one of the following occurs:

■ If you chose access code authentication, a dialog box appears, in which you 
must provide the access code that you specified when setting up the remote 
computer.

■ If you chose phone authentication, you receive a phone call at the number 
that you specified when setting up the remote computer.

5 Do one of the following:

■ If you chose access code authentication, type your access code in the box, and 
then click OK.

■ If you chose phone authentication, provide your pass code by following the 
voice instructions.

Note

■ If you are not the original meeting host, you must log in to your Meeting Center 
Web site before joining a meeting in which you want to share a remote 
computer. If you are already in a meeting, but did not log in to your site, you 
must leave the meeting, log in to your site, and then rejoin the meeting.

■ If a password-protected screen saver is running on the remote computer, your 
meeting service automatically closes it once you provide your access code or pass 
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code.

■ If the remote computer is running Windows NT or 2000, and you must log in to 
the computer, send a Ctrl+Alt+Del command to the computer.

■ If you set up the remote computer so you can access multiple applications, you 
can share additional applications simultaneously.

Sharing additional applications on a shared remote computer

Host or Presenter only

While sharing a remote computer on which you have specified that you can access 
only specific applications rather than its entire desktop, you can share additional 
applications on the remote computer. Meeting attendees can view all shared 
applications simultaneously.

To share an additional application on a shared remote computer:

1 On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose Share Remote Application:

The Select Application dialog box appears.

2 In the list, select the remote application that you want to share.

3 Click OK.

Stopping remote computer sharing

Host or Presenter only
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You can stop sharing a remote computer during a meeting at any time. Once you 
stop sharing a remote computer, the Access Anywhere Server disconnects your local 
computer from the remote computer. The remote computer remains logged into 
the Access Anywhere Server, so you can access it again at any time.

Before you stop remote computer sharing:

To ensure your privacy and the security of your remote computer, do one of the 
following:

■ Close any applications that you started during the sharing session. 

■ If the remote computer is running Windows NT or 2000, and you have 
administrator rights on the computer, log off from or lock the computer. To 
access these options on the computer, send a Ctrl+Alt+Del key combination to 
the remote computer. For details, see Sending a Sending a Ctrl+Alt+Del 
command to a shared remote computer on page 200.

■ Specify a screen saver password, and set the screen saver to appear after short 
period of inactivity—for example, 1 minute.

■ Shut down the computer, if you do not plan to access it again remotely.

To stop remote computer sharing:

1 On the title bar of the Access Anywhere window, click the Access Anywhere 
menu.

2 Do one of the following

■ If you are sharing the remote computer’s entire desktop, choose Stop Remote 
Desktop Sharing.

■ If you are sharing an application on the remote computer, choose Stop 
Remote Application Sharing.

Managing a shared remote computer

Host or Presenter only

If you want to... See...

reduce the screen resolution on a shared 
remote computer so you can view its contents 
without scrolling

Reducing the screen resolution for a shared 
remote computer on page 197

adjust the size of the view of a shared remote 
computer, including zooming in to and out 
from the view and scaling the view to fit the 
sharing window

Adjusting the size of the view of a shared 
remote computer on page 198
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While sharing a remote computer during a meeting, you can manage the remote 
computer by setting options and sending commands.

Options that you can set:

■ Disable or enable the keyboard and mouse on the remote computer.

■ Reduce the screen resolution on the remote computer to match that of your 
computer, or restore the resolution on the remote computer.

■ Adjust the size of the view of the remote computer that appears in the sharing 
window, including zooming in to and out from the view and scaling the view to 
fit the sharing window

■ Hide or display the contents on the remote computer's screen at the remote 
location.

Note Any changes that you make to options affect the remote computer only 
during the current sharing session. The changes do not affect the default options 
that you set for the remote computer in the Access Anywhere Agent preferences.

Commands that you can send:

■ A Ctrl+Alt+Del key combination, which allows you to access options to log in 
to, log out from, lock, or unlock a Windows NT or 2000 computer.

■ A command to bring remote applications to the front of your screen, if they are 
either behind other applications or minimized.

Reducing the screen resolution for a shared remote computer

Host or Presenter only

lock a shared remote computer’s keyboard 
and mouse

Disabling and enabling the keyboard and 
mouse during on a shared remote computer 
on page 199

make the screen on a shared remote 
computer blank, so no one at the computer’s 
location can view it

Hiding the contents on a shared remote 
computer's screen on page 199

send a Ctrl+Alt+Del command to a Windows 
2000 or NT computer, to display the Windows 
Security dialog box

Sending a Ctrl+Alt+Del command to a shared 
remote computer on page 200

display an application window that is hidden 
behind another window on a shared remote 
computer

Bringing an application to the front on a 
shared remote computer on page 200

If you want to... See...
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While sharing a remote computer, you can reduce the screen resolution on the 
remote computer. This option helps to prevent the need to scroll while viewing the 
desktop or applications on the remote computer. The reduced screen resolution 
also appears in all attendees' sharing windows. You can return a remote computer's 
screen resolution to its original setting at any time during a remote access session.

To reduce the screen resolution on a remote computer:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose Remote Computer > Reduce Screen Resolution to Match This Computer.

A check mark next to the command indicates that the screen resolution is reduced. 
If no check mark appears, the screen resolution is at its original setting.

Note

■ If you reduce the screen resolution a remote computer during a sharing session, 
the Access Anywhere Agent restores the resolution to its original setting once 
you end the session.

■ You can specify whether or not the remote computer's screen resolution is 
reduced automatically once you connect to the computer remotely. For details, 
refer to the Access Anywhere User’s Guide.

Adjusting the size of the view of a shared remote computer

Host or Presenter only

While sharing a remote computer, you can adjust the size of the shared view by 
doing any of the following:

■ Select a preset percentage at which to view the remote computer.

■ Zoom in to and out from the remote computer in increments.

■ Scale the remote computer view to fit the sharing window in which it appears.

To adjust the size of the view of a shared remote computer:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose View, and then choose a display option.
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Disabling and enabling the keyboard and mouse during on a 
shared remote computer

Host or Presenter only

While sharing a remote computer, you can disable the keyboard and mouse on the 
remote computer, thereby preventing anyone from using the computer while you 
are accessing it remotely. You can re-enable a remote computer's keyboard and 
mouse at any time.

To disable or enable a remote computer's keyboard and mouse: 

On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose Remote Computer > Disable Keyboard and Mouse.

A check mark next to the command indicates that the keyboard and mouse are 
disabled. If no check mark appears, the keyboard and mouse are enabled.

Note

■ If you disable a remote computer's keyboard and mouse during a sharing 
session, the Access Anywhere Agent re-enables them once you end the session.

■ You can specify whether or not the remote computer's keyboard and mouse are 
disabled automatically once you connect to the computer remotely. For details, 
refer to the Access Anywhere User’s Guide.

Hiding the contents on a shared remote computer's screen

Host or Presenter only

While sharing a remote computer, you can make a remote computer's screen blank, 
thereby preventing anyone at the remote computer's location from viewing the 
contents of the screen. If the contents on a remote computer's screen are hidden, 
you can display them at any time.
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To hide or display the contents on a remote computer's screen:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose Remote Computer > Make Screen Blank.

A check mark next to the command indicates that the contents on the remote 
computer's screen are not visible. If no check mark appears, the contents on the 
remote computer's screen are visible.

Note

■ If you make a remote computer's screen blank during a sharing session, the 
Access Anywhere Agent displays the contents on the screen once you end the 
session.

■ You can specify whether or not a remote computer's screen becomes blank 
automatically once you connect to the computer remotely. For details, refer to 
the Access Anywhere User’s Guide.

Sending a Ctrl+Alt+Del command to a shared remote computer

Host or Presenter only

While sharing a remote computer that is running Windows NT or 2000, you can 
send an Ctrl+Alt+Del command to the computer to access options that let you:

■ Log in to the computer

■ Log out from the computer

■ Lock the computer

■ Unlock the computer

To send a Ctrl+Alt+Del command to a shared remote computer:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose Remote Computer > Send Ctrl+Alt+Del.

Bringing an application to the front on a shared remote computer

Host or Presenter only

While sharing a remote computer, you can restore a remote application that is 
minimized, or display a remote application that is behind another window that you 
cannot control. This option is available only if you set up a remote computer so you 
can access specific applications rather than the entire desktop.

To bring a remote application to the front:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, 
choose Remote Computer > Bring Shared Application to Front.
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The application that you are accessing remotely appears in the Access Anywhere 
window.

Controlling views of shared software

The presenter can control attendees’s views of the following types of shared 
software:

■ Applications

■ Desktop

■ Web browser

■ Remote computer

Attendees can manipulate their individual displays of the shared software. 

Role Task description:

Host or 
Presenter

■ Pause or resume 
sharing More...

■ Control 
full-screen view 
of shared 
software More...

■ Synchronize 
views More...

■ Return to the 
Meeting window 
More...

■ Return 
attendees to the 
software sharing 
window More...

Participant ■ Control your 
view of shared 
software More...

■ Switch views 
between the 
sharing window 
and the Meeting 
window More...

■ Close your 
sharing window 
More...
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Pausing and resuming software sharing

Host or Presenter only

While sharing software, you can temporarily pause sharing to freeze attendees' 
views of the following types of shared software:

■ Application

■ Desktop

■ Web browser

If you want to return attendees to the Meeting window while sharing software, 
pausing shared software conserves resources on your computer and bandwidth for 
your Internet connection. This option is also useful if you do not want attendees to 
see certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

To pause software sharing:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.

2 On the menu that appears, choose Pause Sharing.

The Sharing menu on the title bar of shared windows indicates that sharing is 
paused.

To resume software sharing:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.
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2 On the menu that appears, choose Resume Sharing.

Controlling full-screen view of shared software

Host or Presenter only

You can switch attendees' views of the following types of shared software between a 
standard window and a full-screen view:

■ Application

■ Desktop

■ Web browser

■ Remote computer

A full-screen view of shared software fits attendees' entire screens and does not 
include a title bar or scroll bars.

Attendees can override your setting to control full-screen view or to zoom in or out 
on the shared software on their computers. 

To display shared software in a full-screen view:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

If you are sharing a remote computer, the Access Anywhere menu appears 
instead of the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.

2 On the menu that appears, choose Views > Show Full-Screen View for 
Attendees.

To display shared software in a standard window:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.
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If you are sharing a remote computer, the Access Anywhere menu appears 
instead of the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.

2 On the menu that appears, choose Views > Restore View for Attendees.

Synchronizing views of shared software

Host or Presenter only

While sharing the following types of software, you can synchronize all attendees’ 
views of the software with your view:

■ Application

■ Desktop

■ Web browser

Synchronizing views of shared software ensures that the sharing window appears as 
the active window on attendees’ screens. For example, if an attendee has minimized 
the sharing window, or moved another window on top of it, the sharing window 
becomes the active window when you synchronize views.

Note Synchronizing views has no effect on the size in which the shared software 
appears on attendees’ screens. Attendees can control the size of their views 
independently.

To synchronize your view with attendees:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.
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2 On the menu that appears, choose View > Synchronize Views.

Controlling your view as an attendee

Attendee only

When viewing or remotely controlling shared software, you can specify the 
following options, which determine how shared software appears on your screen:

■ Display the shared software in a full-screen view or a standard window. A 
full-screen view of a shared application or desktop fits your entire screen and 
does not include a title bar or scroll bars. 

■ Scale, or resize, a shared desktop or application to fit the full-screen view or 
standard window in which it appears.

To control your view of shared software:

1 Do either of the following:

■ In the lower-right corner of your desktop, click the Sharing menu.

■ In the title bar of the sharing window, click the Sharing button.

2 On the menu that appears, choose View, then choose an option for viewing the 
shared software. 
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Tip To quickly switch between a standard window and a full-screen view of shared 
software, double-click the shared software.

Returning to the Meeting window while sharing software

When sharing the following types of software, you can return to the Meeting 
window at any time without stopping your sharing session:

■ Application

■ Web browser

■ Remote computer

You can quickly return to your sharing session at any time, without having to restart 
it.

When sharing your desktop, you can also return to the Meeting window; however, 
your desktop sharing session stops automatically. To return to desktop sharing, you 
must start desktop sharing again.

To display the Meeting window while sharing software:

On the floating icon tray, click the Return to Main Window icon.

If you are sharing your desktop, click the Exit and Return to Main Window icon.

Depending on your role, the following occurs:

■ If you are the host or presenter, your Meeting window is displayed on all 
attendees’ screens 

■ If you are an attendee, the Meeting window displays on your screen only; all 
other attendees’ views remain the same.

Closing your attendee sharing window

Attendee only

While viewing or remotely controlling shared software, you can close the sharing 
window in which the software appears at any time. Closing a sharing window 
returns you to the Meeting window. If you close a sharing window, you can reopen 
it at any time.
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To close a sharing window:

1 In the sharing window, click the Sharing button.

2 On the menu that appears, choose the appropriate option:

■ Exit Application Sharing

■ Exit Web Browser Sharing

■ Exit Desktop Sharing

■ Exit Remote Application Sharing

■ Exit Remote Desktop Sharing

The sharing window closes. The Meeting window then automatically opens.

To return to the sharing window at any time:

In the Meeting window, on the Sharing menu, click the appropriate sharing option:

■ Application

■ Desktop

■ Web Browser

■ Remote Computer

Returning attendees to the software sharing window

Host or Presenter only

If you are viewing the Meeting window while sharing one of the following types of 
shared software, you can return attendees to the sharing window at any time:

■ Application

■ Web browser

■ Remote computer

You cannot return to a desktop sharing session from the Meeting window. If you 
share your desktop and then return to the Meeting window, desktop sharing 
automatically stops. However, you can start sharing your desktop again. 

To display the software sharing window on attendees’ screens:

In the Meeting window, on the Share menu, do one of the following, as appropriate:

■ To return attendees to a shared application, choose the application.

■ To return attendees to a shared Web browser, choose Web browser.

■ To return attendees to a shared remote computer, choose Remote Computer.
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Switching your attendee view

Attendee only

While a presenter is sharing software, you can return to the Meeting window at any 
time. The sharing window remains open on your computer, so you can return to 
viewing the shared software at any time.

To return to the Meeting window while the presenter is sharing software:

On the floating icon tray, click the Return to Meeting window icon.

The Meeting window then appears.

To return to a sharing window:

Do either of the following:

■ In the Application Share dialog box, which appears in the Meeting window, click 
Return.

■ In the Meeting window, on the Sharing menu, click the appropriate sharing 
option:

Application

Desktop

Web Browser

Remote Computer
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Annotating Shared Software

You can annotate the following types of shared software during a meeting, using a 
highlighter or another annotation tool:

■ Application

■ Desktop

■ Web browser

All meeting participants can see annotations in their sharing windows. 

Starting and stopping annotation

Host or Presenter only

Role Task description:

Host or 
Presenter

■ Start or stop annotation 
mode More...

■ Use annotation tools 
More...

■ Remove or clear pointers 
More...

■ Change the annotation 
color More...

■ Let an attendee use 
annotation More...

■ Stop annotation for an 
attendee More...

■ Save annotations More...

Participant ■ Ask for permission to use 
annotation More...

■ Use annotation tools 
More...

■ Remove or clear pointers 
More...

■ Change the annotation 
color More...

■ Save annotations More...

■ Give up annotations 
More...
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When you are sharing any of the following types of software, you can make 
annotations on the software. 

■ Application

■ Desktop

■ Web browser

Attendees can see all your annotations.

To start annotating shared software:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.

2 On the menu that appears, choose Start Annotation.

The Tools panel appears.

The Annotating menu also appears on your screen.

3 Select a tool for making annotations.

4 For details about annotation tools, see Using annotation tools on page 211.

Note

■ You can let one or more attendees annotate the shared software. For details, see 
Letting an attendee annotate shared software on page 213.

■ Once you or an attendee makes annotations, you can save an image of the 
software, including the annotations. Fore details, see Taking a screen capture of 
annotations on shared software on page 216.
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To stop making annotations on shared software and return your mouse to a normal 
pointer, you must stop annotation mode. 

To stop annotation mode:

1 Click the Annotating menu.

2 On the menu that appears, choose Stop Annotation.

Using annotation tools

If, while sharing software, you are the presenter or the presenter grants annotation 
control to you, you can use the Annotation panel that appears to make annotations. 
The Annotation panel provides a variety of tools for annotating a shared desktop or 
application.

Tool Description

Pointer Lets you point out text and graphics on shared software. The pointer 
displays an arrow with your name and annotation color. To display the 
laser pointer, which lets you point out text and graphics on shared content 
using a red “laser beam,” click the downward-pointing arrow. Clicking this 
button again turns off the pointer tool.

Text Lets you type text on shared content. Participants can view the text once 
you finish typing it and click your mouse in the content viewer, outside the 
text box.

Line Lets you draw lines and arrows on shared software. For more options, 
click the downward-pointing arrow. Clicking this button again closes the 
Line tool.

Rectangle Lets you draw shapes, such as rectangles and ellipses on shared 
software. For more options, click the downward-pointing arrow. Clicking 
this button again closes the Rectangle tool.

Highlighter Lets you highlight text and other elements in shared software. For more 
options, click the downward-pointing arrow. Clicking this button again 
closes the Highlighter tool.

Pointer tool

Text tool

Line tool

Rectangle tool Annotation Color

EraserHighlighter tool Screen Capture
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Clearing annotations and pointers on shared software

To clear annotations or pointers:

1 On the Tools panel, click the downward-pointing arrow to the right of the 
Eraser button.

2 Choose an option to clear annotations or pointers.

To clear specific annotations:

1 On the Tools panel, click the Eraser button.

Your mouse pointer changes to an eraser.

2 On the shared software, click the annotations that you want to clear.

Annotation 
Color

Displays the Annotation Color palette, on which you can select a color to 
annotate shared software. Clicking this button again closes the 
Annotation Color palette. 

Note The annotation color that you choose does not affect the color for 
your pointer.

Eraser Erases text and annotations or clears pointers on shared software. To 
erase a single annotation, click it on the shared software. For more 
options, click the downward-pointing arrow. Clicking this button again 
turns off the eraser tool.

Screen Capture Saves an image of the shared software, including annotations, to a 
WebEx Universal Communications Format (.ucf) file, which you can 
open on your computer or the content viewer in a meeting.

Tool Description

If you are the presenter, you can clear If you are an attendee, you can clear

all annotations made by participants annotations made by you

just annotations you have made pointers added by you

all pointers added by participants

just your own pointers
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To turn off the eraser tool:

On the Tools panel, click the Eraser Tool button.

Selecting a color for annotating shared software

If you are annotating shared software, you can select a different color for making 
annotations.

To select a color for annotating shared software:

1 On the Tools panel, click the downward-pointing arrow to the right of the 
Annotation Color button.

The Annotation Color palette appears.

2 Click the color that you want to use.

Note Once you join a meeting, you receive a default annotation color, which 
appears to the right of your name on the Participants tab.

Letting an attendee annotate shared software

Host or Presenter only

You can let one or more meeting attendees annotate the following types of shared 
software:

■ Application

■ Desktop

■ Web browser

You can let multiple attendees annotate shared software simultaneously.

To grant annotation control to an attendee, you must start annotation mode. For 
details, see Starting and stopping annotation on page 209.

To let an attendee annotate shared software:

1 Click the Annotating menu.

2 On the menu that appears, do one of the following:
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■ To let only specific attendees annotate shared software, choose Allow to 
Annotate > [name of the attendee]. To let another attendee also annotate the 
software simultaneously, repeat this step.

■ To let all attendees annotate the software simultaneously, choose Allow to 
Annotate > All Attendees.

Note

■ If an attendee is remotely controlling shared software, the attendee cannot 
annotate it until you start annotation mode.

■ You can stop an attendee from annotating shared software at any time. For 
details, see Stopping an attendee from annotating shared software on page 215.

■ If an attendee requests to annotate shared software, a request message appears 
next to your mouse pointer. On the Allow to Annotate menu, the name of the 
attendee who requested annotation appears on an orange background.

Requesting annotation control of shared software

Attendee only

If a presenter is sharing the following types of shared software, you can ask the 
presenter to grant annotation control to you:

■ Application

■ Desktop

■ Web browser

Once you have annotation control, you can:

■ Make annotations by highlighting areas on the software, drawing lines and 
shapes, typing text, and using pointers.

■ Clear annotations at any time.

■ Change the color that you are using to make annotations.

■ Save an image of your annotations on the shared software.

To request annotation control of shared software:

1 In the title bar of the sharing window, click the Sharing button.

2 On the menu that appears, choose Request Annotation. 

A request message appears on the presenter's screen.
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Once the presenter grants annotation control to you, the Annotation panel 
appears:

Your mouse pointer becomes a highlighter tool. 

3 To make annotations, drag your mouse.

4 Optional: Choose another annotation tool. For details, see Using annotation 
tools on page 211.

Note If you are remotely controlling shared software, the presenter must reassume 
control, and then turn on annotation mode. You and the presenter can then 
annotate the shared software simultaneously.

Giving up annotation control

Attendee only

If the presenter has granted annotation control to you, you can stop making 
annotations at any time.

To stop making annotations:

1 In the sharing window, click the Sharing button.

2 On the menu that appears, choose Give up Annotation.

Stopping an attendee from annotating shared software

Host or Presenter only

If a meeting attendee is annotating shared software, you can stop the attendee from 
making annotations. 

To stop an attendee annotating shared software:

1 Click the Annotating menu.
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2 On the menu that appears, choose Allow to Annotate. &&&?

On the menu that appears, a check mark appears next to the name of any 
attendee who can annotate the shared software.

3 Choose the name of the attendee to cancel the selection.

Taking a screen capture of annotations on shared software

If you make annotations on shared software, you can save an image of the shared 
software, including all annotations and pointers, to a WebEx Universal 
Communications Format (.ucf) file. You can open a .ucf file on your computer 
desktop or in the content viewer in a meeting.

To take a screen capture of annotations on shared software:

1 On the Tools panel, click Screen Capture button.

The Save As dialog box appears.

2 Choose a location at which to save the file, and then click Save.

Note The file you save is an image of your entire desktop.

Granting attendees control of shared software

If you want to... See...

Ask to control the software Requesting remote control of shared software 
on page 217

Grant an attendee control of the software Letting an attendee remotely control shared 
software on page 218

Automatically grant attendees control of the 
software

Automatically letting attendees remotely 
control shared software on page 218

Stop an attendee from controlling the software Stopping remote control of shared software on 
page 219
216



Chapter 15: Sharing Software
While sharing the following types of software, the presenter can let an attendee 
control it remotely:

■ Application

■ Desktop

■ Web browser

An attendee who has remote control of shared software can interact with it 
completely. While an attendee is remotely controlling shared software, the 
presenter’s mouse pointer is inactive. At any time, however, the presenter can take 
back control of a shared application and regain the use of his or her mouse pointer.

Any attendee can send a request to control the software remotely. The presenter can 
then grant control to the attendee. Alternatively, the presenter can automatically 
grant control of shared software to any attendee who requests remote control.

The presenter can stop an attendee from remotely controlling shared software at 
any time.

Caution An attendee who has remote control of the presenter’s desktop can run 
any programs and access any files on the computer that the presenter has not 
protected with a password.

Requesting remote control of shared software

If the presenter is sharing the following types of software, you can ask the presenter 
to grant remote control to you:

■ Application

■ Desktop

■ Web browser

Once you assume remote control of shared software, you can interact with it 
completely.

To request remote control of shared software:

1 In the sharing window, click the Sharing button.

2 On the menu that appears, choose Request Remote Control. 

A remote-control request message appears on the presenter's screen.
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Tip While remotely controlling shared software, you can request the presenter to 
allow you to annotate it. For details, see “Requesting annotation control of shared 
software” on page 214.

Letting an attendee remotely control shared software

Host or Presenter only

If you are sharing software, you can let an attendee control it remotely.

To let an attendee remotely control shared software:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.

2 On the menu that appears, choose Allow to Control Remotely > [name of 
attendee].

Automatically letting attendees remotely control shared 
software

Host or Presenter only

While sharing software, you can automatically grant control of the software to an 
attendee who requests control. In this case, an attendee who requests remote 
control automatically takes control of the software that you are sharing. While 
automatic remote control is turned on, any attendee can take control away from 
any other attendee by requesting remote control.

To automatically let attendees control shared software:

1 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.
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2 On the menu that appears, choose Accept Control Requests Automatically.

To stop letting attendees control shared software automatically:

1 Do either of the following:

■ On the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your computer’s desktop, click the Sharing 
menu.

2 On the menu that appears, choose to Accept Control Requests Automatically to 
cancel the selection.

Stopping remote control of shared software

Host or Presenter only

While an attendee is remotely controlling a shared application, desktop, or Web 
browser, you can take back control of the shared software at any time. You can do 
either of the following:

■ Take back remote control of shared software temporarily, allowing an attendee 
to take control at any time. 

■ Prevent an attendee from further controlling shared software.

To take back control a shared software temporarily:

On your computer's desktop, click your mouse. 

You can now control the shared software.

The attendee who was controlling the shared software can take back control at any 
time by clicking his or her mouse.

To prevent an attendee from further controlling a shared software:

1 On your computer's desktop, click your mouse. 

You can now control the shared software.

2 Do either of the following:

■ In the title bar of a window that you are sharing, click the Sharing menu.

■ In the lower-right corner of your desktop, click the Sharing menu.
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3 On the menu that appears, choose Allow to Control Remotely.

A menu appears, containing a list of all attendees in the meeting. A check mark 
appears to the left of the attendee who has remote control.

4 Choose the attendee's name to cancel the selection.

Sharing applications with detailed color
By default, Meeting Manager sends images of shared software using 16-bit color 
mode, which is the equivalent of your computer’s “High Color” (16-bit) setting. 
This mode provides an accurate representation of color for most shared 
applications. However, if your shared application contains detailed color images—
such as color gradients—the color may not appear accurately on participants’ 
screens. For example, color gradients may appear and color “bands.”

If the accuracy and resolution of color in a shared application is important, you can 
turn on True Color mode in Meeting Manager. Using this mode, however, may 
affect the performance of application sharing.

When using True Color mode, you can select one of the following options:

■ Better imaging (no image compression)

■ Better performance (some image compression)

“Performance” refers to the “speed” at which images appear on attendees’ screens, 
and “imaging” refers to the quality of the color in shared images.

Note Before turning on True Color mode, ensure that your monitor display is set 
to True Color (either 24- or 32-bit color). For more information about setting 
options for your monitor, refer to Windows Help.

To turn on True Color mode:

1 If you are currently sharing an application, stop your sharing session.

2 On the Meeting menu, choose MeetingOptions.

The Meeting Options dialog box appears.

3 Click the True Color Mode tab.

4 Select Enable True Color mode.

5 Select one of the following options:
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■ Better imaging

■ Better performance

6 Click OK or Apply.

Tips for Sharing Software
The following tips can help you to share software more effectively:

■ Application sharing only: To save time during a meeting, ensure that any 
applications you intend to share are open on your computer. At the appropriate 
time during the meeting, you can then quickly begin sharing an application, 
without waiting for the application to start.

■ If attendees cannot see all of the shared software without scrolling their sharing 
windows, they can adjust their views of the shared software. They can reduce the 
size of the shared software in decrements, or scale it to fit inside their sharing 
windows. For details, see Returning to the Meeting window while sharing software 
on page 206.

■ To improve the performance of software sharing, close all applications that you 
do not need to use or share on your computer. Doing so conserves processor 
usage and memory on your computer, thus helping to ensure that Meeting 
Manager can send images of shared software quickly during a meeting. Also, to 
ensure that a maximum amount of bandwidth is available for software sharing, 
close any applications that use bandwidth, such as instant messaging or chat 
programs, and programs that receive streaming audio or video from the Web.

■ If you are sharing an application for which the rendering of color on 
participants’ screen is important, you can improve color quality by turning on 
True Color mode. For details, see Sharing applications with detailed color on 
page 220.

■ Application and Web browser sharing only: Avoid covering a shared application 
or Web browser with another window on your computer's desktop. A 
crosshatched pattern appears in attendees’ sharing windows where the other 
window is covering the shared application or browser.

■ Application and Web browser sharing only: If you want to switch your display 
between shared software and the Meeting window, you can pause software 
sharing before you return to the Meeting window, and then resume sharing once 
you return to the shared application. Pausing software sharing conserves 
processor usage and memory on your computer while you view the Meeting 
window. For details, see Pausing and resuming software sharing on page 202.

■ Because software sharing requires additional bandwidth during a meeting, it is 
recommended that you use a dedicated, high-speed Internet connection when 
sharing software. However, if attendees are using dial-up Internet connections, 
they may notice a delay in viewing or controlling shared software. If you want to 
share a document, such as a Microsoft Word or Excel document, you can 
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improve the meeting experience for these attendees by using document sharing 
instead of application sharing.
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16
Using Chat

About using chat
You can send and receive chat messages to and from meeting participants. All chat 
messages that you send or receive appear on the Chat panel in the Meeting window.

Chat is useful if you want to:

■ Communicate with other participants during a meeting that does not include an 
audio conference

■ Send a private message to another participant

■ Send brief information to all participants or a specific group of participants

■ Ask a question but do not want to interrupt the presenter

Note During a meeting, the presenter can specify chat privileges for all participants. 
These privileges determine to whom participants can send chat messages.

If you want to ... See ...

get an overview of using chat About using chat on page 223

send chat messages Sending chat messages on page 224

assign sounds to incoming messages Assigning sounds to incoming chat messages 
on page 225

print chat messages Printing chat messages on page 226

save chat messages Saving chat messages on page 227

open a chat file during a meeting Opening a chat file during a meeting on 
page 228
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Sending chat messages
Depending on the chat privileges that the meeting host has granted to participants, 
you can send a chat message to:

■ Only the host

■ Only the presenter

■ Only the host and the presenter

■ All attendees at once, not including the meeting host, the panelists, and the 
presenter

■ All participants at once, including all attendees, the meeting host, the panelists, 
and the presenter

■ Another participant, privately

To send a chat message:

1 In the Meeting window, open the Chat panel.

2 Type a message in the chat box.

3 In the Send to drop-down list, select the recipients of the message.

4 Click Send.

The recipients receive the chat message on their Chat panels. The following 
figure shows an example.

chat box
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Note If you join a meeting in progress, you can see only the chat messages that 
attendees send after you join the meeting.

Assigning sounds to incoming chat messages
You can assign a sound to play when you receive a chat message. Specifically, you 
choose to play a sound for one of the following occasions:

■ if you are not viewing the Chat panel

■ for only the first chat message that you receive in a thread

■ whenever you receive a chat message

Meeting Manager saves your sound preferences on your computer. However, if you 
start or join a meeting on another computer, you must specify your preferences 
again.

To assign sounds to incoming chat messages:

1 Do either of the following:

■ On the Chat panel, right-click the Chat title bar, and then choose Sound 
Alerts.

■ In the Meeting window, on the Edit menu, choose Preferences.

The Preferences dialog box appears.

2 Click the Chat tab.

The Chat tab options appear.

3 Select Play the selected sound.
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4 In the drop-down list, choose the occasion for which you want to assign a sound.

5 Select a sound to play. You can do either of the following:

■ Select a sound in the Sound drop-down list.

This list contains the names of all sound files that reside at the default loca-
tion on your computer.

■ Click Browse, and then select a sound file that resides in another folder.

6 Optional. To play the currently selected sound, click the button.

7 Click OK.

Note

■ The default location on your computer for sound files is standard, and is based 
on your computer's operating system. On a computer running Windows, the 
default location is the Media folder.

■ You can copy other sound files of the appropriate types to the default location, 
or any other directory, to make them available in the Preferences dialog box.

■ On a computer running Windows, you can play any .wav file.

Printing chat messages
You can print all the chat messages that appear on the Chat panel.

To print chat messages:

1 In the Meeting window, on the File menu, choose Print > Chat.

A print dialog box appears.

2 Optional. Specify printer options.

3 Print.

Note If no chat messages appear on your Chat panel, this Chat option is 
unavailable.
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Saving chat messages

About saving chat messages

You can save chat messages that appear on the Chat panel to a .txt file. You can 
then reopen the file for use in any meeting or view the file's content outside a 
meeting by opening the file in a text editor.

Once you save chat messages to a file, you can save changes to the messages or save 
a copy of them to another file.

Saving chat messages

You can save chat messages you have sent or received to a new chat file. 

To save new chat messages:

1 In the Meeting window, on the File menu, choose Save> Chat.

The Save Chat As dialog box appears.

2 Choose a location at which you want to save the file.

3 Type a name for the file.

By default, the name of the previous chat file you saved displays. You can save all 
chat messages in your current meeting to this existing file, or save them to a new 
file.

4 Click Save.

Meeting Manager saves the chat messages in a .txt file at the location you 
selected.

Note If no chat messages appear on your Chat panel, this option is unavailable.

Saving changes to a chat file

If you make changes to the messages on your Chat panel, you can save them to an 
existing chat file.

If you want to ... See ...

get an overview of saving chat messages About saving chat messages on page 227

save new chat messages Saving chat messages on page 227

save changes to a chat file Saving changes to a chat file on page 227

save a copy of a chat file Creating a copy of previously saved chat 
messages on page 228
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To save changes to a chat file:

In the Meeting window, on the File menu, choose Save> Chat.

Meeting Manager saves the changes to the existing chat file.

Note If no chat messages appear on your Chat panel, this option is unavailable.

Creating a copy of previously saved chat messages

If you have saved chat messages and want to create another copy of the messages, 
you can do so by saving the chat messages to a chat file with a different name.

To create a copy of chat messages that have been previously saved:

1 In the Meeting window, on the File menu, choose Save As > Chat.

The Save Chat As dialog box appears.

2 Do either or both of the following:

■ Type a new name for the file.

■ Choose a new location at which you want to save the file.

3 Click Save.

Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.

Opening a chat file during a meeting
If you saved chat messages to a file, you can display those chat messages on your 
Chat panel by opening the file.

To open a chat file:

1 In the Meeting window, on the File menu, choose Open > Chat.

The Open Chat dialog box appears.

2 Select the chat file that you want to open.

Tip The names of chat files have a .txt extension.

3 Click Open.

The chat messages appear on the Chat panel.

If there are already chat messages in your chat viewer, Meeting Manager appends 
the messages from the chat file to the existing messages.
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Polling Attendees

About polling attendees
During a meeting, you can poll attendees by presenting them with a questionnaire. 
Conducting a poll can be useful for gathering feedback from attendees, allowing 
attendees to vote on a proposal, testing attendees’ knowledge of a topic, and so on.

To conduct a poll, you must first prepare a poll questionnaire. You prepare a 
questionnaire during a meeting. To save time during a meeting, you can prepare a 
questionnaire by starting the meeting earlier than the scheduled time, save it, and 
then open it during the actual meeting.

Once you close a poll, you can view the results and share them with attendees. You 
can also save the results of a poll for viewing outside a meeting.

Preparing a poll questionnaire

If you want to ... See ...

get an overview of polling attendees About polling attendees on page 231

prepare a poll questionnaire Preparing a poll questionnaire on page 231

take a poll during a meeting Opening a poll on page 235

view or share poll results during a meeting Viewing and sharing poll results on page 235

save or open your poll questionnaires and poll 
results

Saving and opening poll questionnaires and 
results on page 237

If you want to ... See ...

get an overview of preparing a poll 
questionnaire

About preparing a poll questionnaire on 
page 232
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About preparing a poll questionnaire

Presenter only

On the Polling panel, you can create a poll questionnaire that includes 
multiple-answer, single-answer, or text questions. You can also specify options for 
displaying a timer during polling and poll results. Once you complete a 
questionnaire, you can open the poll at any time during a meeting.

Creating poll questions and answers

Presenter only

You can create a questionnaire at any time after you start a meeting. The following 
figure shows a portion of the Polling panel, which offers the tools you use to 
compose a questionnaire.

To create a questionnaire:

1 Open the Polling panel.

For more information, see Working with panels on page 104.

2 In the Question section, select the type of question you want to create by doing 
one of the following:

■ To create a multiple-answer question, select Multiple choice, and then 
choose Multiple Answers in the drop-down list.

■ To create a single-answer question, select Multiple choice, and then choose 
Single Answer in the drop-down list.

■ To create a text question, select Short answer.

3 Click New.

compose a questionnaire Creating poll questions and answers on 
page 232

edit your poll questions or answers Editing a questionnaire on page 233

display a timer when a poll is in progress Displaying a timer during polling on page 234

If you want to ... See ...
232



Chapter 17: Polling Attendees
4 Type a question in the box that appears.

5 In the Answer section, click Add.

6 Type an answer in the box that appears.

7 To type another answer, click Add once you finish typing an answer.

The question and answers appear in the Poll Questions area.

8 To add questions, repeat steps 2 to 7.

The following figure shows an example of a poll questionnaire.

Tip While you are creating a poll questionnaire, Meeting Center automatically 
saves it every two minutes to the WebEx folder in the My Documents folder on your 
computer. If you ever lose your poll questionnaire, you can easily recover it in the 
designated folder.

Editing a questionnaire

Presenter only

You can change the type of a question and edit, rearrange, or delete the questions 
and answers. 

To change the type of a question:

1 Select the question by clicking it, and then select the new type of question in the 
Question section.

For more information about the different types of questions, see Creating poll 
questions and answers on page 232.

2 Click Change Type.
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To edit any question or answer that you typed:

1 Select the question or answer by clicking it, and then click the Edit icon.

2 Make your changes.

To delete a question or an answer:

Select the question or answer by clicking it, and then click the Delete icon.

To rearrange questions or answers:

Select the question or answer by clicking it, and then click the Move Up or Move 
Down icon, as appropriate.

To delete an entire questionnaire:

Click Clear All.

If you have not saved the questionnaire, a message box appears, asking whether you 
want to save it or not.

Displaying a timer during polling

Presenter only

You can specify that a timer displays for attendees and yourself when a poll is in 
progress.

To display a timer:

1 Click Options at the bottom of your Polling panel.

2 In the dialog box that appears, select Display, and then type the length of time 
in the Alarm: box.

3 Click OK.

the Edit icon

the Delete icon

the Move Up and Move 
Down icons
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Opening a poll
Presenter only

After you finish preparing a poll questionnaire, you can open the poll.

If you prepared your questionnaire in advance and saved it, you must first open it 
on the Polling panel. For details, see Opening a poll questionnaire file on page 239.

To open a poll:

1 Open the Polling panel.

2 Click Open Poll.

The questionnaire appears on attendees’ Polling panels. Attendees can now fill 
out the questionnaire.

As attendees answer the questions, you can watch the polling status on your 
Polling panel. The following figure shows an example.

3 Click Close Poll when the time is up.

If you specify a timer and the poll times out, the poll automatically closes.

Attendees can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with 
attendees. For details, see Viewing and sharing poll results on page 235.

Viewing and sharing poll results

Viewing poll results

Presenter only

To view each attendee’s 
polling status, click one of 
these three buttons.

If you want to ... See ...

view and understand poll results Viewing poll results on page 235

share poll results with attendees after you 
close a poll

Sharing poll results with attendees on 
page 236
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Once you close a poll, you can view the complete results of the poll and share them 
with attendees. 

The following figure shows an example of your Polling panel after you close a poll. 
The Results column indicates the percentage of attendees who chose each answer. 
The Bar Graph column provides a graphic representation of each percentage in the 
Results column.

Note Meeting Center bases the percentage for each answer on the total number of 
attendees in the meeting, not the total number of attendees who submitted answers 
in the poll.

Sharing poll results with attendees

Presenter only

After you close a poll, you can share the poll results with attendees.

To share the results of a poll:

In the Share with attendees section on your Polling panel, select Poll results, and 
then click Apply.

The results of the poll appear in the attendees’ Polling panels, just as they appear on 
your Polling panel.
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Saving and opening poll questionnaires and results

Saving a poll questionnaire

Presenter only

Once you create a poll questionnaire, you can save it as an .atp file. You can open 
the file for use in any meeting. For more information about preparing a poll 
questionnaire, see Creating poll questions and answers on page 232.

If you make changes to a poll questionnaire after you save it, you can either save the 
changes to the same file or save a copy of the questionnaire to another file.

To save a new poll questionnaire:

1 On the File menu, choose Save > Poll Questions.

The Save Poll Questions As dialog box appears.

2 Choose a location at which to save the file.

3 Type a name for the file.

4 Click Save.

Meeting Manager saves the poll questionnaire to a file at the location you 
specified. Poll questionnaire file names have an .atp extension.

To save changes to a poll questionnaire that you previously saved:

On the File menu, choose Save > Poll Questions.

Meeting Manager saves the changes to the existing poll questionnaire file.

To save a copy of a poll questionnaire:

1 On the File menu, choose Save As > Poll Questions.

The Save Poll Questions As dialog box appears.

2 Do either or both of the following:

■ Type a new name for the file.

■ Choose a new location at which to save the file.

3 Click Save.

If you want to ... See ...

save a poll questionnaire to a file Saving a poll questionnaire on page 237

save poll results to a file Saving poll results on page 238

open a poll questionnaire during a meeting Opening a poll questionnaire file on page 239

open poll results on your computer Opening a poll results file on page 239
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Meeting Manager saves the poll questionnaire to a file at the location you 
specified. The names of poll questionnaire files have an .atp extension.

Saving poll results

Presenter only

If you conduct a poll and then share its results, you can save the results to a text, or 
.txt, file.

Once you save poll results to a file, you can save changes to the poll results or save 
a copy of the results to another file.

Tip Meeting Center automatically saves poll results every two minutes to the 
WebEx folder in the My Documents folder on your computer. If you ever lose your 
poll results, you can easily recover them in the designated folder. Meeting Center 
saves both group and individual results.

To save new poll results:

1 Close the poll if you have not done so.

2 On the File menu, choose Save > Poll Results.

The Save Poll Results As dialog box appears.

3 Choose a location at which to save the file.

4 Type a name for the file.

5 Click Save.

Meeting Manager saves the poll results to a file at the location you specified. The 
names of poll results files have a .txt extension.

To save changes to poll results that you previously saved:

On the File menu, choose Save > Poll Results.

Meeting Manager saves the changes to the existing poll results file.

To save a copy of a poll results:

1 On the File menu, choose Save As > Poll Results.

The Save Poll Results As dialog box appears.

2 Do either or both of the following:

■ Type a new name for the file.

■ Choose a new location at which to save the file.

3 Click Save.
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Meeting Manager saves the poll results to a file at the location you specified. The 
names of poll results files have a .txt extension.

Opening a poll questionnaire file

Presenter only

If you saved a poll questionnaire to a file, you can display the questionnaire during 
a meeting by opening the file.

Note You can open a poll questionnaire file, which has an .atp extension, only 
when a meeting is in progress.

To open a poll questionnaire file:

1 On the File menu, choose Open > Poll Questions.

The Open Poll Questions dialog box appears.

2 Select the poll questionnaire file that you want to open.

Note The names of poll questionnaire files have an .atp extension.

3 Click Open.

The poll questionnaire appears on your Polling panel. You can now open the 
poll to meeting attendees.

Opening a poll results file

Presenter only

If you saved poll results to a file, you can open the file on your computer.

To open a poll results file on your computer:

Double-click the saved file, which has a .txt extension.

The poll results file opens in your default text editor.

For each question, the poll results show the number and percentage of attendees 
who chose each answer and the total number of attendees in the meeting.

The following figure shows an example of poll results in the text format.
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Transferring and Downloading 
Files During a Meeting

About transferring and downloading files during a 
meeting

During a meeting, you can publish files that reside on your computer. Meeting 
attendees can then download the published files to their computers or local servers. 
Publishing files is useful if you want to provide attendees with a document, a copy 
of your presentation, an application, and so on. 

Files that you publish reside only on your computer—not on a server. Thus, your 
published files are always protected from unauthorized access during a meeting.

Publishing files during a meeting

During a meeting, you can publish files that reside on your computer, and meeting 
attendees can download the files to their computers or local servers.

To publish files during a meeting:

1 In the Session window, on the File menu, choose Transfer.

If you want to... See...

get an overview of transferring and 
downloading files during a meeting

About transferring and downloading files 
during a meeting on page 241

publish files during a meeting Publishing files during a meeting on page 241

download files during a meeting Downloading Files During a Meeting on 
page 242
241



Chapter 18: Transferring and Downloading Files During a Meeting
The File Transfer window appears.

2 Click Share File.

The Open dialog box appears.

3 Select the file that you want to publish.

4 Click Open.

The file appears in the File Transfer window.

The file is also now available in each attendee’s File Transfer window.

5 Optional. Publish additional files that you want attendees to download.

Note The number of attendee Meeting windows in which the File Transfer 
window is open, including your own, appears in the lower-right corner of the 
File Transfer window.

To stop publishing files during a meeting:

In the title bar of the File Transfer window, click the Close button.

Meeting Manager closes the File Transfer window in each attendee’s Session 
window.

Downloading Files During a Meeting

If a presenter publishes files during a meeting, the File Transfer dialog box 
automatically appears in your Meeting window. You can then download the 
published files to your computer or a local server.

To download files during a meeting:

1 In the File Transfer window, select the file that you want to download.
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2 Click Download.

The Save As dialog box appears.

3 Choose a location at which to save the file.

4 Click Save.

The file downloads to your selected location.

5 If applicable, download additional files.

6 Once you finish downloading files, in the title bar of the File Transfer window, 
click the Close button.

Note To reopen the File Transfer window at any time, from the File menu, choose 
Transfer. This option is available only if the presenter is currently publishing files.
243



Chapter 18: Transferring and Downloading Files During a Meeting
244



19
Managing and Taking Notes

When scheduling a meeting, the host can specify the default note-taking options 

that take effect once the meeting starts. During a meeting, the presenter can change 
the default note-taking options at any time. 

You can choose how to handle meeting notes:

■ All participants with access can take private notes.

■ Only one participant takes notes or meeting minutes.

Note The notes feature is not available on the Mac.

■ Only one participant performs closed captioning.

Role Task description:

Host If the Notes panel is 
closed, click Panels and 
then select Notes.

■ set up options for 
taking notes in a 
meeting More...

■ select a participant as 
closed captionist 
More...

■ choose one person to 
take notes More...
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Specifying note-taking options for a meeting

During a meeting, you can turn the notes option on or off and specify one of these 
options:

■ All participants with access to notes can take private notes.

■ Only one participant can take notes.

■ Only one participant can perform closed captioning.

To specify note-taking options:

1 In the Meeting window, on the Meeting menu, choose Options.

The Meeting Options dialog box appears, with the Options tab selected by 
default.

2 Select the note-taking option you want.

■ To turn the notes option on or off, select or clear the Notes check box.

■ To turn the closed captioning option on or off, select or clear the Enable 
Closed Captioning check box.

3 Click OK.

Note

■ Once you change the notes option, any published notes or closed captions are 
removed from each participant’s Notes or Closed Caption panel. Be sure to ask 

Note taker The host can select one 
person to take notes or 
allow all participants to 
take notes

■ get an overview of 
taking notes More...

■ take personal notes 
during a meeting 
More...

■ provide closed 
captions for a 
meeting More...

■ saving notes to a file 
Select a participant 
as closed captionist 
More...

Role Task description:
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participants to save notes or closed captions before you change the notes option.

■ When scheduling a meeting, the meeting host can specify the default note-taking 
options, which take effect once the meeting starts.

Choosing a note taker

If the single note taker or closed captions option is set for a meeting, you can 
designate any participant to be the note taker or closed captionist, respectively. 
When scheduling a meeting, you can set the notes option, or a presenter can set the 
notes option during a meeting. 

To designate a note taker:

1 In the Meeting window, in the participant list, select the participant you want to 
designate as note taker.

2 On the Participants panel, right-click and point to Make. Then choose Note 
Taker.

A pencil indicator appears to the left of the participant's name in the participant 
list.

To designate a closed captionist:

1 In the Meeting window, in the participant list, select the participant you want to 
designate as closed captionist.

2 On the Participant panel, right-click and point to Make. Then choose Closed 
Captionist.

A closed caption indicator appears to the left of the participant's name in the 
participant list. 

Note

■ If you select another note taker or closed captionist, any notes or closed captions 
that the previous note taker or closed captionist published remain on each 
participant's Notes panel or Closed Caption panel, respectively. However, the 
new note taker or closed captionist cannot edit the exiting notes or closed 

Closed Captionist indicator
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captions.

■ For information about selecting a note-taking option during a meeting, see 
Specifying note-taking options for a meeting on page 246. 

Enabling the closed captions

You can easily select the option for closed captions and appoint a participant to 
transcribe the closed captions.

To specify the closed caption option:

1 In the Meeting window, on the Meeting menu, choose Options.

The Meeting Options dialog box appears, with the General tab selected by 
default.

2 To turn the closed caption option on or off, select or clear the Enable closed 
captioning check box, respectively.

To display the Closed Captions panel:

1 Click Panels.

This button is located in the upper right corner of the Meeting window.

2 From the Select Panel drop-down list, choose Closed Captions.

The Closed Captions panel displays. 

The host is selected by default as closed captionist. This icon appears in the Tools 
column next to the host’s name:

To select another participant to transcribe, right-click that participant’s name on 
the participant list. Then click Make > Closed Captionist.

About taking notes
During a meeting, one or more meeting participants with access to the notes feature 
can take notes on the Notes or Closed Caption panel in the Meeting window. Only 
one participant performs closed captioning.

If all participants with access take notes, they cannot publish their notes to others 
during the meeting. However, participants can save their notes at any time during 
the meeting.
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The meeting host can select the single note taker during the meeting. A single note 
taker can publish notes at any time during the meeting or send a meeting transcript 
containing the notes to all participants. If needed, the host can also select a closed 
captionist. A closed captionist can publish captions in real-time during the meeting 
and can also send a transcript containing the captions to all participants.

Note The notes feature is not available on the Mac.

Taking personal notes

If the meeting host or presenter has selected the option to allow participants to take 
personal notes, you can type your notes on the Notes panel in the Meeting window. 

To take personal notes: 

1 In the Meeting window, open the Notes panel.

For details about using the panels, see Working with panels on page 104.

2 Type your notes in the box.

Note You can save your notes to a text file on your computer. For details, see Saving 
notes to a file on page 251.

Taking public notes (meeting minutes)

If the meeting host has designated you as the single note taker for a meeting, you 
can type notes on the Notes panel in your Meeting window. Your notes are not 
visible to other meeting participants until you publish them. You can publish your 
notes at any time during the meeting, or you can send your notes in a meeting 
transcript to all participants.

To take public notes:

1 In the Meeting window, open the Notes panel.

2 Type your notes in the box.

3 Optional. To publish your notes, so they appear in each participant's Notes 
panel, click Publish.
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Note f the Notes panel is not selected on a participant's Meeting window once you 
publish notes, the participant is sees an alert. 
For information about selecting a note-taking option during a meeting, see 
Specifying note-taking options for a meeting on page 246.
For details about sending public notes in a meeting transcript, see Sending a meeting 
transcript to participants on page 252.

Providing closed captions

If the meeting host has designated you as the closed captionist for a meeting, you 
can type captions on the Closed Captions panel in your Meeting window. To type 
captions, you can use either a standard keyboard, or a steno keyboard and machine 
translation software.

Your captions are visible to other meeting participants in real-time, one line at a 
time. You can also send your captions in a meeting transcript to all participants.

To transcribe closed captions:

1 Open the Closed Caption panel.

Click Panels in the upper-right corner of the Meeting window. Select Closed 
Captions on the drop-down menu.

2 Type your captions in the box.

3 Once you type a line of captions, do either to publish your captions on each 
participant's Closed Caption panel:

■ Press the Enter key on your computer's keyboard.

■ Click Publish on the Closed Caption panel.

Note

■ If the Closed Captions panel is not selected on a participant's Meeting window 
once you publish a line of captions, the participant is alerted that captions are 
available.

■ You can save your captions to a text file on your computer. For details, see Saving 
notes to a file on page 251.

■ For details about sending closed captions in a meeting transcript, see Sending a 
meeting transcript to participants on page 252.
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Saving notes to a file
If you are taking personal or public notes (meeting minutes) or closed captions 
during a meeting you can save your notes to a text file on your computer. You can 
also save any notes or closed captions that another note taker or closed captionist 
publishes on your Notes or Closed Captionpanel.

Once you save new notes to a file, you can save changes to the notes or save a copy 
of the notes to another file. 

To save new notes:

1 In the Meeting window, do either:

■ On the Notes panel or Closed Caption panel, click Save.

■ On the File menu, point to Save, and then choose Notes.

The Save Notes As dialog box appears.

2 Choose a location at which to save the file.

3 Type a name for the file.

4 Click Save.

Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.

To save changes to notes:

In the Meeting window, do either:

■ On the Notes panel or Closed Caption panel, click Save.

■ On the File menu, point to Save, and then choose Notes.

Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.

To save a copy of notes to another file:

1 In the Meeting window, on the File menu, point to Save As, and then choose 
Notes.

The Save Notes As dialog box appears.

2 Do either or both:

■ Type a new name for the file.

■ Choose a new location at which to save the file.

3 Click Save.

Meeting Manager saves the file at the location you chose. Its file name has a .txt 
extension.
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Tip Alternatively, you can save all of the following meeting information to files at 
once:

■ Shared presentations or documents

■ Chat messages

■ Poll questionnaire

■ Poll results

■ Notes

To save all information at once, on the File menu, choose Save All. In this case, 
Meeting Manager uses the default file names for the files. Thus, if you have already 
saved a file using another name, Meeting Manager does not overwrite that file.

Sending a meeting transcript to participants
You can send a transcript of a meeting to all participants at any time during the 
meeting. The transcript is an email message that contains general information, such 
as:

■ Meeting topic

■ Meeting number

■ Meeting starting and ending times

■ URL for the Meeting Information page for the meeting on your meeting service 
Web site

■ List of all participants

■ Meeting agenda

■ Any public notes that you took during the meeting 

Optionally, you can attach any of these files to the transcript, if you saved them 
during the meeting:

■ Shared documents

■ Poll questionnaire

■ Poll results

■ Chat

■ Public notes or closed captions that you took or that the note taker or closed 
captionist published during the meeting

To send a meeting transcript to participants:

1 In the Meeting window, on the File menu, choose Send Transcript.
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If you have saved any files during the meeting, the Send Transcript dialog box 
appears, allowing you to attach the files to the transcript email message.

If you have not saved any files during the meeting, a transcript email message 
opens.

2 If the Send Transcript dialog box appears, select the check box for each file that 
you want to attach to the transcript, and then click OK.

The transcript email message opens.

3 Review the email message and make any changes that you want.

4 Send the email message.

Note

■ The transcript is sent to all participants who provided their email addresses 
when joining the meeting, whether or not they are still attending the meeting 
when you send the transcript. 

■ For security purposes, a participant who receives a transcript email message 
cannot see the email addresses for the other participants.

■ The transcript contains notes only if you are the meeting host, the public note 
taker, or the closed captionist, and you have saved the notes to a file. If all 
participants can take private notes, the transcript email message does not 
include your private notes, and the option to attach your notes in a file is not 
available.

■ If you saved notes or closed captions to a file, the transcript email message and 
the attached notes file contain the latest version of notes that you saved. 

■ If you are the meeting host and end the meeting—and you have not sent a 
transcript—a message appears, asking you if you want to send a transcript.
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Sending and Viewing Video

If a video camera is attached to your computer, you can broadcast live video to 

meeting participants. Live video lets other participants see you, an object under 
discussion, and so on. All participants can view live video that you send, without the 
need for video equipment installed on their computers. 

Participant is... Tasks

Sending video If the Video panel is closed, click 
Panels and then select Video

■ Get an overview of sending live 
video More...

■ Send video to meeting attendees 
More...

■ Set video options More...

■ Securing your privacy in a 
meeting with live video More...

 Viewing video Participants have several ways to 
control video images

Viewing video in a floating window
More...

Viewing multiple video images 
More...

Zooming in and out on video images
More...

Viewing video in full screen More..
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Setting up video
To set up video, you must connect a video camera—also called a webcam—to your 
computer. After you start or join a meeting, Meeting Manager automatically detects 
your video camera.

Generally, Meeting Manager is compatible with any video camera that connects to 
your computer's USB or parallel port. The quality of the video image can vary, 
depending on the quality of the video camera that you use. 

Important After you install your webcam software, check that your webcam is 
operating properly. Then close the software program you installed with your 
webcam before starting or joining a meeting. WebEx does not need this software 
program running during meetings and leaving this program running could 
interfere with the video features in your meeting.

Sending live video
To send live video, you must connect a video camera to your computer. For details, 
see Setting up video on page 256.

If the single-point video option is turned on (one video image appears), only the 
presenter or another participant selected by the presenter can send live video.

If the multipoint video option is turned on, up to six participants whose computers 
have a video camera can send video.

Note If you do not have a video camera, you can still view video sent by other 
meeting attendees.

To send live video:

1 In the Meeting window, open the Video panel.

2 Click Send Video to start broadcasting live video.

If you are sending video and at least one participant is viewing the video, you see an 
orange indicator on the video panel or floating icon tray (if you are sharing in 
full-screen).
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Using multipoint video

With multipoint video, you can allow up to six participants with video cameras 
attached to their computers to send live video during a meeting.

To select participants to send live video:

1 Make sure the video option for your meeting set to multipoint.

On the Meeting menu, choose Options>General. Then select Multipoint.

2 In the Meeting window, display the Video panel. 

If the panel is closed, click the Panels button and then on the Select Panel menu, 
choose Video. 

If the panel is minimized, click its icon in the icon tray.

3 Click the icon for the number of video displays you want to display.

You can display video from up to six meeting participants (with webcams) at 
one time.

4 In the drop-down list below the video image, select a participant.

If the Video panel is open and you 
are sending video, you see an 
orange indicator.

If you are in full-screen mode, you see this 
indicator

Click to select the number of video 
displays you want to see: one, two, four 
or six.

For example, click 
here to see four 
displays.
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Specifying video camera options

While sending live video during a meeting, you can specify:

■ Quality of the video image—that is, how “fast” images appear to participants

■ Resolution of the video image

■ Which video camera you want to use, if multiple cameras are attached to your 
computer

If more than one camera is attached to your computer, you can also select the video 
camera that you want to use.

To specify video camera options:

1 In the Meeting window, on the Video panel, click Options.

The Video Options dialog box appears.

2 Specify the options that you want.

For details about the options on the Video Options dialog box, see About video 
options on page 259.

3 Click OK.

Select participants to display video 
from this drop-down list
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About video options

You can change the quality of the video image by adjusting the number of frames 
per second and changing the video resolution. Use the Video Options dialog box to 
easily make changes.

To access the Video Options dialog box: In the Meeting window, open the Video 
panel, and then click Options.

Session Options

Note These options appear only 
for presenters if the multipoint 
video option is turned on.

■ Congestion control Control the amount of video data that other participants' video 
cameras can send during a meeting Move the slider up or 
down to adjust the following for all other participants' video 
cameras:

■ Maximum resolution—The resolution of the video 
image that participants' cameras send. A higher resolution 
produces clearer video images, but uses more resources on 
the computers of participants who are sending video 
images, and uses more bandwidth for all participants' 
Internet connections. 

■ Frames-per-second—A higher frame rate produces 
faster video, but uses more resources on the computers of 
participants who are sending video images, and uses more 
bandwidth for all participants' Internet connections. 

Personal Options

■ Video frame rate Using the slider, adjust the number of video frames per second 
that your camera sends. Or type a number in the box. For 
single-point video, you can specify a rate of 0 to 10 frames per 
second. For multipoint video, you can specify a rate of 0 to 30 
frames per second. 

A higher frame rate produces faster video, but uses more 
resources on your computer and bandwidth for your Internet 
connection.

■ Video resolution Select the resolution of the video image that your camera 
sends. A higher resolution produces clearer video images, but 
uses more resources on your computer and bandwidth for your 
Internet connection.

■ Capture device If more than one video camera is attached to your computer, 
select which camera you want to use in the drop-down list. 

Allow others to remotely control my cam—Available 
only if your video camera has remote control capability. 
Specifies that the presenter can remotely control your video 
camera that is, move the camera left, right, up, or down.
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Securing your privacy in a meeting with live video

If your camera is sending video and you need to stop the transmission for any 
reason, you have two options: closing the Video panel or stopping the video until 
you are ready to send video again.

To close the Video panel:

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, click to remove the check mark next to the Video 
panel.

To reopen the Video panel:

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, choose Video.

The Video panel reopens.

To stop sending live video

If you are viewing video in full screen, click View Meeting Window. The control for 
sending and stopping video transmission is on the Video panel in the Meeting 
window.

1 In the meeting window, open the Video panel.

2 Click Stop Video.

To resume sending live video:

1 In the meeting window, open the Video panel.

2 Click Stop Video.

Transmitting live video resumes on all participants' screens.

Limiting bandwidth usage and network congestion

You can control the network congestion and bandwidth consumption that sending 
and viewing multipoint video might cause. The video options for a presenter 
include a Congestion Control setting, which you can change at any time during 
your meeting. This option is preset to Medium, for an adjustable maximum frame 
rate of 15 fps (frames per second) for all attendees. A setting of Maximum increases 
the maximum adjustable frame rate to 30 fps.

To control network congestion (presenters only):

1 In the Meeting window, on the Video panel, click Options.

The Video Options dialog box appears.
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2 Select the Session Options tab.

3 Move the slider switch down to limit bandwidth consumed and reduce the 
frame rate.

4 Click OK.

To raise or limit the video frame rate and video resolution (any meeting attendee):

1 In the Meeting window, on the Video panel, click Options.

The Video Options dialog box appears.

2 Optional. Change the video frame rate.

Limiting the frame rate reduces the number of video frames transported. 
Increasing the frame rate speeds up this transmission rate. A faster bandwidth 
requires more bandwidth.

3 Optional. Change the video resolution.

Video resolution is measured in pixels. The higher the number of pixels 
transmitted, the greater the resolution (and bandwidth consumed).

4 Click OK.

Viewing live video

In the Meeting window, open the Video panel. Meeting Manager begins sending 
video immediately.

Note

■ If the multipoint video option is turned on for the meeting, you can view up to 
six video images at once on your Video panel. For details, see Viewing multiple 
video images on page 262.

■ You can view video in a floating video window. For details, see Viewing live video 
in a floating window on page 261.

Viewing live video in a floating window
You can view live video in a floating window, which you can place anywhere on 
your computer's screen. The floating window remains on top of the Meeting 
window and any other windows that are open on your screen. This option lets you 
view video continuously in a meeting, even when you are not viewing the Video 
panel.

If you are sending live video and you view your own video in the floating video 
window, Meeting Manager sends your video continuously in a meeting, even if you 
are not viewing the Video panel.
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To view live video in a floating window:

1 In the Meeting window, open the Video panel.

2 Select the video images you want to view in a floating window and then click the 
Undock button.

Viewing multiple video images
If the multipoint video option is turned on for a meeting, you can view up to six 
video images at once on your Video panel. You can also select which participants 
from whom you want to receive video images.

System requirements for viewing multiple video images

Some network and system requirements are more stringent when using multiple 
video images in a meeting than for single point video. Make sure you and those 
viewing the video have equipment that meet these added requirements:

■ CPU with at least 1.7 GHz of computing power

■ 128 MB RAM

■ T1 network connection

Note Asynchronous DSL and cable modem connections may not provide enough 
bandwidth to run multi-point video.

Zooming in or out on live video
When viewing live video, you can zoom in or out on the video image.

To zoom in or out on live video:

1 In the Meeting window, open the Video panel.

2 Select the image you want to enlarge or reduce. then click the Undock button. 

Undock button

Click to undock the video panel
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3 In the floating video window, click the Zoom button, and then select a zoom 
option.

Controlling full-screen view of live video
When viewing live video, you can switch your display of video between the Video 
panel, the floating video window, and a full-screen view. A full-screen view of video 
fits your entire screen and does not include a title bar or scroll bars.

To display a video image in a full-screen view:

Do one of the following:

■ If you are viewing video on the Video panel, click the Full Screen button. 

■ If you are viewing video in a floating video window, click the Zoom button and 
then select Full Screen.

To return to standard view from full view:

Click View Meeting Window.

Click the Zoom button to enlarge or 
reduce the size of the video image

Full Screen button

Full Screen button
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Managing Video

About managing live video
As the presenter, you can manage video for a meeting using these methods:

■ Turn the video option on or off. More...

■ Display only one video window or up to six video windows. More...

■ Protect privacy by stopping or starting video at will. More...

■ Take a screen capture of live video and paste it into the content viewer. More...

■ Select a participant who can send live video. More...

Stopping or starting live video
When a participant joins a meeting with video, and he or she has a functioning 
webcam, the following occurs:

■ If the participant is the presenter, the video camera immediately begins sending 

If you want to... See...

get an overview of managing live video About managing live video on page 265

select video options for a meeting Specifying video options during a meeting on 
page 266

select a participant who can send live video Selecting a participant to send live video on 
page 268

take a screen capture of live video and paste 
it in the content viewer

Taking screen captures of live video on 
page 269

stop or start sending video at any time during 
the meeting

Stopping or starting live video on page 265
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live video when the presenter joins the meeting.

■ If the participant joins the meeting as an attendee, the video camera is on, but is 
not transmitting images, thus avoiding a potentially embarrassing situation in 
which images are being transmitted without the attendee’s awareness or 
consent. 

If your camera is sending video and you want to stop the transmission for any 
reason, you have two options: close the Video panel or stop sending video until you 
are ready to send video again.

To close the Video panel:

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, click to remove the check mark next to Video.

To reopen the Video panel:

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, choose Video.

The Video panel reopens.

To stop sending live video:

If you are viewing video on the Video panel or in a floating video window, click Stop 
Video.

The video image pauses on all participants’ screens except yours. 

To resume sending live video:

If you are viewing video on the Video panel or in a floating video window, click 
Send Video.

The live video image resumes on all participants' screens.

Specifying video options during a meeting
During a meeting, you can turn the video option on or off. If you turn the video 
option off, neither you nor participants can send video images during the meeting.

You can also specify whether you want to use single point video, in which only one 
participant can send video images; or multi-point video, in which up to six 
participants can send live video images.

To specify video options:

1 In the Meeting window, on the Meeting menu, choose Options.
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The Meeting Options dialog box appears, with the General tab selected by 
default.

2 To turn the video option on or off, select or clear the Video check box, 
respectively.

3 Select the video option you want.

■ Single point: Lets only the presenter or one participant send live video during 
the meeting.

■ Multi-point: Lets the presenter and up to five other participants send live 
video during the meeting. This option uses more resources on your computer 
and bandwidth for your Internet connection, which may affect the 
performance of Meeting Manager.

4 Click OK.

Using multi-point video

With multi-point video, you can allow up to six participants with video cameras 
attached to their computers to send live video during a meeting. Each video image 
appears as a thumbnail window on the video panel.

Note Older computers may not have the screen space, Internet bandwidth, or CPU 
resources required to support video from six webcams simultaneously.

To select participants to send live video:

1 Make sure the video option for your meeting is set to multi-point.

For details, see Specifying video options during a meeting on page 266.

2 In the Meeting window, display the Video panel. 

If the panel is closed, click the Panels button and then on the Select Panel menu, 
choose Video. 

If the panel is minimized, click its icon in the icon tray.

3 Click the icon for the number of video views you want to display.

You can display video from up to six participants (with webcams) at one time.

4 In the drop-down list below each video image, select a participant.
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About managing live video

Selecting a participant to send live video

Taking screen captures of live video

Stopping or starting live video

Selecting a participant to send live video
You can allow another participant with a video camera attached to his or her 
computer to send live video during a meeting.

To select a participant to send live video:

1 In the Meeting window, open the Video panel.

■ If the panel is closed, click the Panels button and then on the Select Panel 
menu, choose Video. 

■ If the panel is minimized, click its icon in the icon tray.

2 In the drop-down list below the video image, select a participant.

3 Ask the participant to click Send Video on his or her Video panel.

The participant’s video camera begins sending live video.

Select participants from this 
drop-down list

Click to see one, two, four, or six 
video views
268



Chapter 21: Managing Video
Taking screen captures of live video
You can take a snapshot of any video image on your Video panel, and then paste it 
on a shared whiteboard in the content viewer.

To take a snapshot of live video:

1 On the Video panel, click the Undock the video panel button.

2 In the floating video window, click the Capture a screenshot button.

3 If you are not already sharing a whiteboard, on the Share menu, choose 
Whiteboard.

4 On the Edit menu, choose Paste As New Page.

The screen capture of the video image appears on the shared whiteboard.
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Using My WebEx

If you want to... See...

get an overview of My WebEx About My WebEx on page 272

set up a user account on your Meeting Center 
Web site

Obtaining a user account on page 273

log in to or out from My WebEx Logging in to and out of the Meeting Center 
site on page 273

use your list of meetings Using your list of meetings on page 274

set up a One-Click Meeting and install WebEx 
One-Click, which lets you start the meeting 
instantly from the One-Click panel or a 
shortcut on your computer

Setting Up a One-Click Meeting on page 89

view or set options for your Personal Meeting 
Room page

Maintaining Your Personal Meeting Room 
Page on page 283

set up or access remote computers, using 
Access Anywhere

Using Access Anywhere (My Computers) on 
page 287

add, edit, or delete files in your personal 
storage space for files

Maintaining files in your personal folders on 
page 287

add, edit, or delete information about your 
contacts in your online address book

Maintaining contact information on page 304

change information or settings in your user 
profile, including personal information and 
preferences

Maintaining your user profile on page 316

manage the scheduling templates you saved Managing scheduling templates on page 322

set up your personal conference numbers 
(PCN) accounts, which you can use to set up 
a teleconference for online meetings or 
audio-only meetings

Maintaining personal conference numbers on 
page 324

generate reports about online sessions Generating reports on page 330
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About My WebEx
My WebEx is an area on your Meeting Center Web site in which you can access your 
user account and personal productivity features. The following features are 
available, depending on the configuration of your site and user account:

■ Personal list of meetings: Provides a list of all the online meetings that you are 
hosting and attending. You can view the meetings by day, week, or month, or 
you can view all meetings.

■ One-Click Meetings: Optional feature. Lets you set up a meeting that you can 
quickly start at any time, as often as you want. If you install WebEx One-Click, 
you can start your One-Click Meeting right from your desktop, using the WebEx 
One-Click panel or one of the One-Click Meeting shortcuts.

■ Personal Meeting Room: Optional feature. A page on your Meeting Center Web 
site on which visitors can view a list of meetings that you are hosting and join a 
meeting in progress. Visitors can also access and download files that you share. 

■ Access Anywhere: Optional feature. Lets you access and control a remote 
computer from anywhere in the world. For more information about Access 
Anywhere, refer to the guide Getting Started with Access Anywhere, which is 
available on your Meeting Center Web site.

■ File storage: Lets you store files in personal folders on your Meeting Center Web 
site, where you can access them on any computer that has access to the Internet. 
Also lets you make specific files available on your Personal Meeting Room page, 
so visitors to your page can access them.

■ Address book: Lets you keep information about your personal contacts on your 
Meeting Center Web site. Using your address book, you can quickly access 
contacts when inviting them to a meeting.

■ User profile: Lets you maintain your account information, such as your user 
name, password, and contact information. Also lets you specify another user 
who can schedule meetings on your behalf, set options for your Personal 
Meeting Room page, and manage scheduling templates.

■ Personal conference numbers: Optional feature. Lets you create personal 
conference number (PCN) accounts, which you can use to set up a 
teleconference for your online meetings or scheduled audio-only meetings. You 
can also use your PCN account to start an instant audio-only meeting from any 
phone.

■ Web site preferences: Lets you specify the home page for your Meeting Center 
Web site—that is, the page that appears first whenever you access your site. If 
your site provides multiple languages, you can also choose a language and locale 
in which to display text on your site.

■ Usage reports: Optional feature. Lets you obtain information about meetings 
that you hosted. If you use the Access Anywhere option, you can also obtain 
information about computers that you access remotely.
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Obtaining a user account
Once you obtain a user account, you can use My WebEx features and host meetings 
on the Web.

You can obtain a user account in one of two ways:

■ The site administrator for your Meeting Center Web site can create a user 
account for you. In this case, you need not sign up for an account on your site, 
and you can begin hosting meetings immediately.

■ If your site administrator has made the self-registration feature available, you 
can sign up for an account on your Meeting Center Web site at any time.

To obtain a user account using the self-registration feature:

1 Go to your Meeting Center Web site.

2 On the navigation bar, click Set Up > New Account.

The Sign Up page appears.

3 Provide the required information.

4 Click Sign Up Now.

You receive an email message, confirming that you have signed up for a user 
account.

Once your site administrator approves your new user account, you receive 
another email message containing your user name and password.

Note Once you obtain a user account, you can edit your user profile to change your 
password and provide additional personal information. You can also specify site 
preferences, such as your default home page and time zone. For details, see 
Maintaining your user profile on page 316.

Logging in to and out of the Meeting Center site
To manage your online meetings maintain your user account, you must log in to 
your Meeting Center Web site. If you do not yet have a user account, see Obtaining 
a user account on page 273.

To log in to your Meeting Center site:

1 Go to your Meeting Center Web site.

2 In the upper-right corner of the page, click Log In.

The Log In page appears.

3 Enter your user name and password.
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Passwords are case-sensitive, so you must type your password exactly as you 
specified it in your user profile.

4 Click Log In.

Tip If you have forgotten your user name or password, click Login Assistance. 
Provide your email address, and then click OK. You receive an email message 
containing your user name and password.

To log out from your Meeting Center site: 

In the upper-right corner of the page, click Log Out.

Using your list of meetings

About your list of meetings

On your Meeting Center Web site, your My Meetings page in My WebEx includes:

■ A list of all the online meetings that you have scheduled, including both listed 
and unlisted meetings.

■ Any audio-only meetings that you scheduled (if your site and account have the 
Audio-Only Meetings option enabled).

■ A list of meetings on your site to which you are invited.

■ An option to start a One-Click Meeting. For details, see Setting Up a One-Click 
Meeting on page 89.

Tip You can specify that your My WebEx Meetings page is the home page that 
appears once you log in to your Meeting Center Web site. For details, see 
Maintaining your user profile on page 316. 

If you want to... See...

get an overview of your list of meetings About your list of meetings on page 274

open your list of meetings Opening your meetings list on page 275

maintain your list of meetings Maintaining your scheduled meetings list on 
page 276
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Opening your meetings list

You can open your personal list of scheduled meetings on your Meeting Center 
Web site to:

■ Start a meeting

■ Modify a meeting

■ Cancel a meeting

You can open your personal list of meetings to which you are invited to:

■ Obtain information about a meeting

■ Join a meeting in progress

To open your meetings list:

1 Log in to your Meeting Center Web site, and then click My WebEx.

The My Meetings page appears, showing your list of scheduled meetings.

2 Click one of the tabs to navigate to different views of the My WebEx Meetings 
page:

You can choose Daily, Weekly, Monthly, or All Meetings.

3 Optional. Do either of the following:

■ To view the list of meetings to which you are invited, select The meetings you 
are invited to from the list.

■ To include meetings in the view that have already occurred, turn on Show 
past meetings.
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Tip You can specify that your My WebEx Meetings page is the home page that 
appears once you log in to your Meeting Center Web site. For details, see 
Maintaining your user profile on page 316.

Maintaining your scheduled meetings list

Once you schedule a meeting, it appears in your meetings list on your My Meetings 
page. For more information, see Opening your meetings list on page 275.

An online meeting remains on your My Meetings page until you delete it. When 
scheduling a meeting, you can choose to automatically delete the meeting from 
your list of meetings once both of the following occur:

■ You start and end the meeting.

■ The scheduled time for the meeting has passed.

However, if you required registration for a scheduled meeting, the meeting remains 
in your list until you remove it. That way, you can still view information about 
attendees who registered for the meeting at any time after you host the meeting.

To remove a meeting from your list of meetings on your My Meetings page, you 
must cancel the meeting by deleting it on this page.

For details about the options on the My WebEx Meetings page, see About the My 
WebEx Meetings page on page 276.

About the My WebEx Meetings page

How to access this page

On your Meeting Center Web site, click the My WebEx tab.

What you can do here

Access the following:

■ A link to your personal meeting room

■ A link to start a One-Click Meeting

■ A list of meetings you are hosting or are invited to for the specified day, week, or 
month

■ A list of all meetings you are hosting or are invited to
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Options on this page

About the My WebEx Meetings - Daily tab

How to access this tab

On your Meeting Center Web site, click My WebEx > My Meetings > Daily tab.

Options on this tab

Use this option... To...

Go To My Personal 
Meeting Room

Go to your Personal Meeting Room page.

Your Personal Meeting Room page lists any meetings that you 
scheduled and any in-progress meetings that you are currently 
hosting.

Users to whom you provide your personal URL can use this page 
to join any meeting that you are hosting. They can also download 
files in any folders that you share.

Start a One-Click Meeting Start a One-Click Meeting based on settings you have specified 
in One-Click Setup. For details, see Setting Up a One-Click 
Meeting on page 89.

Note If you are using the new WebEx Productivity Tools, there 
are updates for this feature. For more information, refer to the 
WebEx One-Click User’s Guide, which is available from User 
Guides page in the Support section.

Daily View a list all of the meetings for the specified day. For details, 
see About the My WebEx Meetings - Daily tab on page 277.

Weekly View a list all of the meetings for the specified week. For details, 
see About the My WebEx Meetings - Weekly tab on page 279.

Monthly View a list all of the meetings for the specified month. For details, 
see About the My WebEx Meetings - Monthly tab on page 281

All Meetings View a list all meetings, or search for meetings by date, host, 
topic, or words in the agenda. For details, see About the My 
WebEx Meetings - All Meetings tab on page 281

Refresh Refresh the information in the meeting list.

Option on Daily tab Description

Click the Refresh icon at any time to display the most current 
list of meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the 
time zone setting for your Meeting Center Web site.

Date The date for the daily list of meetings. The default is the current 
date.
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Click the Previous Day icon to display a list of meetings for the 
previous day.

Click the Next Day icon to display a list of meetings for the next 
day.

The meetings you host Shows a list all of the online meetings or audio-only meetings 
that you are hosting. 

The meetings you are 
invited to

Shows a list all of the meetings to which you have been invited.

Show past meetings Select to include concluded meetings in the list of meetings.

The Ascending Sort indicator appears next to a column 
heading, and the meetings are sorted by the column, in 
ascending order.

The Descending Sort indicator appears next to a column 
heading, and the meetings are sorted by the column, in 
descending order.

Time The starting time for each scheduled meeting. Click the box 
next to a meeting start time to select that meeting. Click the box 
next to the Time column heading to select or clear all meetings 
in the list. 

Topic The topic for a meeting that you are hosting. Click the topic 
name to get information about that meeting. If you are the 
alternate host for a meeting, the topic appears in italics.

Type Indicates the type of online meeting that you are hosting. 
Available meeting types depend on the configuration of your 
Meeting Center Web site. 

Indicates that the live meeting is in process.

Requests Pending
Applies only to meetings that require registration and indicates 
the number of registration requests that are pending—that is, 
requests that you have neither accepted nor rejected. 

Click the link for the number to open a page on which you can 
view details about and accept or reject each registration 
request.

Requests Accepted
Applies only to meetings that require registration and indicates 
the number of registration requests that you have accepted. 

Click the link for the number to open a page on which you can 
view details about each accepted registration request.

Requests Rejected
Applies only to meetings that require registration. The number 
of registration requests that you have rejected. Click the link for 
the number to open a page on which you can view details about 
each rejected registration request.

Option on Daily tab Description
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About the My WebEx Meetings - Weekly tab

How to access this tab

On your Meeting Center Web site, click My WebEx > My Meetings > Weekly tab.

Options on this tab

Status The status of the meeting.

■ Start: You can start this meeting that you are hosting at any 
time by clicking the link. 

■ Join | End: For a meeting in progress that you are hosting, 
you can join or end the meeting. Appears if you left a 
meeting, or you allowed participants to join the meeting 
before its starting time and participants have already joined 
the meeting.

❏ Join: Lets you join the meeting in progress.

❏ End: Ends the meeting.

■ Join: The meeting that you are invited to has started, and 
you can now join the meeting.

■ Registration: The meeting that you are invited to requires 
registration. To display a page on which you can register to 
attend the meeting, click the link. (Applies to meetings , 
events and training sessions only.)

Delete Cancels any meetings that are currently selected in the list. If 
you click this link, a message appears, allowing you to confirm 
that you want to cancel the meeting. Another message appears, 
allowing you to inform any invited attendees that you canceled 
the meeting. 

Option on Daily tab Description

Option on Weekly tab Description

Click the Refresh icon at any time to display the most current list of 
meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Week The beginning and ending date for the weekly list of meetings. 

Click the Previous Week icon to display a list of meetings for the 
previous week.

Click the Next Week icon to display a list of meetings for the next 
week.
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Click the Calendar icon to open the Calendar window for the 
current month. Click on any date to open its schedule in the Daily 
view.

The meetings you host Shows a list all of the online meetings or audio-only meetings that 
you are hosting. 

The meetings you are 
invited to

Shows a list all of the meetings to which you have been invited.

Show past meetings Select to include concluded meetings in the list of meetings.

Day link Opens the Daily view, which shows the scheduled meetings for the 
selected day.

The Ascending Sort indicator appears next to a column heading, 
and the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the meetings are sorted by the column, in descending order.

The Expand button appears next to a Day link. Click this button to 
expand and display the list of meetings for that day.

The Collapse button appears next to a Day link. Click this button to 
collapse and hide the list of meetings for that day.

Time The starting time for each scheduled meeting. Click the box next to 
a meeting start time to select that meeting. Click the box next to the 
Time column heading to select or clear all meetings in the list. 

Topic The topic for a meeting that you are hosting. Click the topic name 
to get information about that meeting. If you are the alternate host 
for a meeting, the topic appears in italics.

Type Indicates the type of online meeting that you are hosting. Available 
meeting types depend on the configuration of your Meeting Center 
Web site. 

Indicates that the live meeting is in process.

Status The status of the meeting.

■ Start: You can start this meeting that you are hosting at any time 
by clicking the link. 

■ Join | End: For a meeting in progress that you are hosting, you 
can join or end the meeting. Appears if you left a meeting, or you 
allowed participants to join the meeting before its starting time 
and participants have already joined the meeting.

❏ Join: Lets you join the meeting in progress.

❏ End: Ends the meeting.

■ Join: The meeting that you are invited to has started, and you 
can now join the meeting.

■ Registration: The meeting that you are invited to requires 
registration. To display a page on which you can register to 
attend the meeting, click the link. (Applies to meetings , events 
and training sessions only.)

Option on Weekly tab Description
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About the My WebEx Meetings - Monthly tab

How to access this tab

On your Meeting Center Web site, click My WebEx > My Meetings > Monthly tab.

About the My WebEx Meetings - All Meetings tab

How to access this tab

On your Meeting Center Web site, click My WebEx > My Meetings > All Meetings 
tab.

Option on Monthly tab Description

Click the Refresh icon at any time to display the most current list of 
meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the time 
zone setting for your Meeting Center Web site.

Month The month for the monthly calendar of meetings. The default is the 
current month.

Click the Previous Month icon to display a list of meetings for the 
previous month.

Click the Next Month icon to display a list of meetings for the next 
month.

Click the Calendar icon to open the Calendar window for the 
current month. Click on any date to open its schedule in the Daily 
view.

Week Number link Opens the Weekly view, which shows the scheduled meetings for 
each day of the selected week.

Day link Opens the Daily view, which shows the scheduled meetings for the 
selected day.

The meetings you host Shows a list all of the online meetings or audio-only meetings that 
you are hosting. 

The meetings you are 
invited to

Shows a list all of the meetings to which you have been invited.

Show past meetings Select to include concluded meetings in the list of meetings.

Topic The topic for a meeting that you are hosting. Click the topic name 
to get information about that meeting. If you are the alternate host 
for a meeting, the topic appears in italics.

Indicates that the live meeting is in process.
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Option on All Meetings tab Description

Click the Refresh icon at any time to display the most current 
list of meetings.

Language link Click to open the Preferences page, where you can select the 
language setting for your Meeting Center Web site.

Time zone link Click to open the Preferences page, where you can select the 
time zone setting for your Meeting Center Web site.

Search for meetings by 
date, host, topic, or words 
in the agenda

Allows you type or select a date range to search for meetings, 
or allows you to type text to search in host names, topics, or 
agendas. Click Search to start the search.

Click the Calendar icon to open the Calendar window. Click on 
any date to select that date as part of your search criteria.

The meetings you host Shows a list all of the online meetings or audio-only meetings 
that you are hosting. 

The meetings you are 
invited to

Shows a list all of the meetings to which you have been invited.

Show past meetings Select to include concluded meetings in the list of meetings.

Time The starting time for each scheduled meeting. Click the box 
next to a meeting start time to select that meeting. Click the box 
next to the Time column heading to select or clear all meetings 
in the list. 

Topic The topic for a meeting that you are hosting. Click the topic 
name to get information about that meeting. If you are the 
alternate host for a meeting, the topic appears in italics.

Type Indicates the type of online meeting that you are hosting. 
Available meeting types depend on the configuration of your 
Meeting Center Web site. 

Requests Pending
Applies only to meetings that require registration and indicates 
the number of registration requests that are pending—that is, 
requests that you have neither accepted nor rejected. 

Click the link for the number to open a page on which you can 
view details about and accept or reject each registration 
request.

Requests Accepted
Applies only to meetings that require registration and indicates 
the number of registration requests that you have accepted. 

Click the link for the number to open a page on which you can 
view details about each accepted registration request.

Requests Rejected
Applies only to meetings that require registration. The number 
of registration requests that you have rejected. Click the link for 
the number to open a page on which you can view details about 
each rejected registration request.

Indicates that the live meeting is in process.
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Maintaining Your Personal Meeting Room Page

About your Personal Meeting Room page

Your user account includes a Personal Meeting Room page on your Meeting Center 
Web site. Users who visit your page can:

■ View a list of online meetings that you are hosting, either scheduled or in 
progress. 

■ Join a meeting in progress.

■ View your personal folders and upload or download files to or from your folders, 

Status The status of the meeting.

■ Start: You can start this meeting that you are hosting at any 
time by clicking the link. 

■ Join | End: For a meeting in progress that you are hosting, 
you can join or end the meeting. Appears if you left a 
meeting, or you allowed participants to join the meeting 
before its starting time and participants have already joined 
the meeting.

❏ Join: Lets you join the meeting in progress.

❏ End: Ends the meeting.

■ Join: The meeting that you are invited to has started, and 
you can now join the meeting.

■ Registration: The meeting that you are invited to requires 
registration. To display a page on which you can register to 
attend the meeting, click the link. (Applies to meetings , 
events and training sessions only.)

Delete Cancels any meetings that are currently selected in the list. If 
you click this link, a message appears, allowing you to confirm 
that you want to cancel the meeting. Another message appears, 
allowing you to inform any invited attendees that you canceled 
the meeting. 

Option on All Meetings tab Description

If you want to... See...

get an overview of your Personal Meeting 
Room page

About your Personal Meeting Room page on 
page 283

access your Personal Meeting Room page Viewing your Personal Meeting Room page 
on page 284

add images and text to your Personal Meeting 
Room page

Setting options for your Personal Meeting 
Room page on page 285

share files on your Personal Meeting Room 
page

Sharing files on your Personal Meeting Room 
page on page 286
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depending on the settings you specify for your folders.

You can customize your Personal Meeting Room page by adding images and text to 
it.

To provide users with access to your Personal Meeting Room page, you must 
provide them with your Personal Meeting Room URL. For more information, see 
Viewing your Personal Meeting Room page on page 284.

Tip Add your Personal Meeting Room URL to your business cards, your email 
signature, and so on.

Viewing your Personal Meeting Room page

You can view your Personal Meeting Room page at any time, by going to the link 
for the page. The link for your Personal Meeting Room page is available on your:

■ My WebEx Meetings page

■ My WebEx Profile page

To view your Personal Meeting Room page:

1 Log in to your Meeting Center Web site, and then click My WebEx.

The My WebEx Meetings page appears.

2 Click the Go to My Personal Meeting Room link.

Alternatively, in My WebEx, click My Profile, and then click the Personal 
Meeting Room URL link in the Personal Meeting Room section.

Your Personal Meeting Room page appears. The following is an example of a 
Personal Meeting Room page.
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Tip Add your Personal Meeting Room URL to your business cards, your email 
signature, and so on.

Setting options for your Personal Meeting Room page

You can add the following to your Personal Meeting Room page:

■ An image (for example, you can add a picture of yourself or your company's 
product).

■ A custom banner image to the header area of your Personal Meeting Room page, 
if your user account has the “branding” option. For example, you can add your 
company’s logo.

■ A welcome message. For example, you can provide a greeting; instructions on 
joining an online session; information about yourself, your product, or your 
company. 

At any time, you can replace or delete images and text that you add.

To add an image to your Personal Meeting Room page:

1 If you have not already done so, log in to your Meeting Center Web site. For 
details, see Logging in to and out of the Meeting Center site on page 273.

2 On the navigation bar at the top of the page, click My WebEx.

3 Click My Profile.

The My WebEx Profile page appears.

4 Under Personal Meeting Room, specify options for your page.
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5 At the bottom of the My WebEx Profile page, click Update.

6 For details about the options for your Personal Meeting Room page, see About 
the My WebEx Profile page on page 318.

Sharing files on your Personal Meeting Room page

You can share folders on your My WebEx Files: Folders page so that they appear on 
the Files tab on your Personal Meeting Room page. For any folder that you share, 
you can specify whether users can download files from or upload files to the folder.

For more information about your Personal Meeting Room page, see About your 
Personal Meeting Room page on page 283.

To share files on your Personal Meeting Room page:

1 Open the My WebEx Files page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Under Name, locate the folder in which you want to share files. 

3 If the file or folder is in a closed folder, click the folder to open it.

4 Click the Properties icon for the folder in which you want to share files. 

The Edit Folder Properties window appears.
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5 Specify sharing options for the folder.

6 Click Update.

For details about sharing options, see About the Edit Folder Properties page on 
page 295.

Using Access Anywhere (My Computers)
For information about and instructions for using Access Anywhere to set up and 
access a remote computer, please refer to the guide Getting Started with WebEx 
Access Anywhere. This guide is available on the Support page on your Meeting 
Center Web site.

Maintaining files in your personal folders

About maintaining files in your folders

Your user account includes personal storage space for files on your Meeting Center 
Web site. 

If you want to... See...

get an overview of your personal storage 
space for files

About maintaining files in your folders on 
page 287

open your personal storage space for files Opening your personal folders, documents, 
and files on page 288

create new folders to organize your files Adding new folders to your personal folders on 
page 289

upload files to your personal folders Uploading files to your personal folders on 
page 289

move or copy files or an entire folder to 
another folder

Moving or copying files or folders in your 
personal folders on page 290

change information about files or folders, 
including their names or descriptions

Editing information about files or folders in 
your personal folders on page 291

search for files or folders in your personal 
storage space for files

Searching for files or folders in your personal 
folders on page 292

download files in your personal storage space 
to your computer

Downloading files in your personal folders on 
page 292

share, or publish, files in your personal folders 
on your Personal Meeting Room, so others 
can access them

Sharing files on your Personal Meeting Room 
page on page 286

remove files or folders from your personal 
folders

Deleting files or folders in your personal 
folders on page 293
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In your personal storage space, you can:

■ Create folders to organize your files.

■ Edit information about any file or folder in your personal folders.

■ Move or copy a file or folder to a different folder.

■ Share a folder so it appears on your Personal Meeting Room page.

Tip

■ You can use this storage space to access important information when you are 
away from the office. For example, if you are on a business trip and want to share 
a file during an online session, you can download the file in your personal folders 
to a computer, and then share the file with attendees.

■ If you share a folder, visitors to your Personal Meeting Room page can upload 
files to or download them from the folder. For example, you can use your 
personal folders to exchange documents that you share in your sessions, archive 
recorded meetings, and so on. For more information about your Personal 
Meeting Room, see About your Personal Meeting Room page on page 283.

Opening your personal folders, documents, and files

To store files on your Meeting Center Web site, or to access files that you stored, 
you must open your personal folders.

To open your personal folders: 

1 Log in to your Meeting Center Web site, and then click My WebEx. 

2 Click My Files.

The My WebEx Files page appears, showing your personal folders and files. 
Depending on the settings for your Meeting Center Web site, you may see 
different categories of folders and files, and you can click on the heading links to 
see each category:

■ My Documents

■ My Recordings

■ My Event Recordings (available only in Event Center)

■ My Training Recordings (available only in Training Center)
288



Chapter 22: Using My WebEx
For details about the My WebEx Files page, see About the My WebEx Files > My 
Documents page on page 293 and About the My WebEx Files > My Recordings page 
on page 298.

Adding new folders to your personal folders

To organize your files on your Meeting Center Web site, you can create folders in 
your personal storage space for files.

To create a new folders:

1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Under Action, click the Create Folder button for the folder in which you want a 
new folder.

The Create Folder window appears.

3 In the Folder Name box, type a name for the folder.

4 Optional. In the Description box, type a description to help you to identify the 
folder’s contents.

5 Click OK.

Uploading files to your personal folders

To store files in your personal folders on your Meeting Center Web site, you must 
upload them from your computer or a local server. 
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You can upload:

■ Up to three files at once

■ Any file that is less than 5076K

The amount of space available for storing files is determined by your site 
administrator. If you require more disk space, contact your site administrator.

To upload files to your personal folders:

1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Locate the folder in which you want to store the file.

3 Under Action for the folder, click the Upload button for the folder in which you 
want to store the file.

The Upload File window appears.

4 Click Browse.

The Choose File dialog box appears.

5 Select the file that you want to upload to your folder.

6 Click Open.

The file appears in the File name box.

7 Optional. In the Description box, type a description to help you to identify the 
file.

8 Optional. Select up to two additional files to upload.

9 Click Upload.

The files are uploaded to the folder that you selected.

10 Once you are finished uploading files, click Finish.

Moving or copying files or folders in your personal folders

You can move one or more files or folders to another folder on your Meeting Center 
Web site.

To move or copy a file or folder:

1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Locate the file or folder that you want to move.

3 Select the check box for the file or folder that you want move.
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You can select multiple files or folders.

4 Click Move or Copy.

The Move/Copy File or Folder window appears, showing a list of your folders.

5 Select the option button for the folder in which you want to move or copy the 
file or folder.

6 Click OK.

Editing information about files or folders in your personal 
folders

You can edit the following information about a file or folder in your personal 
folders on your Meeting Center Web site:

■ Name

■ Description

You can also specify sharing options for folders that appear on your Personal 
Meeting Room page. For more information, see Sharing files on your Personal 
Meeting Room page on page 286.

To edit information about a file or folder:

1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Locate the file or folder for which you want to edit information.

3 Click the Properties icon for the file or folder for which you want to edit 
information.

The Edit File Properties or Edit Folder Properties window appears.
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■ In the Description box, type a new name for the file or folder.

■ In the Name box, type a new name for the file or folder.

4 Click Update.

Searching for files or folders in your personal folders

In your personal folders on your Meeting Center Web site, you can quickly locate a 
file or folder by searching for it. You can search for a file or folder by text that 
appears in either its name or description.

To search for a file or folder:

1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 In the Search For box type all or part of the file's name or description.

3 Click Search.

A list of any files or folders that contain the search text appears.

Downloading files in your personal folders

In your personal folders on your Meeting Center Web site, you can download any 
files to your computer or a local server.
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1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Locate the file that you want to download.

3 Under Action, click the Download button for the file that you want to 
download.

The File Download dialog box appears.

4 Follow any instructions that your Web browser or operating system provides to 
download the file.

Deleting files or folders in your personal folders

You can delete files or folders in your personal folders on your Meeting Center Web 
site.

To delete a file or folder:

1 Open the My Documents page. For details, see Opening your personal folders, 
documents, and files on page 288.

2 Under Name, locate the file or folder that you want to delete. 

3 Select the check box for the file or folder that you want delete.

You can select multiple files or folders.

4 Click Delete.

About the My WebEx Files > My Documents page

How to access this page

On your Meeting Center Web site, click My WebEx Files > My Documents.

What you can do here

■ Store files that you use in your online sessions or that you want to access when 
away from your office.

■ Specify in which folders that visitors to your Personal Meeting Room can 
download or upload files.

Options on this page

Link or option Description

Capacity The storage space available for your files, in megabytes (MB).
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Used The amount of storage space that your files occupy, in megabytes 
(MB). Once this value exceeds your capacity, you can no longer 
store files until you remove existing files from your folders.

Search for Lets you locate a file or folder by searching for it. You can search 
for a file or folder by text that appears in either its name or 
description. To search for a file or folder, type all or part of its name 
or description in the box, and then click Search.

Refresh
Click this button to refresh the information on the page.

Name The name of the folder or file. Click a folder or file name to open the 
Folder Information page or File Information page. From the 
Information page, you can access the properties of a folder or file.

Indicates that the item is a folder. Click the image to display 
the contents of the folder.

Indicates that the item is a file.

Path The folder hierarchy for the folder or file. The Root folder is the 
top-most folder in which all other folders and files reside.

Size The size of the folder or file, in kilobytes (KB).

Actions Click the icons to perform an action on the folder or file that is 
associated with it. 

Upload file: Available only for files. Click this icon to open the 
File Upload page, on which you can select up to three files at a time 
to upload to a specified folder.

Download file: Available only for files. Click this icon to 

download the file associated with it.

Edit File Properties or Edit Folder Properties: Click this 
icon to open the Edit File Properties page or Edit Folder Properties 
page, on which you can edit information about the file or folder, 
respectively.

Create Folder: Available for folders only. Click this icon to 
open the Create Folder page on which you can create a new folder 
in your personal storage space.

Link or option Description
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About the Edit Folder Properties page

How to access this page

On your Meeting Center Web site, click My WebEx > My Files > Properties icon 
for folder.

What you can do here

Specify a name, a description, and sharing options for a folder that you created in 
your personal folders.

Options on this page

Shared Specifies the sharing settings for a folder; that is, how others who 
visit your Personal Meetings Room can access your folder and its 
files. 

R: Read only. Visitors to your Personal Meeting Room can view the 
list of files in the folder and download the files.

W: Write only. Visitors to your Personal Meeting Room can upload 
files to the folder, but they cannot view the files in it.

R/W: Read and write. Users can view files in the folder, download 
files from the folder, and upload files to the folder.

Password Protected: Indicates that the folder is password 
protected. Visitors to your Personal Meeting Room must provide 
the password you specify to access the folder.

Select All Selects the check boxes for all the folders and files that are visible 
in the list. You can then click the Copy or Move button or click the 
Delete link to perform an action on the selected folders or files.

Clear All Clears the check boxes for all the folders and files that are selected 
in the list.

Delete Deletes the selected folders and files from the list.

Copy Opens a page on which you can copy the selected folder or file to 
another folder.

Move Opens a page on which you can move the selected folder or file to 
another folder.

Link or option Description

Use this option... To...

Name Enter the name of the folder.

Description Enter the description of the folder.
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Opening the My Recordings page
To upload or maintain recordings, you must do so from the My Recordings page 
on your Meeting Center Web site or the My Recorded Meetings page in Meeting 
Center.

Share Specify who can access this folder.

■ Do not share this folder: This folder does not appear on your 
Personal Meeting Room page. Thus, visitors to your page cannot 
view the folder or access any files in it.

■ Share this folder: This folder appears on your Personal Meeting 
Room.

The drop-down list specifies which users can access the folder, as 
follows:

With all: All visitors to your Personal Meeting Room can access 
this folder.

With users with host or attendee accounts: Only visitors to your 
Personal Meeting Room who have either a host account or an 
attendee account on your Meeting Center Web site can access this 
folder.

With users with host accounts only: Only visitors to your 
Personal Meeting Room who have a host account on your Meeting 
Center Web site can access this folder.

Share as Enter the name for the folder that will appear on your Personal 
Meeting Room page.

Read Let visitors to your Personal Meeting Room view the list of files in the 
folder and download the files.

Write Let visitors to your Personal Meeting Room upload files to the folder 
but does not allow them to view the files in it.

Read & write Let users view files in the folder, download files from the folder, and 
upload files to the folder.

Allow files to be 
overwritten

Let users upload a file with the same name as an existing file in the 
folder and replace the existing file. If this option is not selected, users 
cannot overwrite any files in the folder.

Password protected Let only visitors to your Personal Meeting Room who know the 
password view the list of files in the folder, download files from the 
folder, or upload files to the folder, depending on the read/write 
settings for the folder.

Password: The password that visitors to your Personal Meeting 
Room must provide to access the folder.

Confirm: If you specified a password, type it again to verify that you 
typed it correctly.

Update Save any changes that you made to folder's properties, and then 
closes the Edit Folder Properties window.

Cancel Close the Edit Folder Properties window, without saving any of the 
changes that you made.

Use this option... To...
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To open the My Recordings page:

1 Log in to your Meeting Center Web site, and then click My WebEx. 

2 Click My Files > My Recordings.

The My Recordings page appears, showing your recording files. 

Note In Meeting Center, you can also view your recordings in the My Recorded 
Meetings page. To view this page, from the left navigation bar, click My Recorded 
Meetings. For details about the My Recorded Meetings page, see About the Add/Edit 
Recorded Meeting Page on page 301.

For details about the My Recordings page, see About the My WebEx Files > My 
Recordings page on page 298.

Uploading a recording file
If you recorded a meeting using the integrated or standalone WebEx Recorder, you 
can upload the recording file, with a .wrf extension, from your local computer to 
the My Recordings page or the My Recorded Meetings page.

For instructions on publishing a recording, see Editing information about a 
recording on page 298.

Note If you recorded a meeting using the WebEx Network-Based Recorder (NBR), 
the WebEx server automatically uploads the recording file, with an .arf extension, 
to the My Recordings page and the My Recorded Meetings page once you stop the 
Network-Based Recorder. You do not need to upload it yourself.

To upload a recording file:

1 Go to the My Recordings page or the My Recorded Meetings page. For details, 
see Opening the My Recordings page on page 296.

2 Click Add Recording.

3 On the Add Recording page or the Add Recorded Meeting page, enter 
information and specify options.

For details about what you can do with each option on Add/Edit Recording 
page, see About the Add/Edit Recording page on page 300. For details about what 
you can do with each option on the Add/Edit Recorded Meetings page, see About 
the Add/Edit Recorded Meeting Page on page 301.

4 Click Save.
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Editing information about a recording
You can edit information about a recording at any time. 

To edit information about a recording:

1 Go to the My Recordings page or the My Recorded Meetings page. For details, 
see Opening the My Recordings page on page 296.

2 Click the following icon for the recording that you want to edit.

The Edit Recording page or Edit Recorded Meeting page appears.

3 Make your changes.

For details about what you can do with each option on the Edit Recording page, 
see About the Add/Edit Recording page on page 300. For details about what you 
can do with each option on the Edit Recorded Meetings page, see About the 
Add/Edit Recorded Meeting Page on page 301.

4 Click Save.

About the My WebEx Files > My Recordings page

How to access this page

Log in to your Meeting Center Web site, and then click My WebEx. From the left 
navigation bar, click My Files > My Recordings.

What you can do here

Manage, upload, and maintain your recording files.

Options on this page

Option Description

Personal Storage The percentage of available personal storage space on your Meeting 
Center Web site that is being used by your recordings.

 

Refreshes the information on the page.

Indicates a disabled recording.

Topic The name of the recording.

Size The size of the recording.

Create Time The date and time the recording was created.

Duration The length of the recording.
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About the My Recorded Meetings page

How to access this page

Log in to your Meeting Center Web site. From the left navigation bar, click My 
Recorded Meetings.

What you can do here

Manage, upload, and maintain your recordings of Meeting Center meetings.

Options on this page

Format The format of the recording file.

A recording file can be in WebEx Advanced Recording Format (ARF) 
or WebEx Recording Format (WRF). You can also store recording 
files that are in Windows Media Audio/Video (WMV) or Shockwave 
Flash Object (SWF) format.

Lets you upload a new recording.

For details, see Uploading a recording file on page 297 and About the 
Add/Edit Recording page on page 300.

Lets you play the recording (available only for recording files with an 
.arf extension that were recorded by NBR).

If playback of the file requires a password, you must provide the 
password.

 Lets you download the recording to your local computer.

If downloading the file requires a password, you must provide the 
password.

Lets you edit information of the recording. For details, see About the 
Add/Edit Recording page on page 300.

Lets you delete the recording from this page.

Option Description

Option Description

 

Refreshes the information on the page.

Search Allows you type text to search for within meeting recording names. 
Click Search to start the search.

Indicates a disabled recording.

Topic The name of the recording.

File Size The size of the recording file.

Create Time The date and time the recording was created.
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About the Add/Edit Recording page

How to access this page

If you are adding a recording...

1 On your Meeting Center Web site, click My WebEx > My Files > My Recordings.

2 Click Add Recording.

If you are editing information of a recording...

1 On your Meeting Center Web site, click My WebEx > My Files > My Recordings.

2 Click the following icon for the recording that you want to edit.

What you can do here

■ Edit general information about a recording, including the topic and description.

■ Require a password to play or download the recording.

Duration The length of the recording.

Format The format of the recording file.

A recording file can be in WebEx Advanced Recording Format (ARF) 
or WebEx Recording Format (WRF). You can also store recording 
files that are in Windows Media Audio/Video (WMV) or Shockwave 
Flash Object (SWF) format.

Lets you upload a new recording.

For details, see Uploading a recording file on page 297 and About the 
Add/Edit Recorded Meeting Page on page 301.

Lets you play the recording (available only for recording files with an 
.arf extension that were recorded by NBR).

If playback of the file requires a password, you must provide the 
password.

 Lets you download the recording to your local computer.

If downloading the file requires a password, you must provide the 
password.

Lets you edit information of the recording. For details, see About the 
Add/Edit Recorded Meeting Page on page 301.

Lets you delete the recording from this page.

Option Description
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Options on this page

About the Add/Edit Recorded Meeting Page

How to access this page

If you are adding a recording...

1 On your Meeting Center Web site, from the left navigation bar, click My 
Recorded Meetings.

2 Click Add Recording.

If you are editing information of a recording...

1 On your Meeting Center Web site, from the left navigation bar, click My 
Recorded Meetings.

2 Click the following icon for the recording that you want to edit.

What you can do here

■ Edit general information about a recording, including the topic and description.

■ Require a password to play or download the recording.

■ Specify playback control options, such as panel display options and recording 
playback range and whether to include Network Recording Play controls.

Use this option.... To....

Topic Specify the topic of the recording.

Description Provide a description of this recording.

Recording file Click Browse to select the recording file that resides on your 
local computer.

Duration Specify the duration of the recording.

File size Displays the size of the recording file. (Available only when 
editing recording information.)

Set password Set an optional password that users must provide to view the 
recording.

Confirm password Confirm the password that users must provide to view the 
recording.
301



Chapter 22: Using My WebEx
Options on this page

Use this option.... To....

Topic Specify the topic of the recording.

Description Provide a description of this recording.

Recording file I will provide URL—Specify the Web address, or URL, at which 
the recording resides on a publicly accessible Web server, such 
as your organization’s Web site.

Enter a URL in the box.

Use the file on my local machine—Select a recording file that 
resides on your local computer.

Click Browse to select the file.

Use a file that is already on the WebEx network—Specify a 
recording file that resides on the My Recordings page (in My 
WebEx), which lists the following types of recordings:

■ all the network-based recordings (ARF format) that you made 
during an event

■ other recordings (WRF format) that you upload to the page

Click Look Up to browse and select a recording from the My 
Recordings page. If you cannot find a certain recording, it may 
have been removed or used on the My Training Recordings 
page, if your site includes the training service.

Duration Specify the duration of this recording.

File size Displays the size of the recording. (Available only when editing 
recording information.)

Panel Display Options Determines which panels are displayed in the recording when it 
is played back. You can select any of the following panels to be 
included the recording playback:

■ Chat

■ Q & A

■ Video

■ Polling

■ Notes

■ File Transfer

■ Participants

■ Table of Contents
Panel display options do not modify the panel display in the 
actual recording that is stored on the WebEx network.
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About the Recording Information page

How to access this page

On your Meeting Center Web site, click My WebEx > My Files > My Recordings > 
[topic of a recording], or on your Meeting Center Web site, from the left navigation 
bar, click My Recorded Meetings > [topic of a recording].

What you can do here

■ View information about a recording.

■ Open the Edit Recording Information page or Edit Recorded Meetings page, on 
which you can edit information about a recording.

Options on this page

Recording Playback 
Range

Determines how much of the recording is actually played back. 
You can select either of the following:

■ Full playback: Plays back the full length of the recording. 
This option is selected by default.

■ Partial playback: Plays back only part of the recording based 
on your settings for the following options:

❏ Start: X min X sec of the recording: Specifies the time to 
start playback; for example, you can use this option if you 
would like to omit the “dead time” at the beginning of the 
recording, or if you would like to show only a portion of the 
recording.

❏ End: X min X sec of the recording: Specifies the time to 
end playback; for example, you can use this option if you 
would like to omit the “dead time” at the end of the 
recording. You can not specify an end time greater than 
the length of the actual recording.

The partial playback range you specify does not modify the 
actual recording that is stored on the WebEx network.

Include NBR player 
controls

Includes full Network Recording Player controls, such as stop, 
pause, resume, fast forward, and rewind. This option is selected 
by default. If you would like to prevent viewers from skipping 
portions of the recording, you can turn off this option to omit 
Network Recording Player controls from the playback.

Set password Set an optional password that users must provide to view the 
recording.

Confirm password Confirm the password that users must provide to view the 
recording.

Use this option.... To....

Option Description

Topic The name of the recording. You can edit the topic at any time.
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Maintaining contact information

Duration The length of the recording.

Description A description of the recording.

File size The file size of the recording.

Create time The date and time at which the recording was created.

Status The status of the recording. The possible options are Enable or 
Disable.

Password Indicates whether a user must provide a password to view the 
recording.

Stream recording link Clicking the link lets you play the recording (available only for 
recording files with the.arf extension that were recorded by 
NBR).

Download recording 
link

Clicking the link lets you download the recording.

Clicking the button opens the Edit Recording page.

For details about the page, see About the Add/Edit Recording page 
on page 300 or About the Add/Edit Recorded Meeting Page on 
page 301.

Clicking the button lets you play the recording (available only for 
recording files with the.arf extension that were recorded by 
NBR).

Clicking the button lets you download the recording.

Clicking the button disables the recording everywhere it is 
published on your Meeting Center Web site. (Available only for 
enabled recordings.)

Clicking the button enables the recording everywhere it is 
published on your Meeting Center Web site. Available only for 
disabled recordings.)

Clicking the button opens the Re-Assign Recording page, which 
allows you to re-assign the recording to another host.

Clicking the button returns you to the My Recordings page or the 
My Recorded Meetings page.

Option Description

If you want to... See...

get an overview of your personal address 
book

About maintaining contact information on 
page 305

open your personal address book Opening your address book on page 305

add a new contact to your personal address 
book

Adding a contact to your address book on 
page 306
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About maintaining contact information

You can maintain a personal online address book, in which you can add 
information about contacts and create distribution lists. When scheduling a 
meeting, you can quickly invite any contacts or distribution lists in your personal 
address book. You can also invite contacts in the Company Address Book for your 
Meeting Center Web site, if one is available.

You can add contacts to your personal address book in any of the following ways:

■ Specify information about contacts one at a time.

■ Import contact information from your Microsoft Outlook contacts. 

■ Import contact information from a comma-separated/comma-delimited values 
(CSV) file.

You can also edit or delete the information about any contact or distribution list in 
your personal address book.

Opening your address book

You can open your personal address book on your Meeting Center Web site, to view 
or maintain information about your contacts.

To open your address book:

1 Log in to your Meeting Center Web site. For details, see Logging in to and out of 
the Meeting Center site on page 273.

2 On the navigation bar at the top of the page, click My WebEx.

3 Click My Contacts.

The My WebEx Contacts page appears.

add multiple contacts to your address book at 
once

Importing contact information in a file to your 
address book on page 308

add contacts in Microsoft Outlook to your 
personal address book

Importing contact information from Outlook to 
your address book on page 311

view or change information about contacts in 
your personal address book

Viewing and editing contact information in 
your address book on page 311

find a contact in your personal address book Finding a contact in your personal address 
book on page 312

combine multiple contacts into a single 
distribution list

Creating a distribution list in your address 
book on page 313

edit information about a distribution list Editing a distribution list in your address book 
on page 314

delete a contact or distribution list Deleting contact information in your address 
book on page 316

If you want to... See...
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4 In the View drop-down list, select one of the following contact lists:

■ Personal Contacts: Includes any individual contacts or distribution lists that 
you added to your personal address book. If you have a Microsoft Outlook 
address book or contacts folder, you can import its contacts to this list of 
contacts. 

■ Company Address Book: Your organization's address book, which includes 
any contacts that your site administrator has added to it. If your organization 
uses a Microsoft Exchange Global Address List, your site administrator can 
import its contacts to this address book.

Adding a contact to your address book

You can add contacts to your personal address book, one at a time.

To add a contact to your personal address book:

1 Open your personal address book. For details, see Opening your address book on 
page 305.

2 In the View drop-down list, select Personal Contacts.

A list of contacts in your Personal Contacts list appears.

3 Click Add Contact.

The Add Contact page appears.
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4 Provide information about the contact. 

5 Click Add.

For descriptions of the information and options on the New Contact page, see 
About the New/Edit Contact page on page 307.

Note You cannot add contacts to your Company Address Book.

Tip If you want to add multiple contacts, you can them all at once, instead of 
adding one contact at a time. For details, see Importing contact information in a file 
to your address book on page 308.

About the New/Edit Contact page

How to access this page

On your Meeting Center Web site, click My WebEx > My Contacts > Add Contact 
or [check box for contact] > Edit.
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What you can do here

Enter information about a new or existing contact for your personal address book.

Options on this page

Importing contact information in a file to your address book

You can add information about multiple contacts simultaneously to your personal 
address book, by importing a comma-separated values (CSV) file. A CSV file has 
the .csv file extension; you can export information from many spreadsheet and 
email programs in CSV format.

Use this option... To...

Full name Enter the contact's first and last name.

Email address Enter the contact’s email address.

Language Set the language in which any email messages that you send to the 
contact using your Meeting Center site appear.

Available only if your Meeting Center Web site can be displayed in 
two or more languages. 

Company Enter the company or organization for which the contact works.

Job title Enter the contact's position in a company or organization.

URL Enter the URL, or Web address, for the contact's company or 
organization.

Phone number/Phone 
number for mobile 
device/Fax number

Enter the contact's phone numbers. For each number, you can 
specify the following:

Country Code Specify the number that you must dial if the contact resides in 
another country. To select a different country code, click the link to 
display the display the Country Code window. From the drop-down 
list, select the country in which the contact resides.

Area or city code Enter the area or city code for the contact's phone number.

Number Enter the phone number.

Extension Enter the extension for the phone number, if any.

Address 1 Enter the contact's street address.

Address 2 Enter additional address information, if necessary.

State/Province Enter the contact's state or province.

ZIP/Postal code Enter the contact's ZIP or postal code.

Country Enter the country in which the contact resides.

User name Enter the user name with which the user logs in to your Meeting 
Center Web site, if the contact has a user account.

Notes Enter any additional information about the contact.
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To create a CSV file:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, ensure that Personal Address Book is selected.

3 Click Export.

4 Save the .csv file to your computer.

5 Open the .csv file that you saved in a spreadsheet program, such as Microsoft 
Excel.

6 Optional. If contact information exists in the file, you can delete it.

7 Specify information about the new contacts in the .csv file.

Important If you add a new contact, ensure that the UID field is blank.

For information about the fields in the .csv file, see About the Contact 
Information CSV template on page 310.

8 Save the .csv file. Ensure that you save it as a .csv file.

To import a CSV file containing new contact information:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, ensure that Personal Contacts is selected.

3 In the Import From drop-down list, select Comma Delimited Files.

4 Click Import.

5 Select the .csv file in which you added new contact information.

6 Click Open.

7 Click Upload File.

The View Personal Contacts page appears, allowing you to review the contact 
information you are importing.

8 Click Submit.

A confirmation message appears.

9 Click Yes.

Note If an error exists in any new or updated contact information, a message 
appears, informing you that no contact information was imported.
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About the Contact Information CSV template

How to access this template

On your Meeting Center Web site, click My WebEx > My Contacts > View > 
Personal Address Book > Export.

What you can do here

Specify information about multiple contacts, which you can then import to your 
personal address book.

Fields in this template

Option Description

UUID A number that your Meeting Center site creates to identify the contact. If you 
add a new contact to the CSV file, you must leave this field blank.

Name Required. The contact's first and last name.

Email Required. The contact’s email address. The email address must be in the 
following format:

name@company.com

Company The company or organization for which the contact works.

JobTitle The contact's position in a company or organization.

URL The URL, or Web address, for the contact's company or organization.

OffCntry The country code for the contact’s office phone—that is, the number that you 
must dial if the contact resides in another country.

OffArea The area or city code for the contact's office phone number.

OffLoc The contact’s office phone number.

OffExt The extension for the contact’s office phone number, if any.

CellCntry The country code for the contact’s cellular or mobile phone—that is, the 
number that you must dial if the contact resides in another country.

CellArea The area or city code for the contact's cellular or mobile phone number.

CellLoc The contact’s cellular or mobile phone number.

CellExt Thee extension for the contact’s cellular or mobile phone number, if any.

FaxCntry The country code for the contact’s fax number—that is, the number that you 
must dial if the contact resides in another country.

FaxArea The area or city code for the contact's fax number.

FaxLoc The contact’s fax number.

FaxExt The extension for the contact’s fax machine, if any.

Address 1 The contact's street address.

Address 2 The additional address information, if necessary.

State/Province The contact's state or province.
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Importing contact information from Outlook to your address 
book

If you use Microsoft Outlook, you can import the contacts that you maintain in 
your Microsoft Outlook address book or folder to your personal address book on 
your Meeting Center Web site. 

To import contacts from Outlook to your personal address book:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, select Personal Contacts.

3 In the Import from drop-down list, select Microsoft Outlook.

4 Click Import.

The Choose Profile dialog box appears.

5 In the Profile Name drop-down list, select the Outlook user profile that includes 
the contact information that you want to import.

6 Click OK.

Note

■ When you import contacts in Outlook, your Meeting Center Web site retrieves 
contact information from the Outlook address book or folder in which you have 
chosen to keep personal addresses. For information about keeping personal 
addresses in Outlook, refer to Microsoft Outlook Help. 

■ If your personal address book already includes a contact who is also in your 
Outlook contacts list, the contact is not imported. However, if you change the 
contact's email address in your personal address book, importing the contact 
from Outlook creates a new contact in your personal address book.

Viewing and editing contact information in your address book

In your personal address book, you can view and edit information about individual 
contacts in your Personal Contacts list. You can view, but not edit, information 
about contacts in your Company Address Book.

ZIP/Postal The contact's ZIP or postal code.

Country The country in which the contact resides.

Username The user name with which the user logs in to your Meeting Center Web site, 
if the contact has a user account.

Notes Any additional information about the contact.

Option Description
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To view or edit contact information:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, select one of the following:

■ Personal Contacts

■ Company Address Book

A list of contacts appears.

3 Locate the contact whose information you want to view or edit. For details about 
locating a contact, see Finding a contact in your personal address book on 
page 312.

4 Under Name, select the contact whose information you want to view or edit.

5 Do one of the following:

■ If the contact is in your Personal Contacts list, click Edit.

■ If the contact is in your Company Address Book, click View Info.

Information about the contact appears.

6 Optional. If the contact is in your Personal Contacts list, edit the information 
that you want to change on the Edit Contact's Information page.

For descriptions of the information and options of the Edit Contact's 
Information page, see About the New/Edit Contact page.

7 Click OK.

Finding a contact in your personal address book

You can quickly locate a contact in your personal address book, using one of several 
methods.

To search for a contact in your address book:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, select a contacts list. 

3 Do any of the following:

■ In the Index, click a letter of the alphabet to display a list of contacts whose 
names begin with that letter. For example, the name Susan Jones appears 
under S.

■ To search for a contact in the list you are currently viewing, type text that 
appears in either the contact's name or email address in the Search for box, 
and then click Search.

■ If the entire list of contacts does not fit on a single page, view another page by 
clicking the links for the page numbers.
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■ Sort your personal contacts or company address book by name, email 
address, or phone number by clicking the column headings.

Creating a distribution list in your address book

You can create distribution lists for your personal address book. A distribution list 
includes two or more contacts for which you provide a common name and appears 
in your Personal Contacts list. For example, you can create a distribution list named 
Sales Department, which includes contacts who are members of your Sales 
Department. If you want to invite members of the department to a meeting, you can 
select the group rather than each member individually.

To create a distribution list:

1 Open your address book. For details, see Opening your address book on page 305.

2 Click Add Distribution List.

The Add Distribution List page appears. 

3 In the Name box, type the name of the group.

4 Optional. In the Description box, type descriptive information about the group.

5 Under Members, locate the contacts that you want to add to the distribution list, 
by doing any of the following:

■ Search for a contact, by typing all or part of the contact’s first or last name in 
the Search box.
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■ Click the letter that corresponds to the first letter of the contact’s first name.

■ Click All to list all contacts in your Personal Contacts list.

6 Optional. To add a new contact to your Personal Contacts list, under Members, 
click Add Contact.

7 In the box on the left, select the contacts that you want to add to the distribution 
list.

8 Click Add to move contacts you selected to the box on the right.

9 After you finish adding contacts to the distribution list, click Add to create the 
list.

In your Personal Contacts list, the Distribution List indicator appears to the left 
of the new distribution list:

For descriptions of the information and options on the Add Distribution List page, 
see About the Add/Edit Distribution List page on page 315.

Editing a distribution list in your address book

You can add or remove contacts from any distribution list that you have created for 
your personal address book. You can also change a group's name or descriptive 
information.

To edit a distribution list:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, select Personal Contacts.

A list of the contacts in your Personal Contacts list appears, including any 
distribution lists that you have created. The Distribution List indicator appears 
to the left of a distribution list:

3 Under Name, select the name of the distribution list. the check box for the group 

The Edit Distribution List page appears.

Distribution List indicator

Distribution List indicator
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4 Edit information about the distribution list. 

5 Click Update.

For descriptions of the information and options on the Edit Distribution List page, 
see About the Add/Edit Distribution List page on page 315.

About the Add/Edit Distribution List page

How to access this page

On your Meeting Center Web site, click My WebEx > My Contacts > Add 
Distribution List. Or, select distribution list in Personal Contacts list.

What you can do here

Enter information about a new or existing distribution list for your personal 
address book.

Options on this page

Use this option... To...

Name Enter the name of the distribution list. For example, if you want to 
add a distribution list that includes members of your company’s 
sales department, you might name the list Sales Department.
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Deleting contact information in your address book

You can delete any contact or distribution lists that you have added to your personal 
address book.

To delete a contact or contact group:

1 Open your address book. For details, see Opening your address book on page 305.

2 In the View drop-down list, select Personal Contacts.

3 In the list that appears, select the check box for the contact or distribution list 
that you want to delete.

4 Click Delete.

A message appears, asking you to confirm the deletion.

5 Click OK.

Maintaining your user profile

Description Optionally enter descriptive information about the distribution list, to 
help you identify it later.

Search Find a contact, by typing all or part of the contact’s first or last 
name.

Index Find a contact, by clicking the letter that corresponds to the first 
letter of the contact’s first name. To list contacts for which you 
identified with a number, click #. To list all contacts in your Personal 
Contacts list, click All.

Add Add a one or more selected contacts to your distribution list.

Remove Remove one or more selected contacts from your distribution list.

Add Contact Add a new contact to your Personal Contacts list and add the 
contact to your distribution list.

Add Add a new distribution list to your Personal Contacts list.

Update Update an existing distribution list that you have edited.

Use this option... To...

If you want to... See...

get an overview of maintaining your user 
profile

About maintaining your user profile on 
page 317

edit your user profile Editing your user profile on page 317
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About maintaining your user profile

Once you obtain a user account, you can edit your user profile at any time to do the 
following: 

■ Maintain personal information, including your

Full name

User name (if your site administrator provides this option)

Password

Contact information (including your street address, email address, and 
phone numbers)

Tracking codes that your organization uses to keep records of your meetings 
(such as project, department, and division numbers) 

■ Specify whether to display links to your company’s partner sites in the My 
WebEx navigation bar, if your site administrator set up partner links

■ Manage any scheduling templates that you saved

■ Set options for your Personal Meeting Room options, including the images and 
welcome message that appear on the page

■ Set default options for your online sessions, including

Whether your scheduled meetings are automatically removed from your list 
of meetings once the meeting ends

The default session type that you want to use, if your account includes 
multiple session types

Whether the Quick Start page appears in the content viewer once you start a 
meeting

The users who can schedule meetings on your behalf

■ Set Web site preferences, including:

The home page that appears when you access your Meeting Center Web site

The time zone in which meeting times appear

The language in which your Web site displays text, if your site includes 
multiple languages

The locale (the format in which your Web site displays dates, times, currency 
values, and numbers)

Editing your user profile

Once you obtain a user account, you can edit your user profile at any time to change 
account login information, contact information, and other options available for 
your account.
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To edit your user profile:

1 Log in to your Meeting Center Web site. For details, see Logging in to and out of 
the Meeting Center site on page 273.

2 On the navigation bar, click My WebEx.

3 Click My Profile.

4 Edit the information on the page.

5 When you are finished editing your user profile, click Update.

For descriptions of the information and options on the My Profile page, see About 
the My WebEx Profile page on page 318.

About the My WebEx Profile page

How to access this template

On your Meeting Center Web site, click My WebEx > My Profile.

What you can do here 

Manage the following:

■ Account information

■ Personal information

■ Partner integration options

■ Scheduling templates

■ Personal Meeting Room information

■ Productivity Tool information (for new Productivity Tools users only)

■ Session options

■ Web page preferences, including your home page and language

Personal information options

Use this option.... To....

User name Specify the user name for your account. You can change this 
name only if the administrator for your Meeting Center Web site 
provides this option.

Tip If you need to change your user name, but cannot edit it on 
this page, ask your site administrator to change your user name 
or create a new account for you.
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Partner integration options

Your site administrator can set up custom links to the Web sites of your company’s 
partners, and then display the links on the My WebEx navigation bar. For example, 
if your company uses another company’s Web site to provide a service, your site 
administrator can provide a link to that company’s site in your My WebEx 
navigation bar. You can then show or hide that link.

Password Specify the password for your account. A password:

■ Must contain at least four characters

■ Can consist of a maximum of 32 characters

■ Can include any letters, numbers, or special characters, but 
not spaces

■ Is case sensitive

Confirm password Verify that you typed your password correctly in the Password 
box.

Call-in authentication If enabled by your site administrator, allows you to be 
authenticated and placed into the correct teleconference without 
needing to enter a meeting number whenever you dial into any 
CLI (caller line identification) or ANI (automatic number 
identification) enabled teleconference. Selecting this option for a 
phone number in your user profile maps your email address to 
that phone number. Caller authentication is available only if you 
have been invited to a CLI/ANI enabled teleconference by email 
during the meeting scheduling process. Caller authentication is 
not available if you are dialing in to a CLI/ANI enabled 
teleconference.

Call-back When selected for a phone number in your user profile, allows 
you to receive a call from the teleconferencing service if it is using 
an integrated call-back feature. If your site includes the 
international call-back option, participants in other countries 
receive a call back. For more information about this option, ask 
your site administrator.

Call-in authentication 
PIN

If enabled by your site administrator, allows you specify a call-in 
authentication PIN to prevent “spoofers” from using your number 
to dial into a teleconference. If your site administrator sets the 
authentication PIN as mandatory for all accounts using call-in 
authentication on your site, you must specify a PIN number or 
caller authentication will be disabled for your account. This option 
is available only if you have selected the Call-in authentication 
option for at least one of the phone numbers in your profile.

Other personal 
information options

Enter any personal information that you want to maintain in your 
profile.

Use this option.... To....

Display partner links in 
My WebEx

Shows or hides partner site links in the My WebEx navigation 
bar.

Use this option.... To....
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Scheduling template options

Use these options to manage scheduling templates that you set up using the 
scheduling options on your site.

Personal Meeting Room options

Use this option.... To....

Get Info Shows the settings you set for the selected template.

Edit Opens the scheduling options on your site for the selected 
template.

Delete Removes the selected template from your profile.

Select All Selects all the scheduling templates, allowing you to delete them 
all at once.

Use this option.... To....

Personal Meeting Room 
URL

Go to your Personal Meeting Room page.

Your Personal Meeting Room page shows online sessions that 
you scheduled and any in-progress sessions that you are 
currently hosting.

Users to whom you provide your personal URL can use this page 
to join any meeting that you are hosting. They can also download 
files in any folders that you share.

Welcome Message Enter the message that appears on your Personal Meeting Room 
page. A message can be a maximum of 128 characters, 
including spaces and punctuation.

To specify a message, type it in the box, and then click Update.

Upload Image Upload an image file from your computer or another computer on 
your network to your Personal Meeting Room page. For 
example, you can upload a picture of yourself, your company's 
logo, or a picture of your company's product. Visitors to your 
page can see the image that you upload.

The image can be an maximum of 160 pixels wide. If you upload 
a larger image, its width is automatically reduced to 160 pixels. 
However, the image's aspect ratio is maintained.

Browse: Lets you locate an image.

Upload: Uploads the image that you selected.

Current Image: Displays the image that currently appears on 
your Personal Meeting Room page.

Delete: Removes the current image from your Personal Meeting 
Room page. This button is available only if you have uploaded an 
image for the page.
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Productivity Tools options

For new Productivity Tools users only

For more information about WebEx One-Click and Productivity Tools, refer to the 
WebEx One-Click User’s Guide, which is available from the User Guide page in the 
Support section.

Session options

Customize branding of 
header area

Upload a banner image to the non-scrolling header area for your 
Personal Meeting Room page. For example, you can upload your 
company's logo or an advertisement. Visitors to your page can 
see the image that you upload. Available only if your site 
administrator has turned on this option for your account.

The image can be an maximum of 75 pixels high. If you upload a 
larger image, its height is automatically reduced to 75 pixels. 
However, the image's aspect ratio is maintained.

Browse: Lets you locate a banner image.

Upload: Uploads the banner image that you selected.

Current Image: Displays the banner image that currently 
appears on your Personal Meeting Room page.

Delete: Removes the current banner image from your Personal 
Meeting Room page. This button is available only if you have 
uploaded an image for the page.

Use this option.... To....

Automatically download 
Productivity Tools when 
logging in to WebEx 
service site

Specify that WebEx Productivity Tools should be downloaded 
automatically when you log in to the WebEx service site. If this 
option is turned off, you can still download Productivity Tools 
manually.

Use this option.... To....

Automatically delete 
meetings from My 
Meetings when 
completed

Specify that once a scheduled meeting ends, the meeting is 
automatically removed from your list of scheduled meetings on 
the My Meetings page, if the scheduled starting time has passed. 
If you do not select this option, the meeting remains on your list 
of meetings until you delete it.

You can change this default setting when scheduling a meeting.

Default session type Specify the default session type that you host, if your user 
account lets you host different types of online sessions.

For more information about session types, ask the site 
administrator for your WebEx service.

You can change this default setting when scheduling a meeting.

Use this option.... To....
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Web page preferences

Managing scheduling templates

Quick Start Specify whether the Quick Start page appears in the content 
viewer once you start a meeting. The Quick Start lets you start 
sharing activities quickly, as an alternative to starting them from 
a menu or toolbar.

■ Show Quick Start to host and presenter: The Quick Start 
appears in the content viewer for the host and presenter.

■ Show Quick Start to attendees: The Quick Start appears in 
the content viewer for attendees. Select this option only if you 
intend to let attendees share information during your 
meetings.

You can change this default setting when scheduling a meeting.

Scheduling permission Type the email addresses for any users whom you want to let 
schedule meetings for you. Separate email addresses with either 
a comma or a semicolon.

Select From Host List: Open the Select Host page, which 
contains a list of all users who have accounts on your Meeting 
Center Web site. On this page, you can select users whom you 
want to let schedule meetings for you.

Use this option.... To....

Home page Set the first page that appears when you access your Meeting Center 
Web site.

Time zone Set the time zone in which you reside.

If you select a time zone for which daylight saving time (DST) is in effect, 
your Meeting Center Web site automatically adjusts its clock for daylight 
saving time

Note The selected time zone appears:

■ Only on your view of your Meeting Center Web site, not other users' 
views 

■ In all meeting invitations that you send using your Meeting Center 
Web site

Language Set the language in which your Meeting Center Web site displays text.

Note The languages that appear in this list are limited to the languages 
that have been set up for your Web site.

Locale Set the format in which your Web site displays dates, times, currency 
values, and numbers.

Use this option.... To....

If you want to... See...

get an overview of managing your scheduling 
templates

About managing scheduling templates on 
page 323
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About managing scheduling templates

Scheduling templates let you save the options you set for a meeting for later use. 
Once you save a scheduling template, you can use it to quickly schedule another 
meeting, instead of setting the same options again. If you saved a scheduling 
template using the Save As Template option when scheduling a meeting, you can 
manage the template, as follows:

■ View the options you set in the template.

■ Edit the options you set in the template.

■ Delete the template.

Managing scheduling templates

You can view, edit, or delete any scheduling templates that you saved.

To manage scheduling templates:

1 Log in to your Meeting Center Web site. For details, see Logging in to and out of 
the Meeting Center site on page 273.

2 On the navigation bar, click My WebEx.

3 Click My Profile.

The My Profile page appears. 

4 Under Scheduling Templates, select a template in the list.

5 Click one of the following buttons to perform an action on the template:

■ Get Info: Shows the options you set in the template.

■ Edit: Opens the scheduling options on your site.

■ Delete: Removes the template from your profile.

view, edit, or delete a scheduling template Managing scheduling templates on page 323

If you want to... See...
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Viewing MeetingPlace audio conference numbers
You can view your Cisco Unified MeetingPlace account information from the My 
Audio page in My WebEx. Along with your telephone numbers, your Cisco Unified 
MeetingPlace profile number is displayed here.

When the directory service integration is enabled for your site, an Edit 
MeetingPlace Profile link will be available from the My Audio page. Click this link 
to launch a MeetingPlace site in a new browser, where you can edit your 
MeetingPlace profile.

About the My Audio page for Cisco Unified MeetingPlace users

How to access this page

On your Meeting Center Web site, click My WebEx > My Audio.

What you can do here 

■ View phone numbers for your Cisco Unified MeetingPlace account

■ View your Cisco Unified MeetingPlace profile number

■ Navigate to your MeetingPlace site, where you can edit your MeetingPlace 
profile (directory integration service only)

Maintaining personal conference numbers

About maintaining personal conference number accounts

If your Meeting Center Web site includes the Personal Conference Number (PCN) 
option, you can create up to three PCN accounts. When scheduling an online 
meeting or an audio-only meeting, you can select a PCN account to use for your 
teleconference. You can also use your PCN account to start an instant 
teleconference from any phone, without scheduling it first.

If you want to... See...

get an overview of maintaining your personal 
conferencing number (PCN) accounts

About maintaining personal conference 
number accounts on page 324

add or edit a PCN account to obtain 
conferencing numbers or specify access 
codes

Adding or editing a personal conference 
number account on page 325

use your PCN account Using your personal conference numbers on 
page 328

delete a PCN account Deleting a personal conference number 
account on page 330
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Your PCN account also specifies the access code that you want to use to start the 
teleconference, and the access codes that you want attendees to use to join the 
teleconference.

You can delete a personal teleconferencing account at any time.

Adding or editing a personal conference number account

You can add up to three personal conference number (PCN) accounts. You can edit 
a PCN account at any time to change the following:

■ The access code that you want to use to start a teleconference 

■ The access codes that you want participants to use to join the teleconference

To add or edit a PCN account:

1 Log in to your Meeting Center Web site, and then click My WebEx.

2 Click My Audio.

The My Audio page appears.

3 Click Create personal conference number or, if you have already added an 
account, click Edit.

The Create/Edit Personal Conference Number page appears.
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4 Edit the information on the page.

5 When you are finished add or editing the account, click OK or Update.

For descriptions of the information and options on the My Audio page, see the 
topic About the My Audio page on page 326.

For descriptions of the information and options on the Create/Edit Personal 
Conference Number page, see the topic About the Create/Edit Personal Conference 
Number page on page 327.

About the My Audio page

How to access this page

On your Meeting Center Web site, click My WebEx > My Audio.

What you can do here 

■ Add, edit, or delete a personal conference number (PCN) account. 

■ View information about your existing PCN accounts.
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Options on this page

About the Create/Edit Personal Conference Number page

How to access this page

On your Meeting Center Web site, click My WebEx > My Audio > Create personal 
conference number or Edit.

What you can do here 

Specify the teleconference access codes for that you must provide to start a 
teleconference or that attendees must provide to join the teleconference.

Use this option.... To....

Create personal 
conference number

Open the Create Personal Conference Number page, on which 
you can obtain a personal conference number (PCN) account. 
Appears only if you have not yet added the maximum of three 
accounts.

With a PCN account, you can use the same conference numbers 
for all your meetings, including audio-only meetings that you 
schedule on your Meeting Center Web site or that you start 
instantly from a phone. 

A PCN account also lets you specify the access codes that you 
want to use to start the teleconference, and the access codes 
that you want attendees to use to join the teleconference.

For details about the information in a personal teleconferencing 
account, see About the Create/Edit Personal Conference 
Number page on page 327.

Account [x] View information about each of your personal conference 
number (PCN) accounts.

Default account: Indicates that the PCN account is the default 
account that is selected when you schedule a audio-only 
meeting.

Set as default: If you set up more than one PCN account, you 
can click this link to specify which account is your default 
account.

Edit Open the Edit Personal Conference Number page, on which you 
can change the access codes for your PCN account.

For details about the information in a PCN account, see About 
the Create/Edit Personal Conference Number page on 
page 327.

Delete Delete the personal conference number (PCN) account from 
your user profile.

Important If you delete a PCN account that you have already 
selected for a scheduled a meeting, you must edit the meeting to 
select another PCN account or voice-conferencing option. 
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Using your personal conference numbers

Once you add a personal conference number (PCN) account, the account 
information provides the call-in numbers and access codes that you and attendees 
use to participate in a teleconference. 

You can use your PCN account to:

■ Provide teleconferencing for your online meetings

■ Provide teleconferencing for your scheduled audio-only meetings

■ Start an instant, unscheduled teleconference from any phone

Use this option... To...

Host access code Specify the access code that you must enter when you start a 
teleconference, either as part of an online meeting or for a 
audio-only meeting.

This code must be 8 digits in length.

Attendee access code 
(Full speaking)

Specify the access code that attendees with full-speaking access 
must enter to join the teleconference.

Attendees with full-speaking access have permission to speak 
during the teleconference. You can specify which attendees have 
full-speaking access when inviting them to your online meeting or 
audio-only meeting.

You can mute and unmute attendees’ microphones with 
full-speaking access at any time. Attendees can also mute and 
unmute their own microphones.

This code must be 8 digits in length.

Attendee access code 
(Listen only)

Specify an access code that attendees with listen-only access 
must enter to join the teleconference. Applies only to audio-only 
meetings (standalone teleconferences).

Attendees with listen-only access cannot speak during the 
teleconference. You can specify which attendees have 
listen-only speaking access when inviting them to your online 
meeting or audio-only meeting.

Attendees can request to speak at any time during the meeting. 
You can allow an attendee with listen-only access to speak by 
unmuting his or her microphone.

This code must be 8 digits in length. 

Phone numbers View the phone numbers that you and attendees call to join the 
teleconference. The phone numbers that are available depend 
on the options that your WebEx service includes and the options 
that your site administrator selected for your user account. 

If your user account has the global call-in numbers option, the 
Show all global call-in numbers link appears. This option 
provides a list of numbers—such as toll-free or local numbers—
that attendees in other countries can call to join the 
teleconference.
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To use your PCN account for an online meeting:

1 Simply select a PCN account when setting up teleconferencing options for your 
online meeting.

Once you start the meeting, information about the teleconference appears on all 
participants’ screens.

2 Dial the appropriate call-in number.

3 Follow the voice instructions to provide your access code.

Attendees call the appropriate call-in number on their screens, and then enter the 
attendee access code.

To use your PCN account for a scheduled audio-only meeting:

1 When scheduling your meeting, select the Teleconference-Only session type. 

2 Select a PCN account when setting teleconferencing options for the meeting.

3 At the scheduled time, dial the call-in number for your PCN account.

4 Follow the voice instructions to provide your access code.

Each invited attendee receives an email message containing the call-in number and 
the attendee access code that you assigned to him or her.

To use your PCN account to start an instant teleconference from any phone:

1 Dial the call-in number for your PCN account.

2 Follow the voice instructions to provide your access code.

Once you start your teleconference, attendees can join it, by dialing the call-in 
number and entering the access code that you provide to them.

Controlling an audio-only meeting

If you use your personal conference number (PCN) account to start an audio-only 
meeting (standalone teleconference), you and attendees can use the following 
keypad commands:

Host commands

To.... Enter...

Dial the phone number of a participant whom you want 
to add to the teleconference

*1

Lock the teleconference, preventing anyone else from 
joining it

*5

Unlock the teleconference *5

Mute your microphone *6

Unmute your microphone *6
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Attendee commands

Deleting a personal conference number account

You can delete a personal conference number (PCN) account at any time.

To delete a PCN account:

1 Log in to your Meeting Center Web site, and then click My WebEx.

2 Click My Audio.

The My Audio page appears, showing your PCN accounts.

3 Under the account that you want to delete, click Delete.

A confirmation message appears.

4 Click OK.

Generating reports

About generating reports

If your user account includes the reports option, you can view the following reports:

Let participants continue the teleconference without 
the host

*8
Then hang up your phone.

Mute all attendees with full-speaking access ##

Unmute all attendees with full-speaking access 99

Play the participant count *#

Hear all keypad commands that you can use **

To... Enter...

Mute your microphone *6

Unmute your microphone *6

Play the participant count *#

Hear all keypad commands that you can use **

To.... Enter...

If you want to... See...

get an overview of what reports you can 
generate from your Meeting Center Web site

About generating reports on page 330

generate usage reports that provide 
information about each session that you have 
hosted on your site

Generating reports on page 331
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General Meeting Usage reports

These reports contains information about each online session that you host. You 
can view the following reports:

■ Summary Usage report: Contains summary information about each meeting 
including topic, date, start and end time, duration, number of attendees you 
invited, number of invited attendees who attended, and type of voice conference 
you used.

■ Summary Usage report CSV (comma-separated values) file: Contains 
additional details about each meeting, including the minutes that all participants 
were connected to the meeting and tracking codes.

■ Session Detail report: Contains detailed information about each participant in 
a meeting, including the time the participant joined and left the meeting and any 
information that the attendee provided.

Access Anywhere usage report

This report shows information about the computers that you access remotely, 
including the date and start and end times for each session.

Generating reports

You can generate usage reports that provide information about each online meeting 
that you have hosted on your site.

You can export or download the data to a comma-separated values (CSV) file which 
you can then open in a spreadsheet program such as Microsoft Excel. You can also 
print reports in a printer-friendly format.

To generate a report:

1 Log in to your Meeting Center Web site, and then click My WebEx.

2 Click My Reports.

The My Reports page appears.

3 Choose the type of report you want to generate.

4 Specify your search criteria, such as a date range for which you want to view 
report data.

Note  Only three months of report data is available.

Tip You can use wildcards, such as ? or *, when specifying a text string.

5 Click Display Report.
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6 To change the order in which report data is sorted, click the column headings.

The report data is sorted by the column that has an arrow next to the column 
heading. To reverse the sort order, click the column heading. To sort using 
another column, click that column’s heading.

7 Do one of the following, as appropriate:

■ If you are viewing a general meeting usage report and want to display the 
report in a format that is suitable for printing, click Printer-Friendly Format.

■ If you are viewing the usage report for an a meeting and want to view the 
content in the report, click the link for the meeting name.

8 To export the report data in comma-separated values (CSV) format, click 
Export Report or Export.

9 If available, click links on the report to display more details.
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personal conference number account 325
scheduled meetings 76

email invitations
description 54

email messages
registering for meetings 12

ending
Integrated VoIP conference 146
meeting 129

enlarging
video images 262

eraser
using to delete annotations on shared software 

211
Eraser tool

overview 156
erasing

all annotations on shared documents 171
all pointers on shared documents 172
selected annotations on shared documents 171
your annotations on shared documents 171
your pointers on shared documents 172

exchanging files
during a meeting 242
during an event 242
during meeting 241

expanding
panels 107

expelling
attendee from meeting 127

F

files
.atp 237, 239
.txt 238, 239
.ucf (Universal Communications Format) for 

multimedia 174
.wav for chat sounds 225
choosing sounds for alerts 131
choosing sounds for participant actions 131
deleting from personal folders 293
downloading from personal folders 292
editing information about in personal folders 291
exchanging during a meeting 242
exchanging during an event 242
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exchanging during meeting 241
for chat 227
for poll questionnaire 237
for poll questionnaires 239
for poll results 238, 239
maintaining in personal folders, overview 287
moving or copying in personal folders 290
playing sounds for chat messages 225
searching in personal folders 292
sharing on Personal Meeting Room page 286
stop publishing during meeting 241
uploading to personal folders 289

Flash files
sharing as Web content 180

floating
panels in full-screen view 111

folders, personal
adding new for file storage 289
deleting files 293
downloading files 292
editing information about files 291
moving files 290
opening 288
overview 287
searching for files 292
uploading files 289

font
selecting for annotations 171

frame rate
specifying for video 258

full-screen view
accessing panels 110
of live video 263
of shared software, controlling 203
sharing 112
viewing floating panels 111

Full-Screen View tool
overview 156

full-screen view, controlling in
shared document 169
shared presentation 169
shared whiteboard 169

G

generating reports 330, 331
global call-in numbers 139
granting

privileges to attendees during meeting 134
greeting

creating for attendees 126
editing during meeting 126

group results, for poll

saving 238

H

header, custom
adding to Personal Meeting Room page 285

hiding
contents of screen on shared remote computer 

199
Highlighter tool

overview 156
high-resolution color in shared application ensuring 

good imaging 220
home page for site

setting 317
host key

using to reclaim host role 124
host role

reclaiming 124
transferring to another attendee 124

hosts
alternate 54

I

images
adding to Personal Meeting Room page 285

images, pasting in shared
documents 167
presentations 167
whiteboards 167

importing
contacts to address book from file 308
contacts to address book from Outlook 311

incoming chat messages
choosing sound alerts 225

individual results, for poll
saving 238

Info tab display
selecting for meeting 62

information on meeting
obtaining 125

installing
Meeting Manager 3
WebEx One-Click 93, 94

instructions
teleconference 140

integrated call-back teleconferences
definition 51

integrated call-in teleconferences
definition 51

Integrated VoIP conference
about 145
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asking to speak 147
canceling request to speak 147
ending 146
joining 146
leaving 146
letting participants speak 147
muting and unmuting microphones 149
muting and unmuting participant’s microphone 

149
muting and unmuting your microphone 150
setting options 151
speaker queue, overview 150
starting 146
using microphone 148

Internet phone conference
definition 51
requirements 51

inviting
attendees to meeting in progress 122
participants to teleconference 138

inviting attendees
email message contents 54

J

joining
Integrated VoIP conference 146
teleconference 139

joining meetings
from email invitations 8
from host’s personal page 10
from meeting calendar 9
using meeting number 11

K

keyboard
disabling on shared remote computer 199

keypad controls
for audio-only meeting 329

L

language and locale for site
setting 317

leaving
Integrated VoIP conference 146
meetings 127
teleconference 140

Line tool
overview 156

list of meetings, personal

maintaining 276
opening 275
overview 274

locking
access to meeting 127
shared remote computer 200

logging in to and out from site 273

M

magnification, changing for shared
pages 168
slides 168
whiteboards 168

maintaining
contact information, overview 305
files in your personal folders, overview 287
personal conference number accounts, over-

view 324
personal list of meetings 276
Personal Meeting Room page, overview 283
user profile, overview 317

making
another participant the host 124
another participant the presenter 123

managing meetings
overview 119

manual installer
Meeting Manager 3

media players for UCF media files
checking if installed on computer 5

meeting calendar
Daily view 20
Monthly view 20
obtaining information 15
opening 20
overview 19
refreshing 23
registering for meetings 13
removal of meetings 19
searching for meeting 22
selecting date 20
selecting time zone 23
sorting 22
Today view 20
Weekly view 20

Meeting Manager
overview 1
setting up 3
system requirements 2
uninstalling 4

meeting minutes
saving to file 251
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taking during meeting 249
meeting number

using to join meetings 11
meeting service

setting up Meeting Manager 3
setting up Meeting Manager, overview 1
system requirements 2

meeting transcripts
sending to participants 128

Meeting window
content viewer 100

meeting, scheduling
Review page overview 69

MeetingPlace 92, 324
meetings

canceling 78
editing 76
ending 129
how to schedule 39
inviting attendees to meeting in progress 122
leaving 127
managing 119
obtaining information 15
registering 14
restricting access 127
scheduling for host 39
searching for on meeting calendar 22
See also scheduling meetings

meetings, joining
from email invitations 8
from host’s personal page 10
from meeting calendar 9
using meeting number 10

menu bar
overview 102

message
adding to Personal Meeting Room page 285

microphone
muting and unmuting a specific microphone 142
muting and unmuting all 142
muting and unmuting for participant in Integrated 

VoIP conference 149
muting and unmuting participants automatically 

141
muting and unmuting your own in Integrated 

VoIP conference 150
muting and unmuting your own in teleconfer-

ence 143
passing to participant in Integrated VoIP confer-

ence 147
using in Integrated VoIP conference 148

Microsoft PowerPoint presentations, shared
viewing slide titles 162

miniatures, viewing

of shared whiteboards 169
shared pages 169
shared slides 169

minimizing
panels 105

mouse
disabling on shared remote computer 199

moving
between pages in document 176
files in personal folders 290

MSN Messenger
inviting attendees to meeting in progress 122

multimedia
sharing as Web content 180

multipoint video
specifying for meeting 266

muting
a specific microphone 142
all in teleconference 142
in Integrated VoIP conference 149
participant’s microphone in Integrated VoIP con-

ference 149
your microphone in Integrated VoIP conference 

150
your microphone in teleconference 143

My Audio page
options 324, 326

My Computers
using 287

My Contacts
adding contacts 306
creating contact group 313
deleting contacts 316
editing contact group 314
importing contacts from file 308
importing contacts from Outlook 311
opening 305
searching for contacts 312
using, overview 305
viewing or editing contact information 311

My Documents page
options 293

My Files
adding folders 289
deleting files 293
downloading files 292
editing information about files 291
maintaining, overview 287
moving or copying files or folders 290
opening 288
searching for files 292
uploading files 289

My Meetings
maintaining 276
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opening 275
overview 274

My Meetings - All Meetings tab
options 281

My Meetings - Daily tab
options 277

My Meetings - Monthly tab
options 281

My Meetings - Weekly tab
options 279

My Meetings page
options 276

My Profile
editing 317
overview 317

My Profile page
options 318

My Recorded Meetings page
options 299

My Recordings page
options 298

My WebEx
overview 272

N

navigating
shared pages 162
shared slides 162
shared whiteboards 162

New Contact page
options 307

note taker
choosing 247

notes
meeting minutes 249
options for meetings 246
overview 248
saving to file 251
taking personal 249
transcribing closed captions 250
turning on or off during a meeting 246

O

One-Click Meeting
overview 89
removing shortcuts 98
setting up 90
setting up on service Web site 90
starting from Meeting Center 96
starting from service Web site 95

One-Click Meeting Setup Wizard

options 91
One-Click panel

removing from computer 98
One-Click Settings page

descriptions 91
One-Click shortcuts

removing from computer 98
opening

.txt files 239
address book 305
chat file 228
list of your recordings 297
meeting calendar 20
personal folders 288
personal list of meetings 275
poll questionnaire file 239
poll questionnaires 235
poll results file 239
saved document 175
saved presentation 175
saved whiteboard 175
shared documents 158
shared presentations 158
shared whiteboard 161
user profile 317

options
for Integrated VoIP conference 151
for panels 108
for taking notes 246
specifying for video in meeting 266
video, setting 259

Outlook
adding meetings 16

P

pages, of shared documents
adding new 166
checking participant readiness 158
clearing annotations 171
clearing pointers 172
controlling full-screen view 169
displaying 162
moving to previous 176
navigating 162
pasting images 167
printing 175
synchronizing display for all attendees 170
synchronizing view 177
viewing miniatures (thumbnails) 169
zooming in 168
zooming out 168

pages, of shared documents, moving to next 176
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panels
alerts 116
closing 107
collapsing 106
displaying in full-screen view 111
expanding 107
floating 111
in full-screen view 110
minimizing 105
minimizing all 106
overview 104
resetting 108
resizing 109
restoring 106
restoring all 106
returning to default settings 108
setting options 108

participant actions
choosing sound alerts 131

participants
allowing to speak in Integrated VoIP conference 

147
choosing to send live video 257, 267, 268
inviting to teleconference 138
muting and unmuting microphones in Integrated 

VoIP 149
Participants Ready indicator 158
password

requiring for meeting 38
pasting

images in content viewer 167
snapshots of live video in content viewer 269

pausing
software sharing 202

PCNow
see Access Anywhere

Personal Conference number
definition 48

personal conference number account
adding or editing 325
deleting 330
maintaining, overview 324
obtaining 325
using 328
using keypad controls during teleconference 

329
using to start teleconference 328

personal folders
adding new for file storage 289
deleting files or folders 293
downloading files 292
editing information about files 291
maintaining files, overview 287
moving or copying files 290

opening 288
searching for files or folders 292
uploading files 289

Personal Meeting Room page
add images and text 285
overview 283
setting options 285
sharing files 286
viewing 284

personal notes
saving to file 251
taking during meeting 249

personal pages
joining meetings from 10, 11
obtaining information about meetings 16
registering for meetings 14

picture
of live video, pasting in content viewer 269

pictures, pasting in shared
document 167
presentation 167
whiteboard 167

platform-specific client
setting up for Windows 3

pointer
using on shared software 211

Pointer tool
overview 156

pointers
clearing on shared software 212

pointers, clearing from
shared document 172
shared presentation 172
shared whiteboard 172

poll questionnaires
creating 232
deleting 234
opening 235
opening file for 239
preparing, overview 232
saving 237
sending in meeting transcript 128

poll questions or answers
changing type of, editing, rearranging, deleting 

233
poll results

opening file for 239
saving 238
sending in meeting transcript 128
sharing with participants 236
viewing after closing poll 236

polling
overview 231

preferences
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setting for site 317
preparing

poll questionnaires, overview 232
presentation sharing

closing presentations 161
navigating slides 162
starting 158
See also presentations, shared

presentations, shared
adding blank slides 166
annotating 171
clearing pointers 172
closing in content viewer 167
controlling full-screen view 169
displaying slides 162
navigating slides 162
pasting images 167
printing slides 175
saving to file 174
synchronizing display for all attendees 170
using animations 164
using slide transitions 164
viewing thumbnails of slides 169
zooming in 168
zooming out 168

presenter
selecting during meeting 123

printing
chat messages 226
pages in shared documents 175
shared whiteboards 175
slides in shared presentations 175

private notes
saving to file 251
taking during meeting 249
turning on for a meeting 246

privileges 134
assigning all 134
chatting privately 134
chatting with all attendees 134
chatting with host 134
chatting with presenter 134
contacting operator privately 134
granting to attendees during meeting 134
resetting to default 134
viewing any page 134
viewing participant list 134

profile, user
editing 317
maintaining, overview 317

public notes (meeting minutes)
saving to file 251
taking during meeting 249

publishing files

for downloading during meeting 241

R

reclaiming
host role 124

Recording Information page
options 303

recordings
editing information about 298
opening your list 297
uploading 297

Rectangle tool
overview 156

reducing
size of video images 262

reducing view
of shared pages or slides 168
of shared whiteboards 168

refreshing meeting calendar 23
registering

accepting requests 57
benefits 57
for meeting 57
overview 12

registering from
email messages 12
host’s personal page 14
meeting calendar 13

registration requests
accepting 57
rejecting 57

rejoining
teleconference 140

remote computer
setting up for Access Anywhere 287

remote computer sharing
overview 6, 193
starting 193
stopping 196

remote computer, shared
as attendee, switching between views 208
bringing application to the front 200
closing and reopening attendee window 206
controlling full-screen view 205
disabling and enabling keyboard and mouse on 

199
hiding contents of screen 199
locking and unlocking 200
logging in to and out from 200
managing, overview 197
reducing screen resolution 198
resizing view 205
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selecting additional applications 195
showing to attendees 193
zooming in or out 205

remote control, of shared software
granting to an attendee 218
letting attendees perform automatically 218
overview of 217
requesting from presenter 217
stopping 219

removing
attendee from meeting 127
Meeting Manager 4
personal teleconference number account 330
shortcuts for One-Click Meeting 98
WebEx One-Click from computer 98

reports
generating 331
generating, overview 330
types of 330

requirements
for Internet phone conference (VoIP) 51

resetting
panels 108

resizing
content viewer 109
panels 109

resolution
adjusting video image 258

restoring
panels 106

restricting
access to meeting 127

results, for poll
opening 239
saving 238

resuming
software sharing 202

S

saving
annotations on shared software 216
chat messages 227
copy of chat messages 228
documents, shared 174
notes to file 251
poll questionnaires 237
poll results 238
presentations, shared 174
shared documents 174
shared presentations 174
shared whiteboards 174
whiteboards, shared 174

scheduled meetings
adding attendees 76
changing agenda 76
changing day and time 76
editing 76
removing attendees 76
sending updated information to attendees 76

scheduling meetings
Agenda & Welcome page, overview 59
allowing attendees to download files 63
allowing attendees to record 63
allowing notes 63
and Microsoft Outlook 37
Attendee Privileges page, overview 67
enabling close captions 63
enabling video 63
enhancing security 38, 56
for someone else 39
Info tab 62
Invite Attendees page, overview 53
Meeting Options page, overview 63
overview 39
Personal Conference number 48
registration 57
Registration page, overview 56
Required Information page, overview 42
requiring password 38
selecting alternate host 42
selecting day and time 45
selecting document to share 62
selecting meeting type 42
setting duration 45
setting entry and exit tones 48
setting options 63
setting password 42
setting phone options 48
setting recurrence 45
showing feedback form to attendees 63
Teleconference Settings page, overview 48
using tracking codes 45

scheduling templates
about managing 323
managing 323

screen capture
taking of annotations on shared software 216

screen resolution
reducing for shared remote computer 198

searching
for contacts in address book 312
for files in personal folders 292
for meeting on meeting calendar 22

selecting
multiple participants to send video 262
one participant to send video 257, 267, 268
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presenter for meeting 123
template for Info tab 62

sending
chat messages 224
transcripts to participants 252

Session Detail report
description 331

setting
options for panels 108
video options 259

setting up
Meeting Manager 3
One-Click Meeting 90

setting up One-Click Meeting
on service Web site 90

shared remote computer. See remote computer, 
shared.

sharing
Flash files, as Web content 180
in full-screen view 112
poll results with participants 236
streaming audio, as Web content 180
streaming video, as Web content 180
tools in content viewer 100
Web browsers 180
Web content, overview 179

sharing a desktop. See desktop sharing.
sharing a remote computer. See remote computer 

sharing.
sharing a Web browser. See Web browser sharing.
sharing applications. See application sharing.
sharing desktops. See desktop sharing.
sharing documents. See documents, shared.
sharing window

as attendee, returning to 208
closing your attendee window 206
overview 184
returning attendees to while sharing software 

207
sharing, Web browsers

and changing presenters 123
shortcuts

for One-Click Meeting, downloading 93
shortcuts, for One-Click Meeting

removing 98
shortcuts, WebEx One-Click panel

downloading 94
single-point video

specifying for meeting 266
size

of video image, changing 262
slide titles

viewing while sharing 162
slides, in shared presentations

adding 166
checking participant readiness 158
clearing annotations 171
clearing pointers 172
controlling full-screen view 169
displaying 162
moving to next 176
moving to previous 176
navigating 162
pasting images 167
printing 175
synchronizing display for attendees 170
synchronizing view 177
viewing miniatures (thumbnails) 169
viewing title 162
zooming in 168
zooming out 168

snapshots
of live video, taking 269

software sharing
and changing presenters 123
tips for improving performance 221
See also software, shared

software, shared
allowing remote control 217, 218
and changing presenters 123
annotating 209, 210
as attendee returning to main window 208
changing annotation color 213
clearing annotations and pointers 212
controlling attendees’ views 201
controlling full-screen view 203, 205
ensuring good imaging of color 220
improving performance 221
letting attendees annotate 213
pausing and resuming 202
resizing view 205
returning to from Meeting window 207
stopping annotation mode 211
stopping attendees from annotating 215
stopping remote control 219
synchronizing views 204
using annotation tools 211
viewing 184

sorting
meeting calendar 22

sound alerts
assigning to chat messages 131
assigning to incoming chat messages 225
assigning to participant actions 131

sounds
assigning to incoming chat messages 225

speaker queue, for Integrated VoIP conference 150
speaker, in teleconference
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determining 144
Standard View tool

overview 156
starting

annotation mode for shared software 210
application sharing 186
Audio Only meeting before scheduled time 83
Audio Only meeting from email message 83
desktop sharing 190
document sharing 158
Integrated VoIP conference 146
meeting before scheduled time 77
meeting from email message 77
presentation sharing 158
remote computer sharing 193
teleconference 136
teleconference-only meeting 328
Web browser sharing 192
whiteboard sharing 161

starting a One-Click Meeting
from Meeting Center 96
from service Web site 95

stopping
annotation mode for shared software 211
annotations on shared software 215
application sharing 188, 206
desktop sharing 191, 206
publishing files during meeting 241
remote application sharing 206
remote computer sharing 196
remote desktop sharing 206
Web browser sharing 192, 206
whiteboard sharing 162

streaming audio
sharing as Web content 180

streaming video
sharing as Web content 180

Summary Usage report
description 331

Summary Usage report CSV file
description 331

switching, as attendee
between sharing window and main window 208

Synchronize Displays for All tool
overview 156

synchronizing
attendees' content viewers 170
view of pages 177
view of slides 177
view of whiteboard 177
views of shared software 204

system requirements
Meeting Manager 2

T

taking notes
as single note taker 249
closed captions 250
meeting minutes 249
personal 249
specifying options 246

teleconference
asking to speak 143
determining who is speaking 144
displaying instructions for 140
inviting participants 138
joining 139
leaving 140
muting and unmuting a specific microphone 142
muting and unmuting all 142
muting and unmuting participants automatically 

141
muting and unmuting your microphone 143
rejoining 140
starting 136

teleconference-only meeting
starting 328

teleconferences
call back 51
call-in 51
dual mode 51
Personal Conference number 48
third-party 51

telephone conference
WebEx Audio 51

templates
for Info tab 62

templates, scheduling
about managing 323
managing 323

Text tool
overview 156

third-party teleconferences
definition 51

thumbnails, viewing
shared documents 169
shared presentations 169
shared whiteboards 169

time zone
selecting on meeting calendar 23

time zone for site
setting 317

timer
displaying during polling 234

tips
for sharing software effectively 221
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titles of slides
viewing while sharing 162

Tools panel
for shared software, descriptions of tools 211

tools, annotation
using on shared software 211

tracking codes
definition 45

transcripts
files to attach 252
information included 252
sending to participants 252

transferring
files during a meeting 242
files during an event 242
files during meeting 241
host role to attendee 124

transitions
in shared presentations 164

True Color mode, enabling for application sharing 
220

U

UCF
checking system compatibility 5

UCF compatibility
checking before meeting starts 54

UCF media files
verifying that your computer can play 5

uninstalling
Meeting Manager 4

unlisted meetings
definition 45

unlocking
shared remote computer 200

unmuting
a specific mircrophone 142
all in teleconference 142
in Integrated VoIP conference 149
participant’s microphone in Integrated VoIP con-

ference 149
your microphone in Integrated VoIP conference 

150
your microphone in teleconference 143

uploading
files to personal folders 289
recordings 297

user account
obtaining 273

user profile
editing 317
maintaining, overview 317

V

video
adjusting quality while sending 258
controlling full-screen view 263
options, setting 259
overview 255
requesting from participant 257, 267, 268
sending 256
setting up 256
specifying frame rate 258
specifying multipoint for meeting 266
specifying single-point for meeting 266
specifying which camera to use 258
taking snapshots 269
turning on or off during meeting 266
viewing 261
viewing images from multiple participants 262
viewing in a floating window 261
zooming in 262
zooming out 262

video camera
connecting to computer 256
supported models 256

video files
sharing a Web content 180

View Thumbnails tool
overview 156

view tools
Full-Screen View tool, overview 156
overview 104
Standard View tool, overview 156
Synchronize Displays for All tool, overview 156
synchronizing views 204
View Thumbnails tool, overview 156
Zoom In/Zoom Out tool, overview 156

viewing
contact information in address book 311
live video 261
meeting calendar 20
results after closing poll 236
thumbnails 134
video from multiple participants 262
video in floating window 261

viewing miniatures of shared
documents 169
presentations 169
whiteboards 169

voice conferencing
types 51

VoIP
in dual-mode voice conferences 51
requirements 51
XIV



setting up for meeting 51
VoIP conference, in WebEx Audio 51
Volume

setting in Integrated VoIP conference 151

W

Web browser plug-in
for meeting services 3

Web browser sharing
differences to Web content sharing 180
overview of 192
pausing and resuming 202
starting 192
stopping 192
See also Web browser, shared

Web browser, shared
as attendee, switching between views 208
closing and reopening attendee window 206
controlling full-screen view 205
requesting annotation control 214
requesting remote control 217
resizing view 205
showing to attendees 192
zooming in or out 205
See also software, shared

Web content sharing
overview 179

Web site preferences
setting 317

WebEx AIM Pro
overview 5

WebEx Audio
computer conference 51
telephone conference 51

WebEx Document Manager 175
WebEx One-Click

installing 93, 94
removing from computer 98

welcome message
adding to Personal Meeting room page 285
creating for attendees 126
editing during meeting 126

whiteboards, shared
clearing pointers 172
closing 167
controlling full-screen view 169
displaying 162
navigating 162
pasting images 167
printing 175
saving to file 174
synchronizing display for attendees 170

synchronizing view 177
viewing miniatures (thumbnails) 169
zooming in 168
zooming out 168

Z

Zoom In/Zoom Out tool
overview 156

zooming in
on video image 262

zooming in, on shared
pages 168
slides 168
whiteboards 168

zooming out
on video image 262

zooming out, on shared
pages 168
slides 168
whiteboards 168
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